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1 Overview
Graphics Designer is used to create process pictures.
It offers the following features:

• Easy to use, simple interface with tool and graphic palettes

• Streamlined configuration with integrated object and icon libraries

• Open interfaces for importing graphics; OLE 2.0 interface support

• Configurable dynamic behavior of picture objects with support from an assistant
(Dynamic Wizard)

• Links to additional functions by means of powerful script configuration

• Links to graphic objects that you can create yourself

• 32-bit application, runs under Windows NT
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2 Structure
Graphics Designer contains the following items:

• Palettes for creating and editing graphic objects:
Color Palette
Object Palette
Style Palette
Alignment Palette
Zoom Palette
Font Palette

• Palettes and bars for operating the Graphics Designer:
Menu Bar
Standard Palette
Status Bar
Layer Bar

• A dialog window for setting and changing object properties:
Object Properties

Tips & Tricks
When you start the Graphics Designer, the "Tips & Tricks" window appears.

Click on the "Help" button to see notes about configuration.

Note

If you deactivate the "Show Tips at Startup" check-box, the "Tips & Tricks" window will
no longer be displayed at the start of the Graphics Designers.

If you want to reverse your selection, go to the "Options" tab of the "Extras" -> "Settings..."
menu and activate the check-box "Display Tips & Tricks".
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Context-Sensitive Help
By switching on the context sensitive help, you receive help text about palettes, menu
commands, and buttons. It also assists you in finding additional information in the online
help.

How to Get Information About the Palettes, Menu Commands, and Buttons:

1. In the Graphics Designer toolbar, click on the "Help" button . A question mark
appears on the mouse pointer.

2. Click on the palette, menu command, or button about which you want information.

Changing the Palette Size
In order to have a better overview of the entries in the palettes, especially those in the
object and style palettes, you can change the size of the palettes.

How to Change the Size of the Palettes:

1. Click on the palette border, hold down the left mouse button, and drag the palette into
the workspace.

2. Drag the palette to the desired size as you do with other Windows objects.

3. While holding down the left mouse button, move the palette to wherever you want it
on the screen.
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2.1 Color Palette

Use the mouse to assign one of the 16 standard colors, a basic color, or a user-defined color
to the object.

For example, a mouse click within the color palette changes any of the following colors:

• The fill color for area objects (for example, rectangles).

• The line color for line objects (for example, polylines).

• The background color for text objects.

Note

You can place the color palette anywhere in the workspace or anchor it to a border.

The "Toolbars..." menu item in the View menu can be used to bring the color palette in and
out of view as necessary.

2.1.1 Assigning a Standard Color

How to Assign a Standard Color to an Object:

1. Click on the object.

2. Click on one of the 16 standard colors in the color palette.

2.1.2 Assigning a User-Defined Color

How to Assign a User-Defined Color to an Object:

1. Click on the object.

2. Click on the  icon in the color palette.

3. Click on the color you want in the "Basic Colors" or the user-defined colors.

or

Click on the "Define Color >>" button to create another color combination.
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2.2 Object Palette

Using the object palette, select an object which will be created in the first visible layer of
the graphics workspace. Layer 0 is reserved for this purpose in Graphics Designer. The
objects available are arranged according to subject areas:
Use the object palette to select an object which will be created in the first visible layer of
the graphics workspace. Layer 0 is reserved for this purpose in Graphics Designer. The
objects available are arranged according to subject areas:

• Standard objects, such as polygon, ellipse and rectangle

• Smart objects, such as control, OLE element, bar and I/O field

• Windows objects, such as button and check-box.

Note

You can also operate the object palette using only the keyboard by pressing "Alt + O" and
then using the arrow keys.

You can place the object palette anywhere in the workspace or anchor it to a border.

The "Toolbars..." menu item in the View menu can be used to bring the object palette in
and out of view as necessary.
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Standard Objects

Line

Polygon

Polyline

Ellipse

Circle

Ellipse Segment

Pie Segment

Ellipse Arc

Circular Arc

Rectangle

Rounded Rectangle

Graphic objects are used primarily to draw system pictures. The appearance of the objects
can be changed at runtime by making them dynamic (for example, by linking them to the
process).

Static Text

Static text is used to display text. Static means that the text is within a text object (no
dynamic reference). You can change the appearance, location, and contents of the text box
during runtime.
If the static text extends over multiple lines, line breaks can be inserted using the key
combinations <Shift Return> or <Strg m>.

Smart Objects

Application Window

Application windows are objects which are managed by the messaging system (Alarm
Logging), from the archiving system (Tag Logging), from the printout system (Print Jobs),
as well as from applications (Global Scripts). In Graphics Designer, the external properties
(position, size, and other attributes) are configured and transferred to the application at
runtime. The application opens the application window and manages it for display and
operation.

Picture Window

Picture windows are objects that accept pictures created with the Graphics Designer. They
are configured according to position, size, and their other dynamic properties. For example,
one important property is a reference to the picture (picture name) to be displayed in the
picture window. By changing the "Picture Name" attribute dynamically at runtime, the
contents of the window can be changed dynamically.
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Control

Use a Control to implement a Windows element (e.g. a button or a selection box). A
control has attributes which are displayed in the "Object Properties" dialog window in the
"Event" tab and can be edited there.

All controls are available from the "Standard" tab of the object palette. The WinCC-specific
controls can also be selected directly from the "Control" tab of the object palette. In this
case, the "Insert OLE Control" dialog window will not be displayed.

OLE Element

 The Graphics Designer offers the opportunity to insert OLE elements into a graphic. In
the configuration mode, you can edit a few elements with the appropriate OLE application
by double-clicking; others are activated by double-clicking.
After you have made changes to a linked OLE element in an attached object box, you must
update the link manually in order to display the changes.
No editing can be performed in runtime mode.

Note

The integration of "AVI" files as OLE elements in a picture will cause problems in runtime
(related to the system). For this purpose, use a control instead.

I/O Field

The I/O field can be used as an input field, an output field, or a combined I/O field. The
binary, hexadecimal, decimal, or string data formats are supported. You can also specify
limit values, hidden input, or acceptance when the field is full.

Bar

The bar graph graphically displays values relative to upper and lower limit value points,
either as a purely graphic overview or as a combined representation of the values with a
scale that can be defined.
It is assigned to the smart objects group and can be influenced in appearance and
functionality by its properties (attributes).

Graphic Object (External Format)

The graphic object (external format) accepts a picture that was created in an external
graphic format into a Graphics Designer picture.

Status Display

The Status Display is used to display nearly any number of different states of an object.
You can make the display dynamic by linking it to a tag whose value corresponds to the
state. You can assign the tag any number between 0 and 232 -1 (bit combinations).

The states can accommodate gaps (1, 2, 5, 6, etc.). It is possible to have states without
assigned pictures, which can, if necessary, be removed with the “Clear List” command.
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Text List

Use the text list to assign text to values. It can be used as an input list (text input --> value
output), output list (value input --> text output), or combined text list. The decimal, binary,
or bit data formats are possible.

The "decimal" list type displays the output value of the assigned text. When you enter a
text, the assigned value is transferred as an input value to the data manager. If a value range
is assigned to the text, the bottom range limit is transferred. This also applies to "top open"
value ranges (for example, >=100). With "bottom open" value ranges (for example, <=0),
the top range limit is transferred.

The "binary" list type displays the text to which a bit of the output value is assigned should
the bit be occupied. In this case, only one bit may be set in the output value (one text is
displayed). The text assigned to that bit number is output. If more than one bit is set in the
output value, the text "***" is output. When you enter a text, the data manager receives the
input value of the value in which exactly that bit is set whose number corresponds to the
text entered.

The "bit" list type displays a text which refers to the state of a defined bit of the output
value. Exactly two texts can be configured. One text is configured if the bit is set, and
another text if the bit is not set. When you enter a text, the appropriate bit is set or deleted
in the available output value and the new value is used as the input value. The relevant bit is
determined by a unique attribute (bit number).

When you use a text list object, the configured list of text assignments is opened. In the
case of the "decimal" and "binary" list types, the text that corresponds to the current output
value is selected. In the case of the "bit" list type, the opposing text to the current state is
selected because use of this list type normally serves to "turn" a bit, therefore making
further operation unnecessary.

The text list object can be coupled to the text library via the “Language Switch” attribute.
During configuration, entered text is automatically written to the text library. In the text
library, the texts to be displayed can be translated. If you switch data languages, the system
will read the corresponding translations from the text library.

3D-Bar Graph

The 3D-bar is assigned to the smart objects group. Its properties (attributes) influence its
appearance and functionality.
It displays values graphically relative to a high and low limit. The user can freely configure
the type of the 3D display.

The 3D Bar is part of the Basic Process Control options package.

The group display object provides a hierarchically concentrated display of the current
states of certain message types. There is, however, no connection to the message system
within WinCC.

Use the group display in runtime mode to execute a picture change to the picture in which
the error source is displayed. This opportunity for rapid navigation to an error source is a
very significant function for the user.

The group display is part of the Basic Process Control options package.
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Windows Objects

Button

The Button is used to control process events (such as acknowledging messages or
warnings). It recognizes two states ("Pressed" and "Not pressed"). The process connection
is achieved by making the appropriate attributes dynamic.

Check-Box

The Check-Box is used where a multiple selection is required. The user can select one or
multiple boxes in the check-box by clicking. A very flexible link to the process can also be
achieved here by making the appropriate attributes dynamic.

Radio-Button

The Radio-Button is similar to the check-box but only allows a single selection. The
process link from the radio-button can be created at runtime by making the attribute
dynamic.

Round Button

The Round Button is used like the button for operating process events. However, in
contrast to the button, the round button also has a latch down setting for both the "Pressed"
and "Not pressed" states. The process connection is achieved by making the appropriate
attributes dynamic.

Slider

The Slider is used as a movement regulator for controlling a process (for example,
temperature control). The control range lies between the minimum and maximum values.
The process connection is achieved by making the appropriate attributes dynamic.



08.99 Structure

WinCC Manual 2-9
C79000-G8276-C160-01

2.2.1 Drawing an Object

Before you begin
All objects are drawn with the default object properties in the first visible layer of the
graphic workspace. Layer 0 is reserved for this purpose in Graphics Designer. All of these
default settings can be changed (see "Changing the Object Properties").

How to Draw an Object:

1. Use the mouse to select the desired object from the object palette.

2. In the workspace, click the mouse where you want to place the object. Then drag the
cursor while pressing the mouse button until the object reaches the desired size

or

Click the mouse in the workspace. The object is then displayed in a system default
size.

or

1. Activate the object palette with the keystroke combination "Alt + O".

2. Select the object type using the arrow keys on the keyboard.

3. Create the selected object with defaults by hitting the "Enter" key.

How to Draw a Polygon or a Polyline:

1. Select the "Polygon" or "Polyline" icon from the object palette.

2. Click the left mouse button on the desired starting point.

3. Click the left mouse button on each of the other corner points.

4. By clicking the right mouse button, you can correct the part of the object you entered
last.

5. End the polygon or the polyline by double-clicking the left mouse button. The
polygon is closed while the polyline is not.

6. Double-clicking on a corner point while keeping the "Alt" key pressed allows you to
add an additional corner point. This additional corner point will be placed between the
corner point clicked on and the corner point that has been created immediately
preceding it.

7. To delete a corner point, double-click on it while pressing the "Ctrl" key.

Note

If you turn on the "Grid"  and the "Snap to Grid"  functions, you can align the
drawn objects with each other much better.

After Drawing
After an object is drawn, the object palette automatically changes to the "Select Object"
mode. Now you can create another object or select an object which is already in the
workspace and change its properties. You can change the defaults using the "Tools" -
"Settings ..." menu item in the "Options" tab.
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2.2.2 Selecting an Object

How to Select an Object:

• Click on the object with the mouse.

How to Select Multiple Objects (Multiple Selection):

• Hold down the "Shift" key and click on each object with the mouse.

or

Hold down the mouse button and drag a frame ("lasso") around the objects you want
to select.

Note

If you used the "Tools" - "Settings ..." menu to select the "Touching" option under
"Object Selection" in the"Options" tab, the objects can be selected by simply touching
them with the lasso.

With the "Surrounding" option, all of the objects to be selected must be completely
enclosed by the lasso.

2.2.3 Changing the Object Properties

How to Change the Object Properties:

1. Click on an object with the mouse.

2. Click the right mouse button to open the pop-up menu.

3. Click on "Properties" to display the object properties.

4. In the "Properties" tab, select the corresponding attribute to change the object
property.

Note

With multiple selection, all of the attributes of the selected objects are listed in the
"Properties" tab. However, only attribute values that are identical in all of the objects are
displayed.

Default Values of the Object Properties
You can set default object properties for each object type. These defaults are used each time
a new object is created.
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How to Set the Defaults for Object Properties:

1. Open the dialog window with the object properties by means of the  button on the
standard palette or the "View" - "Properties" menu and attach it to the screen with the

pin .

2. Select an object type from the object palette. The properties for the corresponding
default object are displayed.

3. In the "Properties" tab, change the desired properties in the "Static" column.

4. When you exit the Graphics Designer, you can save the presettings by means of the
"Tools" - "Settings" menu in the "Default Objects" tab.

Note

You can change some properties directly, such as line and border style, or background
color, by using the style or color palettes.

2.2.4 Moving an Object with the Mouse

How to Move an Object with the Mouse:

1. Click on an object and hold down the left mouse button.

2. Drag the object to the desired position.

Note

If the "Snap to Grid"  function is enabled, the object can only be shifted according to
the grid setting.

2.2.5 Sizing an Object with the Mouse

How to Change the Size of an Object with the Mouse:

1. Click the mouse on the object. The object is then surrounded by a rectangle with 8
handles.

e.g. 

2. Click on one of these handles and hold down the left mouse button.

3. Drag the object to the desired size.

You can change the size of the object diagonally with one of the four corner handles.
Change the size horizontally or vertically with one of the handles in the middle of the
border.
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2.2.6 Changing the Start Angle/End Angle with the Mouse

The "Change the Start and End Angle" function relates to the objects "Ellipse Segment",
"Ellipse Arc", "Pie Segment", and "Circular Arc".

How to Change the Start/End Angle of an Object with the Mouse:

1. Click the mouse on the object. The object is then surrounded by a rectangle with 8
handles. The end points of the curved object are identified by somewhat larger
handles.

e.g. 

2. Click on one of the larger handles and hold down the left mouse button. The pointer
changes to a crosshair with an A (Start Angle) or an E (End Angle) attached.

3. Drag the object to the desired size.

e.g. 

You can change the size of the object diagonally with one of the four corner handles.
Change the size horizontally or vertically with one of the handles in the middle of the
border.



08.99 Structure

WinCC Manual 2-13
C79000-G8276-C160-01

2.3 Style Palette

Use the style palette to change the appearance of the selected object. Depending on the
object type, there are different types of styles available, for example:

• different line/border types,

• several line/border weights,

• line end styles for line objects,

• various fill patterns.

Note

The settings that are currently selected are displayed in a "bold" typeface.

You can also operate the style palette using only the keyboard with the keystroke
combination "Alt + S" and the arrow keys.

You can place the style palette anywhere in the workspace or anchor it to a border.

The "Toolbars..." menu item in the View menu can be used to bring the style palette in and
out of view as necessary.

2.3.1 Changing the Line Style

The appearance of lines and borders can be altered by changing the line properties. There
are different line styles available, including dot, dash, solid, etc. You can select the type of
line or border from the style palette.

How to Change the Line/Border Style Using the Style Palette:

1. Click on an object with the mouse.

2. Click on the  icon in the style palette.

or

Click on the  in front of your selection to open it.

3. Click on the line you want to use from the selection available.

or

1. Activate the style palette using the keystroke combination "Alt + S".

2. Select the line style you want using the arrow keys on the keyboard.

3. Accept the setting by hitting the "Enter" key.
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2.3.2 Changing the Line Weight

The appearance of lines and borders can be altered by changing the weight. There are
different weights available. You can select the thickness of the lines or borders from the
style palette.
The values provided correspond to a line/border weight measured in pixels.

How to Change the Line/Border Weight Using the Style Palette:

1. Click on an object with the mouse.

2. Double-click on the  icon in the style palette.

or

Click on the  in front of your selection to open it.

3. Click on the weight you want to use from the selection available.

or

1. Activate the style palette using the keystroke combination "Alt + S".

2. Select the line weight you want using the keyboard arrow keys.

3. Accept the setting by hitting the "Enter" key.

2.3.3 Changing the Line End Style

The appearance of line ends can be altered by changing the line properties. There are
different line end styles available, including none, one-sided, two-sided, and thin or thick
arrows. Using the style palette, you can select the type of line end style.

How to Change the Line End Styles Using the Style Palette:

1. Click on a line object with the mouse.

2. Double-click on the  icon in the style palette.

or

Click on the  in front of your selection to open it.

3. Click on the line end style you want to use from the selection available.

or

1. Activate the style palette using the keystroke combination "Alt + S".

2. Select the line end style you want using the arrow keys on the keyboard.

3. Accept the setting by hitting the "Enter" key.

Note

If a line weight > 5 is selected, the line end style "Round" will be displayed as a filled
circle.

The "Line End Style" property is not available for borders around surface objects.
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2.3.4 Changing the Fill Pattern

The appearance of the background surfaces of objects can be altered by changing the object
properties. There are different fill patterns available, including solid, striped, transparent,
etc. You can select the fill pattern from the style palette.

How to Change the Fill Pattern Using the Style Palette:

1. Click on a surface object.

2. Click on the  icon in the style palette.

or

Click on the  in front of your selection to open it.

3. Click on the fill pattern you want to use from the selection available.

or

1. Activate the style palette using the keystroke combination "Alt + S".

2. Select the fill pattern you want using the arrow keys on the keyboard.

3. Accept the setting by hitting the "Enter" key.
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2.4 Alignment Palette

With the alignment palette:

• Change the absolute location of one or more objects.

• Change the location of the selected objects relative to each other.

• Unify the height and width of multiple objects.

You have at your disposal the following alignment functions for the selected objects:

Icon Description

Left-align objects
(Arrange menu - Align - Left)

Right-align objects
(Arrange menu - Align - Right)

Top-align objects
(Arrange menu - Align - Top)

Bottom-align objects
(Arrange menu - Align - Bottom)

Center objects horizontally
(Arrange menu - Align - Center Horizontally)

Center objects vertically
(Arrange menu - Align - Center Vertically)

Space objects horizontally
(Arrange menu - Align - Space Horizontally)

Space objects vertically
(Arrange menu - Align - Space Vertically)

Give objects uniform widths
(Arrange menu - Align - Same Width)

Give objects uniform heights
(Arrange menu - Align - Same Height)

Give objects same width and height
(Arrange menu - Align - Same Width and Height)

Note

You can place the alignment palette anywhere in the workspace or anchor it to a border.

The "Toolbars..." menu item in the View menu can be used to bring the alignment palette in
and out of view as necessary.
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2.4.1 Aligning Objects

How to Align Objects:

1. Select the objects on the workspace that you want to realign

2. Click on the corresponding icon in the alignment palette.

The objects are realigned.

Note

For the functions "Left", "Right", "Top", and "Bottom", the type of selection determines
which object will be used as reference for the alignment.

If the objects have been selected using a selection frame (lasso), the object located the
furthest out will be used as reference.

If the objects have been selected using the mouse and the "Shift" key, the object selected
first will be used as reference for the alignment.

How to Unify the Width/Height of Objects:

1. While holding down the "Shift" key, click on the objects you want to unify in your
workspace.

2. Click on the corresponding icon in the alignment palette.

The objects are all set to the width and/or height of the object that was selected first.
The line weight, however, is not changed.

Note

If you select the objects with the mouse (border), the objects assume the width and/or
height of the object which was configured first in this group.
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2.5 Zoom Palette

With the zoom palette you can adjust the zoom factor of the active window by adjusting the
slider with the mouse or by using the buttons. The current zoom factor is displayed below
the slider.

You can also set the zoom step-by-step using the standard toolbar functions.

Note

You can also operate the zoom palette using only the keyboard by using the keystroke
combination "Alt + Z" and the arrow keys.

You can place the zoom palette anywhere in the workspace or anchor it to a border.

The "Toolbars..." menu item in the View menu can be used to bring the zoom palette in and
out of view as necessary.

How to Set the Zoom Factor:

1. Holding down the mouse button, drag the slider to the desired zoom factor.

or

Click above or below the control. The zoom factor is set to the appropriate zoom level
according to the position of the mouse.

or

Use one of the buttons to set the zoom factor to the fixed sizes 8, 4, 1, ½ or ¼.

2. After you release the mouse button, the picture is displayed at the zoom factor
(percentage) shown in the zoom palette.
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2.6 Menu Bar

The menu bar contains all menu commands available in Graphics Designer. Commands
which cannot be activated are shown in gray.

2.6.1 File Menu

New...
Use the "New" command to create an empty window in which you can draw a new picture.

The Graphics Designer provides an empty workspace with a default name NewPdlx. The x
is incremented every time a new picture is created. When you save, you can change the
name.

Open ...
Use the "Open..." command to load an existing file into the workspace.

The project-specific files for Graphics Designer (file name extension .PDL) are listed as
defaults.

For further information about the process of file selection, refer to the Windows NT
description.

Note:

With a "Multi-User System" project type, another user may already have the picture file
open that you want to open. In this case, the system opens a copy of the file with write
protection. If you make changes, this file must be saved under another name.

Close
Use the "Close" command to remove the opened file from the screen.

If you have not yet saved a change to the file, the Graphics Designer asks if you want to
save the file.
If you answer with "Yes," the file is saved. If the file is a new picture, the "File" - "Save As
..." dialog box is opened.

Runtime
Use the "Runtime" command to switch to runtime mode to test the current picture.

Note:

If you have not saved the picture yet, a dialog window opens and requests that you do so. If
you exit the save dialog box by means of "Cancel," the system does not switch to runtime
mode.
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Save
Use the "Save" command to save the current version of your work. Use this command
when a file is saved for the first time and does not have a permanent name, or when you
want to save a change to the file under the same path and name.

The program-specific file name extension .PDL is attached to the file name as a default.

Note:

With a "Multi-User System" project type, the picture file to be saved may have been
opened "write protected". In this case, the "Save" function is not possible. You must save
the file under another name.

Save As ...
Use the "Save As..." command to save the current version of your work. Use this command
if you want to change the name or the path of the file. The dialog box is similar to the
dialog box for the "Save" command.

For conventions and procedures regarding the assignment of a file name and path, refer to
the Windows NT description.

The program-specific file name extension .PDL is attached to the file name as a default.

Save All
Use the "Save All" command to save the current version of all open work windows under
already existing names. If a window has not been named, the system automatically switches
to the "Save As ..." dialog box.

Print ...
Use the "Print..." command to print the open picture to the configured printer.

Print Preview
Use the "Print Preview" command to check the page layout in the print view before you
print it out.

Printer Setup ...
Use the "Printer Setup..." command to set up the desired printer and its parameters.

Print Project Documentation ...
The "Print Project Documentation ..." command prints out the documentation of the current
picture, with all the objects contained in it and their properties, using the report system of
WinCC (Report Designer).

View Project Documentation
Use the "View Project Documentation" command to check the page layout of the project
documentation in the print view before printing it out.
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Export ...
Use the "Export..." command to export the picture which is currently in the configuration
window in the "Enhanced Meta File (.EMF)" or "Windows Meta File (.WMF)" format.

The program-specific file name extension .EMF is attached to the file name as a default.

Note:

When you export a picture created with the Graphics Designer, you lose all object
properties which can be made dynamic that belong to individual objects.

An individual line should not be exported as an .EMF file. As lines have no object
expansion, a random height will be calculated for the line when exported. When imported,
this results in an incorrect representation of the line.
For this reason, individual lines should only be exported in the .WMF format.

2.6.2 Edit Menu

Undo
Use the "Undo" command to take back the last command used in processing the picture
(Undo).

Redo
Use the "Redo" command to repeat the action that was undone (Re-Undo) previously.

Duplicate
Use the "Duplicate" command to create a copy of an object directly in the picture. Objects
duplicated this way are not stored on the Clipboard.

Select All
Use the "Select All" command to select all objects in the picture.

Group
Use the "Group" command to group several marked objects into a group, a so-called group
object. All objects except Control and OLE Objects can be grouped. All objects in a group
can be marked and edited with a mouse click.

You can change the properties of all of the group elements globally or edit the properties of
each individual element using the "Object Properties" window.



Structure 08.99

2-22 WinCC Handbuch
C79000-G8276-C160-01

Edit Group Objects

Example:
Object properties of an object group consisting of a line, a circle, and a rectangle:

How to Edit Objects within a Group:

1. Select the group of objects.

2. Display the object properties (e.g. by double-clicking on the group).

3. Select a property of an individual object or a property from the whole group.

4. Edit the properties.

Note:

The properties of the group consist of the default attributes of the group and the batch of
attributes belonging to all of the subobjects. Each attribute is only listed once. Changing a
group attribute has an effect on all of the subobjects that share the attribute.

Since the attributes belonging to a group object do not have a higher priority, each attribute
belonging to a single object can be changed independent of the group object.

Changing the group attributes "Height" and "Width" makes the individual "Height" and
"Width" match a percentage value of the group attributes.

Changing the attributes "Position X" and "Position Y" in the group element does not change
the same attributes in the individual elements. Each individual object retains this property
in relation to the group origin.

The individual objects retain their configured dynamics. If an additional dynamic feature is
configured to the same attribute within the group, the latest change applies during runtime
mode. This behavior also applies to the picture selection. It cannot be ensured that the
attributes are set in certain order.
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Ungroup
Use the "Ungroup" command to ungroup a group of objects so that you can edit each object
individually.

TAB Sequence
Use the "TAB-Sequence" command to influence the sequence in which operable objects are
triggered in runtime mode. Differentiate between the following:

• Alpha Cursor Objects and

• Tab Order Objects.

The "Alpha Cursor" - "Sequence" is exclusive to I/O objects. I/O objects can also contain a
number in the sequence for the Tab Order.

"Tab Order" - "Sequence" refers to objects which can be selected from the "Object Types"
dialog box. The "Object Types" dialog box is opened with the command "Edit" - "TAB
Sequence" - "Tab Order" - "Settings".

Note:

Operable I/O objects can possess a number in the TAB Sequence for both the Alpha Cursor
and the Tab Order. These are listed according to the sequence in which they were created.

How to Set the TAB Sequence of the Alpha Cursor:

1. Click on "TAB Sequence" - "Alpha Cursor" - "Sequence" in the "Edit" menu.

A numbered rectangle appears in the upper left corner of each input/output object.

2. Click on these rectangles sequentially. The numbers increase correspondingly.

3. End the input by clicking on an empty space in the workspace.

The numbering can be changed at a later time. Objects can likewise be removed from or
added back into the TAB Sequence.

Note:

If you hold the "Shift" key and click on the object, the number is reset to 1.
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How to Set the TAB Sequence of the Tab Order:

1. Click on "TAB Sequence" - "Tab Order" - "Sequence" in the "Edit" menu

A numbered rectangle appears in the upper left corner of each object selected by
"Edit" - "TAB Sequence" - "Tab Order" - "Settings".

2. Click on these rectangles sequentially. The numbers increase correspondingly.

3. End the input by clicking on an empty space in the workspace.

The numbering can be changed at a later time. Objects can likewise be removed from or
added back into the TAB Sequence.

Note:

If you hold the "Shift" key and click on the object, the number is reset to 1.

How to Change the Selection of Object Types for the Tab Order:

1. Click on "TAB Sequence" - "Tab Order" - "Settings ..." in the "Edit" menu.

2. In the dialog box, click on the object types which should be included in the TAB
Sequence of the Tab Order.
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How to Change an Existing TAB Sequence:

1. In the "Edit" menu, click on "TAB Sequence" - "Alpha Cursor" or "Sequence" or
"TAB Sequence" -"Tab Order" - "Sequence".

The TAB sequence number is inserted in the objects.

2. The first object you click on receives the number 1.

3. Now click sequentially on the other objects. They are numbered according to the order
of their selection.

Note:

If you click on an object while holding the "Shift" key, you assign the number 1 and thus
start a new sequence.

In order to renumber only some of the objects, hold the "Ctrl" key and click on the last
object which should retain its number. Numbers above that one are reassigned to other
objects when you click on those objects.

How to Delete an Object from a TAB Sequence:

1. In the "Edit" menu, click on "TAB Sequence" - "Alpha Cursor" or "TAB Sequence" -
"Tab Order".

The TAB sequence number is inserted in the objects.

2. Holding the "Shift" + "Ctrl" keys, click on the object to be deleted from the TAB
sequence.

The number of the object is replaced by an asterisk (*). The objects with higher
numbers are automatically renumbered.

How to Reinsert an Object into the TAB Sequence:

1. In the "Edit" menu, click on "TAB Sequence" - "Alpha Cursor" or "TAB Sequence" -
"Tab Order".

The TAB sequence number is inserted in the objects.

2. Holding the "Shift" + "Ctrl" keys, click on the object marked with an asterisk (*) that
is to be reinserted in the TAB sequence.

The asterisk (*) is replaced by the next number in the TAB sequence.

Properties
Transfer the properties of an object or an object group to another object using the
"Properties" menu item under the "Edit" menu. You can select from two functions, which
can also be accessed using the standard toolbar icons:

• Copy Properties

• Assign Properties



Structure 08.99

2-26 WinCC Handbuch
C79000-G8276-C160-01

Copy Properties
Use the "Copy Properties" command to copy the properties from an object (except for the
object name and the properties belonging to the "Geometry" area) in order to transfer them
to another object.

Assign Properties
After you take properties from one object with the "Properties" - "Copy" command, transfer
them to a selected object with the "Properties" - "Assign" command. Only the properties
(attributes) contained in both objects (e.g. color, line weight, border weight, etc.) are
assigned.

2.6.3 View Menu

Properties
Use the "Properties" command to open a window where the properties of the selected
object or object group are displayed.

Library
Use the "Library" command to open the Graphics Designer picture library. You can store
objects created in Graphics Designer as icons under any name you select in this library.
You can then paste them into other pictures if necessary.

The pictures can be stored in either a global library (path is provided in the MCP.INI file)
or a project-related library (\LIBRARY in project path).

How to Store a Graphic Object in a Library:

1. Select the object or the group of objects you want to store under a name in the library.

2. In the toolbar, select the  button, or click on "Library" in the "View" menu. The
library window will open.

3. Select whether the object should be stored in the "Global Library" or in the "Project
Library".

4. Select a folder in which to store the object.

5. Using the mouse, move the object to the file list. The object receives the default name
Objectx (x = 1, 2, 3 ...). The name remains highlighted.

6. Assign a picture-related name to the object. The picture names can be changed at a
later time.

You can also use the pop-up commands "Copy" and "Paste" as well as the toolbar icons or
the keystroke combinations "Ctrl + C" and "Ctrl + V" to move the object.

Note:

Pictures with tag links and actions should not be stored in the "Global Library" since this
could lead to errors when they are linked to other projects.
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How to Paste a Graphic Object from a Library:

1. In the toolbar, select the  button, or click on "Library" in the "View" menu. The
library window will open.

2. Select whether you want to take the object from the "Global Library" or from the
"Project Library".

3. Select the folder from which you would like to take the object.

4. Click on the desired object and move it to the Graphics Designer workspace.

or

Click on the desired object, open the pop-up menu, and click on the "Copy" command.
Click on the Graphics Designer workspace, open the pop-up menu, and execute the
"Paste" command.

How to Change a Picture Name in the Library:

1. In the toolbar, select the  button, or click on "Library" in the "View" menu. The
library window will open.

2. Click on the icon of the picture to be changed.

3. Using the right mouse button, open the pop-up menu and execute the "Rename"
command. The file name is highlighted.

4. Enter a new name for the picture.

Library Toolbar

The library toolbar contains some of the icons that are in the Windows Explorer toolbar,
plus "Preview".

Toolbars ...
Display/hide the palettes and toolbars depending on your requirements.
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How to Display/Hide Toolbars:

1. Click on "Toolbars ..." in the "View" menu.

2. In the "Toolbars" dialog box, select or deselect palettes and toolbars by clicking on the
corresponding check-boxes. This will display or hide them.

A check-mark in the check-box shows that the palette or toolbar is displayed.

You can test the effect on the screen display without exiting the dialog box by using the
"Apply" button.

Use the "Restore" button to recreate the last setting of the toolbars that was saved.

Note:

You can also right-click on a docking bar to open the "Toolbars" dialog box.

The activated palettes and toolbars can be placed using the mouse or be docked to a
docking bar.

Full Screen
Use the "Full Screen" command to enlarge the workspace to the full screen size. All
palettes and bars are hidden upon execution of this command.

Switch back to the normal view by pressing any key or by clicking the mouse button.

Grid ...
You can insert a grid into the workspace in order to make your work there more precise. If
you also switch on the "Snap to Grid" function, all newly drawn objects are automatically
aligned with the grid points.

Note:

The minimum grid space displayed on the screen is 10 pixels. If you set a smaller value (for
example, 4 pixels), you can align your objects to that smaller grid value. However, the
screen display will show the next even-numbered multiple of that value greater than 10
pixels (e.g. if 4 pixels are set, the screen will display 12).
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Zoom
Use the "Zoom" command to change the size of the picture shown on the screen. The view
can be changed according to the following increments: from 20% to 100% in increments of
10%, from 100% to 400% in increments of 50%, and from 400% to 800% in increments of
100%.

Zoom Area
Use the "Zoom" - "Zoom Area" command to select a segment of the screen with a lasso and
enlarge the segment.

Layers ...
Use the "Layers..." command to sets layers to active or inactive. This displays or hides the
objects in those different layers. An object is assigned to a layer through its object
properties.

How to Make Layers Active/Inactive:

1. Click on "Toolbars ..." in the "View" menu. This displays the "Settings" dialog box
with the "Visible Layers" tab.

2. Click on the layers in the selection list which are to be set to active. These are then
marked with a check-mark in the list.

or

• Use the "All On" button to make all of the layers active, or the "1-15 Off" button to
deactivate layers 1-15.

or

• Click on the numbers in the layer bar 
for the layers to be set to visible or invisible.

Note:

Objects are created in the first visible layer of the graphic workspace. Layer 0 is reserved
for this purpose in Graphics Designer.

The system does not allow you to switch off all of the layers.
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Language ...
An object can receive different inputs for different languages. Use the "Language ..."
command to select the language with which the object entry is to be linked.

e.g. 

2.6.4 Insert

Import ...
Use the "Import..." command to import graphic objects which are stored in different
formats.

The system supports the WMF format (Windows Meta File) and the EMF format
(Enhanced Windows Meta File).

2.6.5 Arrange

Rotate
Use the "Rotate" command to rotate objects by 90 degrees each. Only certain object types
can be rotated (for example, an OLE element cannot be rotated). The properties are
appropriately adjusted during a rotation (for example, when a text box is rotated by 90
degrees, the text orientation changes from "horizontal" to "vertical").

Mirror
Use the "Mirror" command to mirror objects on the horizontal or vertical middle axis of the
object. Only certain object types can be mirrored (for example, an OLE element cannot be
mirrored). The properties are appropriately adjusted when an object is mirrored (for
example, when a text box is mirrored at the vertical middle axis, the text orientation
changes from "left justify" to "right justify").

Align
Use the "Align" command to set the location of objects relative to each other. The
functionality corresponds to the alignment palette.
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Within the Layer
Use the "Within the Layer" command to influence the location of an object within a layer.
The following functions are available:

• Place on Top

• Place on Bottom

• Move Up One Layer

• Move Down One Layer

Place on Top
Use the "Within the Layer" - "Place On Top" command to move an object to the foreground
within a layer.

Place on Bottom
Use the "Within the Layer" - "Place On Bottom" command to move an object to the
background within a layer.

Move Up One Layer
Use the "Within the Layer" - "Move Up One Layer" command to move an object one
position forward within a layer.

How to Move an Object One Position Forward within a Layer:

1. Select the object you want to move one position forward.

2. Click on "Within the Layer" - "Move Up One Layer" in the "Arrange" menu.

or

Press the "Plus" key.

Move Down One Layer
Use the "Within the Layer" - "Move Down One Layer" command to move an object one
position backward within a layer.

How to Move an Object One Position Backward within the Layer:

1. Select the object you want to move one position backward.

2. Click on "Within the Layer" - "Move Down One Layer" in the "Arrange" menu.

or

Press the "Minus" key.

2.6.6 Tools Menu

Update References
Use the "Update References" command to update existing OLE links.

This command tests all links with OLE elements and updates the contents of the objects. If
a link to an OLE element is no longer valid, the object is represented in the Graphics
Designer by an empty object with a line through it. You also receive an appropriate error
message in the status bar.
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Settings ...
Use the "Settings ..." command to open a dialog window with the following tabs:

• "Grid" Tab

• "Options" Tab

• "Visible Layers" Tab

• "Default Objects" Tab

• "Menu/Toolbars" Tab

Here you can make settings to change the appearance and behavior of the Graphics
Designer.
These settings will be stored and remain after a the Graphics Designer is restarted.

"Grid" Tab
You can insert a grid into the workspace using the "Display Grid" function in order to make
your work there more precise. If you also switch on the "Snap to Grid" function, all newly
drawn objects are automatically aligned with the grid points.

Note:

The minimum grid space displayed on the screen is 10 pixels. If you set a smaller value (for
example, 4 pixels), you can align your objects to that smaller grid value. However, the
screen display will show the next even-numbered multiple of that value that is greater than
10 pixels (e.g. if 4 pixels are set, the screen will display 12).

"Options" Tab
In the "Options" tab you can set basic program settings.

• Select if you want to save the configuration settings upon exit.

• Select if warnings should be output to indicate that the set configuration will result in
poor runtime behavior.

• Select if the objects must be completely surrounded by the lasso when they are selected
or if they only have to be touched.

• Select if you want to permit direct editing of the object attributes in the "Object
"Properties" dialog box.

• Select if, after an object is created via the object palette, the object type continues to be
highlighted in the object palette or is reset.

• Select if you want to use the configuration dialog box. It makes it easier to configure the
objects for the "I/O Field," "Bar," "Button," "Slider," and "Status Display" objects
types.

• Select if the "Tips & Tricks" are to be displayed at the startup of the Graphics Designer.

"Visible Layers" Tab
You can make the picture layers 0 to 15 visible or invisible in the "Visible Layers" tab.

Note:

The system does not allow you to switch off all of the layers.
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"Default Objects" Tab
Set the parameters for saving the presettings with the "Default Objects" tab.

• Decide if you want to save the presettings when exiting.

• Select the file in which the presettings are to be stored. Use the  button to search
through the available paths and set a different path.

• Use the "Save Now" or "Load Now" button to save or load the presettings of the
objects now.

• Select the default trigger for your objects.

"Menu/Toolbars" Tab
With the "Menu/Toolbars" tab, the appearance and properties of the menu bar and toolbars
can be defined.

How to define the Appearance and Properties:

• Select the "Flat Appearance" for the toolbars.

• Turn the display of the handle bars on/off.

• Turn the display of the toolbar icons in the list-boxes on/off.

• Turn the display for the shortcuts in the menus on/off.

• Define if deactivated buttons on the toolbars are to be displayed in color.

• Define if the standard toolbar is to be configurable. For this, the check-boxes
"Configurable" and "Drag & Drop with Pressed ALT Key" must be activated.

To add or remove buttons from the standard toolbar, keep the "ALT" key pressed and
double-click on any button. The "Adapt Toolbar" dialog box will be opened. In there, the
standard toolbar can be adapted to your requirements.

Note:

In order to open the "Adapt Toolbar" dialog box, the "Settings" dialog box must be closed.

Buttons on the standard toolbar can be removed or rearranged by dragging the concerned
button from the toolbar (to remove it) or by positioning it at its new location, while keeping
the "ALT" key pressed.

2.6.7 Window Menu

New Window
Use the "New Window" command to create a copy of the current picture in another
window. This allows you to simultaneously display different segments of a picture.
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2.7 Standard Toolbar

The standard toolbar contains icons with which you can carry out common commands by
clicking the mouse.

The following buttons are available:

Icon Description

New File
(Menu File - New)

Open File
(Menu File - Open ...)

Save File
(Menu File - Save)

Runtime
(Menu File - Runtime)

Cut
(Menu Edit - Cut)

Copy
(Menu Edit - Copy)

Paste
(Menu Edit - Paste)

Undo
(Menu Edit - Undo)

Redo
(Menu Edit - Redo)

Print File
(Menu File - Print ...)

Place on Top within the Layer
(Menu Arrange - Within the Layer - Place on Top)

Place on Bottom within the Layer
(Arrange Menu - Within the Layer - Place on Bottom)

Grid On/Off
(Menu View - Grid ...)

Snap to Grid
(Menu View - Grid ...)

Enlarge View
(Menu View - Zoom - Zoom In)

Reduce View
(Menu View - Zoom - Zoom Out)

Enlarge Segment
(Menu View - Zoom - Zoom Area)

Copy Static Properties of the Selected Object
(Menu Edit - Properties)

Assign Static Properties
(Menu Edit - Properties)
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Icon Description

Mirror Object Vertically
(Menu Arrange - Mirror - Vertically)

Mirror Object Horizontally
(Menu Arrange - Mirror - Horizontally)

Rotate Object
(Menu Arrange - Rotate)

Display Object Properties
(Menu View - Properties)

Open Library
(Menu View - Library)

Turn on Context-Sensitive Help
(? Menu - Direct Help)

Note:

You can place the standard toolbar anywhere in the workspace or anchor it to a border.

The "Toolbars..." menu item in the View menu can be used to bring the toolbar in and out
of view as necessary.

The standard toolbar is configurable. To add or remove buttons from the standard toolbar,
keep the "ALT" key pressed and double-click on any button. The "Adapt Toolbar" dialog
box will be opened. In there, the standard toolbar can be adapted to your requirements.

Buttons on the standard toolbar can be removed or rearranged by dragging the concerned
button from the toolbar (to remove it) or by positioning it at its new location, while keeping
the "ALT" key pressed.

Note:

The standard toolbar can only be configured via "Drag & Drop", if the check-boxes
"Configurable" and "Drag & Drop with Pressed ALT Key" have been activated in the
"Menu/Toolbars" tab of the "Options/Settings.." menu.
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2.8 Font Palette

Use the font palette to quickly change the font and font color of text objects as well as the
line color of standard objects.

Icon Description

Changing the Font

Changing the Font Size

Changing the Font Color

Changing the Line Color

Note:

You can place the font palette anywhere in the workspace or anchor it to a border.

The "Toolbars..." menu item in the View menu can be used to bring the font palette in and
out of view as necessary.

Changing the Font
The currently active font is displayed in the box.

Changing the Font Size
The font size in points (pt.) which is currently active is displayed in the box.

Changing the Font Color

The square in the  icon takes on the color which was selected last. This color can be
directly assigned to another text object by clicking on the icon.

Changing the Line Color
The function affects the following colors:

• The color of the border in area objects

• The line color in line objects

The square in the  icon takes on the color which was selected last. This color can be directly
assigned to another object by clicking on the icon.
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2.9 Status Bar

In addition to general program information, the status bar displays the name of the selected
object and its position coordinates.

Note:

The "Toolbars..." menu item in the View menu can be used to bring the status bar in and
out of view as necessary.

2.10 Layer Bar

In the layer bar, click which of the 16 layers (layer 0 through layer 15) should be switched
to visible. Objects are created in the first visible graphic layer. Layer 0 is reserved for this
purpose in Graphics Designer.

Note:

The system does not allow you to switch off all of the layers.

You can place the layer bar anywhere in the workspace or anchor it to a border.

The "Toolbars..." menu item in the View menu can be used to bring the layer bar in and out
of view as necessary.
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2.11 Tag Bar

The tag bar allows you to easily connect tags with object attributes to make them dynamic.

The tags are selected from the tag bar. The connection of a tag and an attribute is carried
out by dragging and positioning the selected tag using the mouse.

There are two locations where a tag can be positioned:

• above an object in the picture

• above an attribute in the "Properties" tab of the "Object Properties" dialog box

Positioning a Tag above an Object in the picture:
If a tag is positioned above an object, the attribute to be made dynamic cannot be specified.
Therefore the following rules apply:

• For objects possessing a simplified configuration dialog box, the attribute to be made
dynamic is fixed.
The following table lists the objects and their dynamic attribute.

Object Attribute

I/O Field Output Value

Bar Graph Process Connection

Status Display Current Status

Text List Output Value

Check-Box Selected Boxes

Radio-Button Selected Boxes

Slider Object Process Connection

• For all ActiveX and customized objects possessing the "tagflag" attribute, the static
value of this attribute will be set; the attribute will not be made dynamic.

The update cycle used is the default cycle as set in the "Settings" dialog box of the "Object
Default Values" tab. The "Settings" dialog box is opened via the "Options"/"Settings..."
menu.

Tags cannot be positioned above standard objects such as circles and lines.

Positioning a Tag above an Attribute:
If a tag is positioned above an attribute in the "Properties" tab of the "Object Properties"
dialog box, the attribute will be made dynamic by this tag.
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2.12 Object Properties

The "Object Properties" window displays all of the properties of a selected object, an object
group, or the defaults for an object type. These properties can be changed or copied.
Furthermore, objects can be made dynamic here by setting the appropriate attributes, and
they can be linked with actions.

Structure
The "Object Properties" window consists of the following items:

• Pin to affix the window

• Pipettes to copy and assign properties

• Object List

• "Properties" Tab

• "Events" Tab

Pin
The pin gives you the opportunity to affix the "Object Properties" window to a specific
location on the screen. The window can be moved to a desired position and remains open
even when other objects are being processed. Its contents changes to reflect the currently
selected object.

2.12.1 Pipettes for Transferring Object Properties

How to Transfer Object Properties:

1. Double-click on the object whose properties you want to transfer. This opens the
"Object Properties" window.

2. Click on the pin to affix the window.

3. Click on the left pipette icon .

4. In the object list or in the workspace, select the object to which you want to transfer
the copied properties.

5. Click on the right pipette icon .

Note:

Only object properties of matching object characteristics (for example, colors, border
weights, etc.) are transferred.

Object List
In the object list, you can select additional objects in order to process them without closing
the "Object Properties" window.
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How to Select an Object from the Object List:

1. Click on the arrow in the object selection list to open the list.

2. Click on the desired object. The name of the active object is displayed to the left of the
selection list.

Note:

Objects that contain at least one dynamic attribute or one configured event are highlighted
in a "bold" font in the object list.

2.12.2 "Properties" Tab

The properties of the selected object are defined in the "Properties" tab.

Subject Tree
The object properties are arranged in groups in a subject tree in the left half of the
"Properties" tab. When you select a group in the subject tree, the associated attributes are
displayed in the right half of the window.

The following are examples of subjects which are possible depending on the object:

• Geometry

• Colors

• Styles

• Flashing

• Filling

• Font

• Limits

• Miscellaneous

• Axis

• Output/Input

Note:

Subjects that contain at least one dynamic attribute are highlighted in a "bold" font in the
subject tree in the "Properties" tab.
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Attributes
You can change the attributes using either value inputs, palettes, or pop-up menus,
depending on the type of attribute.

The attributes can be made dynamic. In this case the attribute change is made either using a
tag or the return value of an action.

Attribute Settings
The attributes are dependent on the object type and on the subject which you selected from
the subject tree. Four settings are assigned to each attribute:

• Static (S ...) for the static properties of the attribute,

• Dynamic (D ...) for making the attribute dynamic,

• Current (C ...) to specify the update cycle for the attribute,

• Indirect (I ...), for the case that the tag via which the attribute is to be made dynamic is
addressed indirectly.

A green light bulb in the "Dynamic" column shows that the attribute is dynamically linked
with a "Tag".

If the attribute was made dynamic using a "Dynamic Dialog Box",  the light bulb is
replaced by a red lightning bolt.

If the attribute was made dynamic using a "C-Action," the light bulb is replaced by a green
lightning bolt.

An attribute which is to be made dynamic using a "C-Action" that has not yet been
compiled is marked by a yellow lightning bolt.

Information on making an attribute dynamic can be found under "Making an Attribute
Dynamic".

Static Attributes
You can set certain properties for each attribute. These properties are set in the defaults and
can be changed statically as well as dynamically for each attribute.

Note:

With multiple selection, all of the attributes of the selected objects are listed in the
"Properties" tab. However, only attribute values that are identical in all of the objects are
displayed. If you change an attribute, the new attribute value is displayed regardless of
whether the attribute was changed in one, multiple, or all objects.
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How to Change an Attribute with Switchover:

1. Select the desired subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute or on the property set in the
"Static" column (for example, Object: Static Text; Subject: Font; Attribute: Text
Orientation). The attribute changes, for example, Vertical/Horizontal.
If the name of the attribute is already selected, the attribute can by changed with a
single mouse click.

or

Click the right mouse button on the property which is set in the "Static" column. This
opens the pop-up menu. Confirm the "Edit" menu item to change the property of the
attribute.

How to Change an Attribute by Selecting One of Multiple Options:

1. Select the desired subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute or on the property set in the
"Static" column (for example, Object: Circle; Subject: Flashing; Attribute:
Background Flash Frequency). Click on one of the options offered.

For example:. 

If the name of the attribute is already selected, the list of available options can be
opened with a single mouse click.

or

Click the right mouse button on the property which is set in the "Static" column. This
opens the pop-up menu. Select the "Edit" menu item and then select the desired
property for the attribute.

How to Change the Value of an Attribute:

1. Select the desired subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute (e.g. Rectangle; Subject:
Geometry; Attribute: Position X). This opens the input dialog box.

For example: 



08.99 Structure

WinCC Manual 2-43
C79000-G8276-C160-01

If the name of the attribute is already selected, the entry dialog box can be opened
with a single mouse click.

or

Double-click on the attribute value in the "Static" column. The old value will be
selected and the cursor be set.
If the name of the attribute is already selected, the old value can be selected with a
single mouse click.

or

Click the right mouse button on the value displayed in the "Static" column. This opens
the pop-up menu. Select the "Edit" command.

3. The old value will be selected and the cursor be set. Enter the new value for the
attribute by overwriting the old one.

How to Change the Text of an Attribute:

1. Select the desired subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute (e.g. Static Text; Subject:
Font; Attribute: Text). This opens the input dialog box.

For example: 

If the name of the attribute is already selected, the entry dialog box can be opened
with a single mouse click.

or

Double-click on the attribute value in the "Static" column. The old value will be
selected and the cursor be set.
If the name of the attribute is already selected, the old value can be selected with a
single mouse click.

or

Click the right mouse button on the text displayed in the "Static" column. This opens
the pop-up menu. Select the "Edit" command.

3. The old text will be selected and the cursor be set. Enter the new text for the attribute
by overwriting the old one.
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Note:

If the text input contains control characters, they are also displayed in the object properties
(for example, \r\n corresponds to CR/LF).

How to Change the Color of an Attribute:

1. Select the "Colors" subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute or on the color displayed in
the "Static" column (for example, Object: Ellipse; Subject: Colors; Attribute:
Background Color). This opens the color palette.

For example: 

If the name of the attribute is already selected, the color palette can be opened with a
single mouse click.

or

Click the right mouse button on the color displayed in the "Static" column. This opens
the pop-up menu. Select the "Edit" menu item, which then opens the color palette.

3. Select the new color for the attribute from the color palette or click on the "Other..."
button to select a different color.
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How to Change the Pattern of an Attribute:

1. Select the "Styles" subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute or on the pattern displayed in
the "Static" column (for example, Object: Bar; Subject: Styles; Attribute: Fill Pattern).
This opens the pattern palette.

For example: 

If the name of the attribute is already selected, the pattern palette can be opened with a
single mouse click.

or

Click the right mouse button on the pattern displayed in the "Static" column. This
opens the pop-up menu. Select the "Edit" menu item, which then opens the pattern
palette.

3. Select the new pattern for the attribute.
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How to Change the Line Style of an Attribute:

1. Select the "Styles" subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute or on the line displayed in the
"Static" column (for example, Object: Line; Subject: Styles; Attribute: Line Style).
The selection dialog box for the line style will be opened.

For example: 

If the name of the attribute is already selected, the selection dialog box for the line
style can be opened with a single mouse click.

or

Click the right mouse button on the line style displayed in the "Static" column. This
opens the pop-up menu. Select the "Edit" command to open the line style selection
dialog box.

3. Select the new line style for the attribute.

How to Change the Line Weight an Attribute:

1. Select the "Styles" subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute or on the line displayed in the
"Static" column (for example, Object: Line; Subject: Styles; Attribute: Line Weight).
The selection dialog box for the line weight be opened.

For example: 

If the name of the attribute is already selected, the selection dialog box for the line
weight can be opened with a single mouse click.
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or

Click the right mouse button on the line weight displayed in the "Static" column. This
opens the pop-up menu. Select the "Edit" menu item, which then opens the line weight
selection dialog box.

3. Specify the new line weight for the attribute using the greater/smaller buttons or enter
the new value for the line weight in pixels directly in the entry field.

How to Change the Line End Style of an Attribute:

1. Select the "Styles" subject in the subject tree. The corresponding attributes are
displayed in the right half of the window.

2. Double-click on the name of the corresponding attribute or on the line displayed in the
"Static" column (for example, Object: Line; Subject: Styles; Attribute: Line End
Style). This opens the selection dialog box for the line end style.

For example: 

If the name of the attribute is already selected, the selection dialog box for the line end
style can be opened with a single mouse click.

or

Click the right mouse button on the line displayed in the "Static" column. This opens
the pop-up menu. Select the "Edit" menu item, which then opens the line end style
selection dialog box.

3. Select the new line end style (left and right) for the attribute.
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How to Change the Font of an Attribute:

1. Select the "Font" subject in the subject tree. The attributes are displayed in the right
half of the window.

2. Double-click on the name of the corresponding attribute or on the font displayed in the
"Static" column (for example, Object: I/O Field; Subject: Font; Attribute: Font). This
opens the selection dialog box for fonts.

For example: 

If the name of the attribute is already selected, the selection dialog box for the font can
be opened with a single mouse click.

or

Click the right mouse button on the font displayed in the "Static" column. This opens
the pop-up menu. Select the "Edit" command. The font will be selected and the cursor
be set.

3. Select a new font for the attribute or overwrite the selected font name with the name
of the new font.

or
Double-click on the displayed font in the "Static" column. The font will be selected and the
cursor be set.
If the name of the attribute is already selected, a single mouse click will suffice.
Overwrite the selected font name with the new font name.
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How to Change an Attribute through Picture Selection:

1. Depending on the object, select the "Picture," "Pictures" or "Status" subject in the
subject tree. The corresponding attributes are displayed in the right half of the
window.

2. Double-click on the name of the corresponding attribute or on the displayed graphic in
the "Static" column (for example, Object: Round Button; Subject: Pictures; Attributes:
Picture Status Off; or Object: Status Display; Subject: Status; Attribute: Flash
Picture). The selection dialog box for the picture selection be opened.

If the name of the attribute is already selected, the selection dialog box for the picture
selection can be opened with a single mouse click.

or

Click the right mouse button on the graphic that is displayed in the "Static" column.
This opens the pop-up menu. Select the "Edit" command. The existing entry will be
selected and the cursor be set.

or

Double-click on the displayed graphic in the "Static" column. The existing entry will
be selected and the cursor be set.
If the name of the attribute is already selected, a single mouse click will suffice.

3. Select the desired graphic for the attribute or click on the "Search..." button - to search
for the graphic in another folder - or overwrite the selected picture name with a new
name.

Note:

To delete an assigned picture, use the "Cancel Selection" button.
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How to Delete a Language Entry:

1. Select the "Miscellaneous" subject in the subject tree. The attributes are displayed in
the right half of the window.

2. Double-click on the "Configured Languages" attribute (e.g. Object: Static Text;
Subject: Miscellaneous; Attribute: Configured Languages). This opens the selection
dialog box for languages.

For example: 

If the name of the attribute is already selected, the selection dialog box for the
languages can be opened with a single mouse click.

or

Double-click on the displayed language in the "Static" column. The existing entry will
be selected and the cursor be set. Instead of the language name, the language index
will be displayed.
If the name of the attribute is already selected, a single mouse click will suffice.

or

Click the right mouse button on the language displayed in the "Static" column. This
opens the pop-up menu. Select the "Edit" command. The existing entry will be
selected and the cursor be set. Instead of the language name, the language index will
be displayed.

3. Change the assigned language entry of the object by selecting a language or overwrite
the selected language index with a new one.
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Making an Attribute Dynamic
You can make an attribute dynamic by linking it with a tag or an action.

How to Link an Object with an Existing Tag:

1. Click on the object.

2. Open the pop-up menu using the right mouse button. Select the "Properties" menu
item.

3. Select the subject and the corresponding attribute from the "Properties" tab, for
example "Flashing" - "Background Flash Color On".

4. Click on the light bulb with the right mouse button and select the "Tag ..." menu item
from the pop-up menu.

5. In the tag dialog box, select the required tags.

The light bulb turns green.

Alternatively, the tag names can also be entered directly in the "Dynamic" column. For this,
double-click on the light bulb. The existing entry will be selected and the cursor be set.
Overwrite the selected tag name with the new tag name.
The light bulb turns green.
If the attribute is already selected, a single mouse click on the light bulb suffices.

A further possibility is dragging the tag name with the mouse from the tag list and dropping
it in the appropriate line of the "Dynamic" column.

Note:

If the tag name is entered directly in the "Dynamic" column, no check is performed to
determine whether a tag of this name exists.

How to Link an Object with a New Tag:

1. Click on the object.

2. Open the pop-up menu using the right mouse button. Select the "Properties" menu
item.

3. Select the subject and the corresponding attribute from the "Properties" tab, for
example "Flashing" - "Background Flash Color Off".

4. Click on the light bulb with the right mouse button and select the "Tag ..." menu item
from the pop-up menu.

5. In the tag dialog box, click on the  button and assign parameters to properties of
the new tag in the dialog box.

6. After setting the parameters, select the required tag from the tag dialog box.

The light bulb turns green.
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How to Link an Object with a New Action:

1. Click on the object.

2. Open the pop-up menu using the right mouse button. Select the "Properties" menu
item.

3. Select the subject and the corresponding attribute from the "Properties" tab, for
example "Flashing" - "Background Flash Frequency".

4. Click on the light bulb with the right mouse button and select the "Dynamic Dialog
Box ..." or "C-Action ..." menu item from the pop-up menu.

5. Edit the "Dynamic Value Ranges" dialog box or configure a "C-Action".

A red lightning bolt (dynamic dialog box) or a green lightning bolt (C-Action) replaces the
light bulb.

Setting the Update Cycle
The update cycle determines how up-to-date the object attributes are, and thus determines
how current the dynamic object is.

You can select one of the standard cycles for the dynamic TAB sequence, or you can set
your own cycle time.

Indirect addressing is not possible with actions.

Indirect Addressing of an Attribute
A string tag for making the attribute dynamic must be provided with indirect addressing.
This string tag contains the name of another tag whose contents trigger the attribute change.
By changing the name in the string tag, you can access different tags dynamically.

Indirect addressing is marked with a check-mark.

2.12.3 "Events" Tab

In the "Events" tab, you define actions to be carried out by the selected object.

Subject Tree
Object events are divided into groups in the subject tree in the left half of the "Events" tab.
When you select a group in the subject tree, the associated events are displayed in the right
half of the window. You can link each event with a hotkey that also triggers the action.

The following are examples of subjects which are possible depending on the object:

• Mouse

• Keyboard

• Focus

• Miscellaneous

• Property subjects with the attributes of the object
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Note:

Subjects that contain at least one configured event are highlighted in a "bold" font in the
"Events" tab subject tree.

Events

If an event is linked to an action, the  lightning bolt is green. Standard functions are
available for the actions. You can select the standard functions with a dialog box. You can
also program your own actions in the C programming language.

If the action has not been compiled, the  lightning bolt will be yellow.

When you configure actions, the attributes must be accessed using their OLE automation
names.

If a direct connection is configured for the event, the  lightning bolt is blue. A direct
connection is easy to configure and performs very fast during runtime.

Object Event
Each object in a picture can be linked with actions.
You can trigger an action with the following events:

• Mouse event, when the pointer is on an object:
Press or release the left or right mouse button.

• Keystroke event:
Press or release a key

• Miscellaneous object events:
Changing the object

• Events which are linked to an attribute of the object:
Changing an object attribute
Changing the status of a tag which affects an object attribute.

Notes on Runtime Behavior:

Event Mouse - Mouse Click: The event is triggered by releasing the mouse button, but
only if the mouse pointer is over the object when the button is pressed and released.

Event Mouse - Press Left/Right: The event is triggered directly by pressing the mouse
button over the object.

Event Mouse - Release Left/Right: Releasing the mouse button triggers the event for the
object over which the mouse pointer was located when the mouse button was pressed.

Triggering Events
The triggering of events is dependent on the object you select from the subject tree. The
following setting is assigned to every triggering event:

• Action (A ...), to display an assigned action or direct connection,
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Selecting the Action
The following two entirely different possibilities are available for further processing events:

• C-Action
A "C-Action" occurs by linking an event with a function which is formulated in the
ANSI-C programming language and is triggered cyclically or by the event.
You can find information about linking an event with a function to an action under
"Linking an Event with a Function".
The lightning bolt in the object properties window turns green if the event is linked to
a function.

• Direct Connection
To establish a direct connection, select a source element (constant, dynamic object, or
tag) and link it with a target element (current dialog box, object, or tag) from the
“Direct Connection” dialog box.
How to configure a direct connection is described in "Adding Dynamics with a Direct
Connection".
The lightning bolt in the object properties window turns blue if a direct connection has
been configured for an event.

How to Link an Event with a Function:

1. Click on the object.

2. Open the pop-up menu using the right mouse button. Select the "Properties" menu
item.

3. In the "Events" tab, select the subject and the corresponding attribute, for example,
"Mouse" - "Mouse Action".

4. Call up the pop-up menu for the action dialog box by clicking the right mouse button
on the lightning bolt.

5. Select the "C-Action ..." menu item.

6. Configure and compile the "C-Function".

The lightning bolt in the object properties window turns green.
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3 Action Configuration

3.1 Introduction

"Actions" are functions which are formulated in the ANSI-C programming language and
are executed cyclically or in response to an event.
Examples of events are keystrokes, changes in object properties, or changes in the value of
tags.

Actions to be linked with any of the following:

• Graphic object

• Process value archives (see Volume 3, Tag Logging, Section 3.3.2.2)

• User archives (see Volume 3, Tag Logging, Section 3.3.4.2)

• Compressed archives (see Volume 3, Tag Logging, Section 3.3.3.2)

• Archive tags (see Volume 3, Tag Logging, Section 3.4.3)

•  Loop in Alarm - functionality of the message system

The return value of a function, for example, can control a property of the object to which
the action is linked.

Functions and actions which may be used throughout a project or across projects are called
"Global Scripts". They are not linked to an object.

In addition to the project functions, you can also use "internal functions", the system’s own
standard functions, as well as all functions in the standard C library (included in the internal
functions).

Note:

Action processing is performed via an interpreter module. When implementing numerous
or extensive actions, you should, therefore, plan for a higher system load. It is therefore
better to replace extensive actions with separate DLLs (Dynamic Link Libraries).
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3.2 Linking Actions to Graphic Objects

An action can be linked to an attribute of a graphic object.
The function used has a return value. This return value is used to control the attributes
which are linked to the object.
Before you can formulate an action and link it to an object, you must first open the picture
which contains the object in the Graphic Designer.

You can now utilize the Dynamic Wizard, which will support you in formulating your
action  (see Section 3.2.2).

If you want to formulate the action yourself, the following additional steps are required:

• Open the "Object Properties" dialog box for the desired object.

• If you would like to make the properties of the object dynamic, select the "Properties"
Tab.

• If you would like to react to an event with an action in conjunction with the selected
object, select the "Event" Tab.

Making Object Properties Dynamic
You selected the "Properties" tab in the "Object Properties" dialog box.
Now select the category of properties which contains the attribute you want to influence
during runtime. Example: for a rectangle, you would select the geometric properties and
position X.

Click the right mouse button on the white light bulb in the "Dynamic" column in the
"Position X" line.
This opens a pop-up menu with the following options for making a property dynamic:

• Adding dynamics using the Dynamic dialog box

• Adding dynamics with a C-Action

• Adding dynamics with a tag value

• Deleting a dynamic creation which is already present
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3.2.1 Making Object Properties Dynamic with the Dynamic Dialog Box

By clicking the right mouse button on the white light bulb in the "Object Properties" dialog
box, you opened a pop-up menu and selected "Dynamic Dialog Box...".
This opens the "Dynamic Value Ranges" dialog box.

Using tags, functions, and arithmetic operators, the dynamic is formulated here into an
expression. When entering decimal numbers in the expression, the only permissible decimal
character is the period.

The value of the expression and the status of the tags used in the expression work together
to create the attribute value. You determine how this occurs by setting the following options
in the box:

• Select the data type of the expression result.
The data type determines the ways in which the value ranges are defined.

• Set value ranges and assigning attribute values

• Evaluate the status of the tags used in the expression

Finally, you must specify the trigger to be used with the value of the expression to update
the attribute value.

Note:

If you do not specify an update event and the expression contains no tags, the system uses
the default cycle with a default cycle time as the update event. If the expression contains
tags, "Tag" is used as the update event with a default cycle time.

Finally, the formulation of the dynamic is converted into an action.

You have now made the selected object attribute dynamic.
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Note:

When you copy the object whose attribute you just made dynamic into the Graphics
Designer, the action that is linked to that attribute is copied along with it.

At runtime, the attribute value is determined according to defined rules using the value of
the formulated expression and the states of the tags used in the expression.

How to Include a Tag as a Part of an Expression:

Click the left mouse button on the  button or, as an alternative, click the right mouse
button on the "Expression/Formula" line.
This opens the appropriate pop-up menu.
Click the left mouse button on "Tag...".
This opens the "Select Tag" box where you can select the tag you wish to use in the
dynamic expression:

Select the tag either by double clicking the left mouse button on the tag name, or single
clicking the left mouse button on the tag name and then clicking the "OK" button. The
"Select Tag" box is then closed.
You then return to the "Dynamic Value Ranges" dynamic dialog box. The tag name,
enclosed by single quotation marks (‘), will be displayed in the "Expression/Formula" line
to the right of the cursor position or replaces the selected text.

Note:

A tag name can also be entered directly in the "Expression/Formula" field of the "Dynamic
Value Ranges" dialog box. Observe the following:

Tag names must always be enclosed by single quotation marks (‘)

Tag names must not contain the symbols +, -, *, or /
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How to Include a Function as Part of an Expression:

Click the left mouse button on the  button or, as an alternative, click the right mouse
button on the "Expression/Formula" line.
This opens the appropriate pop-up menu.
Click the left mouse button on "Function...".
This opens the "Function Browser" box:

Select the desired function; if necessary, use the mouse to open a folder. The following
alternatives are also available to you:

• Double-click the left mouse button on the function names:
This opens the dialog box for assigning parameters to this function.
After providing the function with its current parameters, you return to the "Dynamic
Value Ranges" box. The function is entered at the insertion mark in the
"Expression/Formula" line with its current parameters.

• Select the function and click on the "OK" button. The "Function Browser" box closes.
The function and its formal parameters are then entered in the "Dynamic Value
Ranges" box in the "Expression/Formula" line at the insertion mark

• Click the right mouse button on the function names:
This opens a pop-up menu.
Select the menu item "Parameter Assignment" which will place you in the dialog box
for assigning parameters to this function.
After providing the function with its current parameters, you return to the "Dynamic
Value Ranges" box. The function is entered at the insertion mark in the
"Expression/Formula" line with its current parameters.

• Click the right mouse button on the function names:
This opens a pop-up menu.
Select the menu item "Apply". The function and its formal parameters are then entered
in the "Dynamic Value Ranges" box in the "Expression/Formula" line at the insertion
mark. The "Function Browser" box remains open.
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If you marked text in the "Expression/Formula" line, the selected text was replaced by the
formula.
If necessary, enter the current parameters in the set of parentheses following the function
name.

For assigning parameters, see Section 3.2.1.2, Making a Function Dynamic Using a C-
Action, "How to Assign Parameters to a Function"

How to Include an Operator as Part of an Expression:

Click the left mouse button on the  button or, as an alternative, click the right mouse
button on the "Expression/Formula" line.
This opens the appropriate pop-up menu.
Click the left mouse button on "Operator...".

This opens a second menu in which you can select the desired operator by clicking on it
with the left mouse button.

This closes both menus and enters the selected operator to the right of the insertion mark in
the "Expression/Formula" line.

The following operators are available:

Operator Description

+ Addition

- Subtraction

* Multiplication

/ Division

Note:

You can also use the keyboard to enter operators. In that case, however, use only the
operators listed in the above table. Other operators will lead to errors because all of the tests
executed in the generated C-Functions are performed in floating-point format.

How to Determine the Data Type of the Expression:
You specify the data type of the expression by clicking with the left mouse button on the
appropriate entry in the "Data Type" field.

The data type of the expression determines the type of value ranges which you may need to
set.
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How to Define a Value Range:
The adjustable value range depends on the data type selected.

Selected data type "Analog":
You can define value ranges for an expression in the "Result of the Expression/Formula"
field.
Set the value of the object attribute for each value range.
In order to do this, you must click the left mouse button on the "Add" box or click the right
mouse button on the "Result of the Expression/Formula" area and select "New..." from the
open pop-up menu.
The first value range, "Value Range1", is entered.

In the above example, the value range extends from the minimum value that the expression
can carry to a value of 100.
You can establish an additional value range in the same way.
The default high limit for a value range is 100 for "Value Range1". The default increment
to the high limit for the next value range is 100.
You can change the values for the high limits and attributes by double-clicking the left
mouse button on the value to be changed (or click the right mouse button on the value and
then click "Edit...").
A box opens in which you can edit the value.

Note:

After a tag has been selected, the value "Tag" is entered in the "Event Name" field. The
selected tag is automatically used as a trigger tag and is scanned for changes during runtime
at a default cycle time of two seconds.
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Selected Data Type "Bool":
You can define the value of an object attribute for the cases "yes/TRUE" (value of the
expression <> 0) and "no/FALSE" (value of the expression = 0) in the "Result of the
Expression/Formula" list box.

You cannot set other valid ranges.
You can change the attribute value by double-clicking the left mouse button on the value to
be changed (or click the right mouse button on the value and then click "Edit...").
A box opens in which you can edit the attribute value.

Note:

After a tag has been selected, the value "Tag" is entered in the "Event Name" field. The
selected tag is automatically used as a trigger tag and is scanned for changes during runtime
at a default cycle time of two seconds.

Selected Data Type "Bit":
You define the value of the object attribute in the "Result of the Expression/Formula" list
box for either case in which a selected bit of a tag is set or not set.

You cannot set other valid ranges.
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You can change the attribute value by double-clicking the left mouse button on the value to
be changed (or click the right mouse button on the value and then click "Edit...").
This opens a box in which you can change the attribute value.

Use the "Select Tags" box to select the tags that contain the bits to be scanned. Open the

box by clicking on the left button  and then clicking on the  button.

You can set the bit of the previously selected tag by clicking on the right button . This
opens the "Bit Selection" box. Click on the desired bit to select it.

Note:

After a tag has been selected, the value "Tag" is entered in the "Event Name" field. The
selected tag is automatically used as a trigger tag and is scanned for changes during runtime
at a default cycle time of two seconds.

Selected Data Type "Direct":
The value of the expression is directly assigned to the object attribute. A value range cannot
be set.

Note:

After a tag has been selected, the value "Tag" is entered in the "Event Name" field. The
selected tag is automatically used as a trigger tag and is scanned for changes during runtime
at a default cycle time of two seconds.
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How to Specify the Effect of the Tag State on the Attribute Value:
If you want the tag status to influence an attribute value, you must activate the "Evaluate
the Status of the Tags" box by clicking on it with the left mouse button. This expands the
Dynamic dialog box.

The tag names (without quotation marks) used in the expression are located in the left part
of the window under Status. Click the left mouse button on a tag name. All of the states
which a tag can assume appear in the right part of the window.
You can set the appropriate attribute value for each state by clicking the left mouse button
on the attribute value to be changed (or click the right mouse button on the value and then
click "Edit").
This opens the "Value Input" box in which you can edit the value.
Close the "Value Input" box by clicking on the "OK" button. The value you entered is then
accepted as the attribute value.

How Value Ranges and Tag States are Evaluated:
The value which is assigned to the attribute is determined according to the following rules:

• Status Evaluation
The status evaluation has the highest priority. The system checks whether one or more
tags used in the expression have one or more states corresponding to the status list. If
so, the status with the highest priority determines the value assignment. The priority of
the states corresponds to their sequence in the status list; the first entry in the list has
the highest priority.

• Evaluation of the Value Ranges
If the status evaluation did not result in a value assignment, the value range containing
the value of the expression is determined. The attribute value linked to this value
range is assigned to the object attribute.
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How to Set the Update Event:

Click on the  button. This opens the "Change Trigger" box.

Note

The trigger event is assigned a default value by the system. The default depends on the
contents of your formulated expression in the "Dynamic Value Ranges" box.

If the expression contains one or more tags, the default value for the trigger event is "Tag"
and all tags contained in the expression are entered into the tag list.

If the expression contains no tags, the default value for the trigger event is then "Default
Cycle". The entry for the cycle is set with a default value.

You select an event by opening the "Event" list with the left mouse button and marking the
desired event by clicking on it with the left mouse button.
The following events are offered:

• Tag

• Default Cycle

• Picture Cycle

• Window Cycle

If you select "Default Cycle," "Picture Cycle", or "Window Cycle" as the event, you can
assign a trigger name to that event.
Input the trigger name by placing the cursor in the "Trigger Name" row using a left mouse
click.
If you enter the name using the keyboard, you delete an entry that was already there.
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If you selected "Default Cycle" or "Tag", you may need to change the cycle time.
Do this by opening the "Cycle" list with the left mouse button and marking the desired time
by clicking on it with the left mouse button.
You can select from the following cycle times:

Upon Change 5 min

250 ms 10 min

500 ms 1 h

1 s User Cycle 1

2 s User Cycle 2

5 s User Cycle 3

10 s User Cycle 4

1 min User Cycle 5

The "Upon Change" entry is only available if you selected "Tag" as the event.
If you selected "Tag" as the event, the contents of the "Change Trigger" box change:

Here you can input one or more tags which serve as a trigger for the action when their value
changes from one cycle to the next. If more than one tag is input, the action is triggered
when the value of one of these tags changes from one cycle to the next.
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There are three ways to enter tags:

• Using the left mouse button, place the cursor on the text line "Tag Name" and enter a
name. The name will not be enclosed by quotation marks.
Afterwards, click on the "Add" button.
The entered tag is entered into the tag list.

• Click the right mouse button on the "Trigger Name" column in the tag list. If you want
to use an existing tag, select “DM_Tags” from the displayed pop-up menu. The
"Select Tag" dialog will open from which you can select the desired tag.
If you want to enter the tag name directly, select "New" from the pop-up menu.

• Click on the  button to open the "Select Tag" box. In this box you may select
the desired tag:

Select the tag either by double clicking the left mouse button on the tag name, or single
clicking the left mouse button on the tag name and then clicking the "OK" button. The
"Select Tag" box is then closed.
You then return to the "Change Trigger" box. The selected tag is now entered in the
"Trigger Name" column in the tag list.

The system assigns a cycle time to the entered tags in the "Default Cycle" column. This is
the time span between two sequential scans of the tags for value change.

If you want to change the cycle time of a tag at a later time, use the following steps:

• Click the right mouse button on the cycle time to be changed to open the pop-up
menu.

• Select the new cycle time from the pop-up menu.

An alternative procedure is the following:

• Double click on the cycle time to be changed to open the "Update" box.

• Select the new cycle time from the list and click the "OK" button to close the box.
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Delete entered tags by marking them in the tag list and then clicking the "Remove" button.
Mark a coherent range of tags by marking the first tag in the range and then marking the
last tag with the "Shift" key pressed.
Mark individual multiple tags by marking the first tag and then marking all others with the
"Ctrl" key pressed.

Attention:
In the case of the "Tag" trigger event, the entry "At Change" is available as a cycle. This
means that the action is triggered as soon as the value of one of the tags in the tag list
changes. This type of trigger results in a heavy system load.

If the update event has been set, close the "Change Trigger" box by clicking on the "OK"
button.

How to Create an Action from the Entries:
You have completed all of the entries for making the object attribute dynamic.
In order for the settings to control the object attribute during runtime, you must create an
action from them.
Do this by clicking on the "Apply" button in the "Dynamic Value Ranges" dialog box. The
system then creates an action from the entries.
If errors occur during this process, they are reported in the "Error Messages" box:

In order to find the causes of the errors, click the "Details" button. The box is then enlarged
and displays a description of the errors.

If the action was generated without errors, the "Dynamic Value Ranges" box closes and you
return to the "Object Properties" box. The white light bulb in the "Dynamic" column is now
a red lightning bolt. It indicates that an action created with the Dynamic dialog box is
linked to this attribute.

Note:

If you wish to test your entries in the "Dynamic Value Ranges" box for errors without
creating an action, click on the "Test" button.

When you click the "Test" or "OK" button, the "Result of the Expression/Formula" list of
value ranges is sorted according to increasing range high limits.

You may view and edit the created action by clicking the right mouse button on the red
lightning bolt to open the corresponding pop-up menu. Select "C-Action..." from the pop-
up menu.
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Attention!
A box will notify you that this action was created using the "simplified script
configuration," that is, with the help of the Dynamic Dialog Box. This is significant
because once an action has been loaded as a "C-Action," it can no longer be processed
using the Dynamic Dialog Box.

Note:

If an action has been saved as a C-Action, the tags which are used are displayed as floating-
point C tags. When using C operators, for example for bit operations, this can lead to
incorrect results at runtime. Therefore, only the operators for the four basic arithmetic
operations should be used in the Dynamic Dialog Box.

For C-Actions, tag names used in the expression are enclosed by double quotation marks
(").

If a tag name contains the symbol ", the symbol \ will be placed in front of it in the C-
Action.
Example: ‘Motor"M"1’ will be changed to ‘Motor\"M\"1’.
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3.2.2 Making Object Properties Dynamic with the Dynamic Wizard

The Dynamic Wizard allows you to add dynamics, via C-Actions, to an object. If the
Wizard is executed, the preconfigured C-Actions and trigger events are set and stored in the
object properties.
The preconfigured C-Actions can be edited in the "Events" tab of the "Object Properties"
window.

The preconfigured C-Actions are divided into the following groups:

• System Functions

• Miscellaneous

• Standard Dynamics

• Picture Elements

• Import Functions

• Picture Functions

The different groups can be selected by clicking on the appropriate tabs with the left mouse
button.

Note:

The "Toolbars..." menu item in the View menu can be used to bring the Dynamic Wizard in
and out of view as necessary.

How to add Dynamics to an Object with the Dynamic Wizard:

1. In the Graphics Designer, select the object or picture to which you want to add
dynamics.

2. Select the Dynamic Wizard via a left mouse button click on the appropriate tab of the
C-Action categories.

3. In the Dynamic Wizard, select a C-Action by double-clicking with the left mouse
button.

4. Follow the instructions in the Dynamic Wizard dialog boxes.

After completing the Dynamic Wizard, the C-Action stored in the object properties can be
edited if necessary.
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3.2.2.1 System Functions

Start another application
With this function, an action can be created that starts another application. During the
course of the wizard, you will indicate the path and name of the application to be started.

Hardcopy
With this function, an action for creating a hardcopy of the display can be configured.

Setting Up a Redundant Link
For the SIMATIC S7 Protocol Suite, you can use this wizard to create a script which
realizes a dynamic switchover.

Language Switch
With this function, an action can be created that switches the data language.

Exit WinCC
With this function, an action can be created that exits WinCC.

Exit WinCC or Windows
With this function, an action can be created that exits WinCC or the operating system. You
can determine how the operating system is exited ("Shut down", "Restart", or "Log on as a
different user").

Exit WinCC Runtime
With this function, an action can be created that exits the runtime mode of WinCC.

Note:

If runtime is exited on a server, runtime will also be exited on all associated clients.

If runtime is exited on a client or multi-client, only that client or multi-client will be
affected.

If runtime is exited on a single-user system, only that single-user system will be affected.

3.2.2.2 Miscellaneous Functions

Display DXF File
This function creates a C-Action which links the object selected in the picture to a trigger.
When the trigger is activated, the specified DXF file is displayed in a window. The position
and size of the window are to be specified.

Select from the following triggers:

• mouse click

• press left mouse button

• release left mouse button

• press right mouse button

• release right mouse button
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The following parameters are to be entered:

• path and name of the DXF file

• X and Y coordinates of the upper left corner of the window

• height and width of the window

• name of the DXF file in the title bar of the window (yes/no)

3.2.2.3 Standard Dynamics

Operational if Authorized
With this function, an action can be created that checks the operator authorization of an
user.

Set/Reset Bit
With this function, an action can be created that sets or resets one bit of a tag. You will be
asked by the wizard to indicate the tag to be changed as well as the bit number.

Dialog Box for Creating Dynamics with Priority List

Dialog box for creating dynamics with priority list
In this dialog box, the color changes controlled by the tag states can be set. The color can
be determined by a single tag or by the logical connection of multiple tags.
As the Logical connection, "AND" and "OR" conditions are
available.
A maximum of 10 color definitions are possible. These definitions will be processed in the
displayed order. Entries that are at the top of the list have a higher priority than entries at
the bottom. The last list entry is always the default entry. The default entry’s priority can
not be changed (it can not be moved up).

Creating the list of color changes:
To add new color conditions, first add a new line by clicking on the "New" button. The
blank entry will automatically be selected and conditions can be defined using the edit
buttons. The edit buttons are located below the color list.
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The buttons for editing conditions have the following functions:

 This button adds a new line to the list.

 All bit masks of the selected line are displayed sequentially. The bit masks can be
changed.

 This button opens the color selection dialog box.
The color selection dialog box can also be opened by double-clicking on the selected line.

 The selected line will be deleted.

 The selected line will be moved up in the list, which increases its priority.

 The selected line will be moved down in the list, which decreases its priority.

 The edited expression will be transferred to the selected list line.

 Except for the default entry, all list entries will be removed.

 The expression will be deleted.

Editing the expression:
The following functions are available using the buttons:

• Tag

• and

• or

• Open Bracket

• Close Bracket

• Undo

available. If the syntax permits, the selected tag, logical expression or bracket will be
placed at the end of the expression. "Undo" removes the last section of the expression.
The new/edited expression is transferred into the selected line of the list via the "Apply"
button.
The expression can not be edited manually.
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The buttons for editing the expression have the following functions:

 This button opens the tag browser. All tags of the Bit, Byte, Word and DWord
type will be displayed. After selecting the tag, a dialog box for entering its value will be
displayed.

 If the syntax permits, a logical "AND" connection is added to the expression.

 If the syntax permits, a logical "OR" connection is added to the expression.

 If the syntax permits, an open bracket is added to the expression.

 If the syntax permits, a closing bracket is added to the expression.

 This button deletes the last section of the expression.

Dialog box for setting the tag bit mask:
In this dialog box, the bits of the tag to be checked are specified.
A byte (a bit for bit tags) of the tag value will be displayed. The states to be checked are
entered here. An ’x’ indicates that the bit will be ignored.
If ’0’ or ’1’ is entered, the state of the concerned bit will be checked accordingly.

Make a Property Dynamic
This function allows you to link an object property to a tag and make that object property
dynamic via the tag value. During the course of the wizard, you will be asked to indicate
the object property and tag.

Set/Reset Multiple Bits
With this function, an action can be created that sets or resets multiple bits of a tag. You
will be asked by the wizard to indicate the tag to be changed and the bit number.

Network Entry
Use this function to realize direct entry into the network at runtime. This is triggered by an
event which must be configured for an object.
If the event occurs, the Step7 program editor is started and the corresponding network is
entered directly.



08.99 Action Configuration

WinCC Manual 3-21
C79000-G8276-C160-01

In order to use the function, the following prerequisites must be fulfilled:

• The WinCC project which contains the picture from which the network entry is
to be made and the Step7 project must be located on the same computer.

• The WinCC project must be created as a subfolder of the Step7 project (Step7
project\wincproj\WinCC project).

• The S7 tags are mapped to WinCC tags.

The event which is to trigger the entry into the network is set on the current object, e.g.
"Click with the left mouse button" on a button. Moreover, the selected WinCC tag is linked
to one of the attributes of the current object to be set by you, e.g. to the background color of
the button. This attribute is controlled by the contents of the WinCC tag upon change of the
tag value.
If the triggering event occurs at runtime at the respective object, e.g. click with the left
mouse button, the Step7 program editor (KOP, FUP, AWL) is started and the network
defined by the selected tag is entered directly.

Add Dynamics to the Prototype
This function allows you to add dynamics to an object property via an element of a
structure tag.

Link a Prototype to a Structure
This function allows you to link an object property that has been edited via “Add Dynamics
to a Prototype” to a tag of the data type “Structure Type”.

Dynamically Instantiate Prototype
Use this function to link at runtime an object property of face plates or customized objects
that have been edited with "Add Dynamics to Prototype" to a tag of a structured data type.

Copy Tag Value
This function allows you to copy the value of one WORD-tag to another WORD-tag.
During the course of the wizard, you will be asked to indicate the source and target tag.

Set Tag Value
This function allows you to set the value of a tag. During the course of the wizard, you will
be asked to indicate the tag to be changed and the value.

Move Object
The object properties “Position X" and "Position Y" can, for example, be linked to tags
during the course of the wizard, making the position of the object dynamic.

Fill Object
With this function, an action can be created that makes the fill level of an object dynamic
via a tag. During the course of the wizard, you can define, in addition to the tags, the upper
and lower limits for the fill levels 0% and 100%.

Output String Tag
With this function, the “Text” attribute of an object can be linked to a text tag. This C-
Action is only available for objects containing the “Text” attribute.
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Link Picture Element to Measurement Point
Links a picture element to a measurement point.
All available measurement points in the Control Center whose structure type corresponds to
the selected picture element are offered via the tag selection dialog box.

Direct Output
Outputs the contents of a tag to an I/O field.
The function expects the following data:

• cycle time

• tag name

Simultaneous Input/Output
Outputs the contents of a tag to an I/O field and allows the user to change the contents.
The function expects the following data:

• cycle time

• tag name

Bar Graph Current Value
Outputs the contents of a tag as current value to a bar graph.
The function expects the following data:

• cycle time

• tag name

• minimum and maximum value of the bar display

• zero point of the bar display

3.2.2.4 Picture Elements

Creating a Picture Element as Type
The assignment of the object properties of a picture to the structure components of a
structured data type is made using the Type Wizard, for example:

• Provide the output value of an I/O field with .ActualValue every second

• Provide the process driver connection of a bar graph with .Temperature every 2
seconds

Here, .ActualValue and .Temperature are components of a structured data type.
The original picture is made into a type picture.
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Creating Instances in the System Picture
Use the Instance Wizard to create a picture window in a father window and call up a type
picture in this picture window. Here, you specify with which tag of a structured data type
the picture window functions and where the picture window is positioned. With the
Instance Wizard, you can position the picture window in different ways:

• as a permanent element in the picture

• as an element which can be displayed or hidden, callable via a button

• as multiple elements which can be displayed or hidden, each callable via a button

• as a permanent button with definable name. The default name of the element
may be a tag.

3.2.2.5 Import Functions

Import Messages
This wizard allows you to accept a COROS LS-B message list into WinCC. Additional
information can be found in the "Hantmigr.doc" file on the WinCC CD-ROM.

Import S5L Only Tag
This wizard allows you to accept a COROS LS-B tag list into WinCC. Additional
information can be found in the "Hantmigr.doc" file on the WinCC CD-ROM.

Import S7 S5 - Assignment List
This wizard allows you to read an assignment list of Step 5 or Step 7 into WinCC.
Additional information can be found in the "Hantzuli.doc" file on the WinCC CD-ROM.
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3.2.2.6 Picture Functions

Picture Navigation
This function creates a C-Action which links the object selected in the picture to a trigger.
When the trigger is activated, the selected picture navigation is performed.

Select from the following triggers:

• mouse click

• press left mouse button

• release left mouse button

• press right mouse button

• release right mouse button

Select from the following picture navigation functions:

• display start picture

• display previous picture

• display next picture

• display marked picture

• mark picture

Picture Change in the Window
This function allows you to change the content of a window object in a Graphics Designer
picture.

Single Picture Change
With this function, an action for a picture change can be created. During the course of the
wizard, you will be asked to indicate the name of the new picture to be displayed.

Display Error Box
With this function, an action can be created to display an error box. You will be asked by
the wizard to indicate the type of instruction (information, question, or emergency box) as
well as the title and text of the message.

Clicking on a button returns the following value:

button returned value

OK 1

Cancel 2

Yes 6

No 7

Display WinCC Dialog Box
This function allows you to display any Graphics Designer picture in a picture window. The
name of the picture to be displayed and the appearance of the picture window are set during
the course of the wizard.
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3.2.2.7 Example of Adding Dynamics

1. In the Graphics Designer, create a picture with an object of the type “Button”.

2. Select the button.

3. Activate the Dynamic Wizard via a double-click on the picture function “Display
Error Box”.

4. In the wizard window “Select Trigger,” select “Left mouse key” as the trigger event
and click on the “Next” button.
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5. In the wizard window "Set options", determine the content of the title line and
instruction text, as well as the appearance of the message window. Afterwards, click
on the "Next" button.

6. In the final wizard window, click on the "Finish" button.

The C-Action generated by the wizard can be edited via the button’s pop-up menu item
"Properties" ("Events" tab).

7. Save the picture.

8. Activate the project by clicking on the  button in the Graphics Designer toolbar.

9. In runtime, if you position the mouse pointer above the button, the mouse pointer will
be displayed with a green lightning bolt. If you click the left mouse button, a message
window displaying the texts you configured will open.
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3.2.3 The Dynamic Wizard Editor

Using this editor, Wizard Scripts can be created which allow the user to easily generate
actions in the Graphics Designer.

The editor makes available an interface with which scripts can be created, edited, and read,
i.e. made available to the actual Dynamic Wizard.

In addition to basic editor functions such as creating, opening and saving a script (similar to
a text editor), the editor also offers the following functions:

1. Create Dynamic Wizard Data (CWD)

This function is used to read in all available Wizard Scripts for the currently set
language and prepare them for editing in the Dynamic Wizard.
The generated data file is stored in the WinCC installation path (Installation
path\wscripts\dynwiz.cwd).

 
2. Read Wizard Script

With this function, additional Wizard Scripts can be read and be made available to the
Dynamic Wizard.
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3. Change the Wizard Language

The language for which the Wizard Script is configured or the Wizard Script which is to
be edited is set here. The languages supported in WinCC are made available,
independent of the installed languages.

Changing the Wizard language does not affect the overall system or the configuration
interface.

4. Change the Object

The Dynamic Wizard, which is also available in the editor for test purposes, is
dependent on the various object properties in the Graphic Designer.

To test a new or an existing Wizard Script, this function can be used to switch to an
existing object in an existing picture.

Using the newly selected object, the Dynamic Wizard is adjusted to display only those
Wizard Scripts which are applicable to this object.

5. Display Wizard Scripts

All Wizard Scripts available to the system are displayed for the set language.
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Additionally, in this dialog box existing Wizard Scripts can be deleted from the list of
Wizard Scripts.

6. Edit Help

You can configure your own help texts for the Wizard Scripts. These help texts are
assigned to the pages configured in the scripts and can be called up by the user.

The help texts can only be created for scripts which have already been read in.
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The Help Editor:

Using this dialog box, a help text can be stored for each page generated by the Wizard
Script.
The first entered line is used as the title, i.e. is displayed bold and underlined.

7. Compile Wizard Scripts

Before testing a new Wizard Script, the script can be compiled and checked for
compilation errors in here.
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3.2.4 Making Object Properties Dynamic with a C-Action

By clicking the right mouse button on the white light bulb in the "Object Properties" box,
you opened a pop-up menu and selected "C-Action...". The "Edit Action" box is then
opened.
Using the C language, you formulate here the function which you would like to use to
control object attributes. In this formulation you may use the preprogrammed C-Functions
which the system makes available in the left half of the box. You only need to perform the
parameter assignment.

The function becomes an action when you assign it an update event.

Note:

If you do not specify an update event, the system uses the default cycle with a default cycle
time as the update event.

You can use the return value of your function to control the attribute that is linked to your
action.
Within the function, you can access each attribute of every single object in each picture
using the Get... and Set... functions. This means you can read and set the attribute value.

The formulated function needs to be compiled. During compilation, errors which may have
occurred are reported.
If the compilation is carried out without errors, the formulation of the action is completed,
and the action is linked to the attribute.
A compiled C-Action is marked with a green lightning bolt in the "Object Properties" box.

Note:

After formulating the action, you can exit the "Edit Action" box and return to the "Object
Properties" box without compiling the action. A box will notify you of this situation. Select
"Compile Yes or No". If you decide not to compile the action, this is noted with a yellow
lightning bolt in the "Dynamic" column within the "Object Properties" box.

Actions which have been compiled error-free can be exported and stored in a file.
Exported actions can be reimported and linked with a new attribute. The imported action
can then be edited if necessary.

Note:

When you copy the object whose attribute you just made dynamic into the Graphics
Designer, the action that is linked to that attribute is copied along with it.
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 How to Formulate a C-Function:
Open the "Edit Action" box:

Formulate the function in the right half of the window. The first line contains the header file
to be linked. The second line contains the function names followed by parentheses
containing the formal parameters, as well as the left (open) parenthesis. The parameters are:

Parameter Meaning Type

lpszPictureName Picture name of the active picture char pointer

lpszObjectName Object name of the selected object char pointer

lpszPropertyName Attribute name of the attribute to
which the action is to be linked

char pointer

The last line contains the right (close) parenthesis.

Edit the C-Function in this section of the window.
The following edit functions are available:

Function Keyboard

New line Enter

Delete character to the right Delete

Delete character to the left Backspace

Jump to the beginning of the line Home

Jump to the end of the line End

Jump to start of text Ctrl+Home

Jump to end of text Ctrl+End

Move the insertion point with the cursor keys

Cut selected text Ctrl+X
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Function Keyboard

Copy selected text Ctrl+C

Paste text from the Clipboard Ctrl+V

Function Mouse

Mark text with left mouse button

Mark a word Double-click with left mouse
button

Move the insertion point with left mouse button

Additional edit functions include:

• Write mode is "Insert".

• The selected text is replaced by the next character selected using the keyboard.

• Expanded selection
Select an area:
Place the cursor where you wish the selection to begin, hold down the Shift key, and
then place the cursor where you wish the selection to end.
Expand a selection:
Hold the Shift key and place the cursor at the desired end of the selection.

You can place fully programmed functions within your function at the cursor location. This
function replaces selected text. Open the folders in the left half of the window and select the
desired function by clicking on it with the right mouse button.
This opens a pop-up menu in which you select the "Parameter Assignment" menu item.
This opens the "Assigning Parameters" dialog box where you can assign parameters to the
selected function.
Once the parameter assignment has been completed successfully, the selected function with
its current parameters is inserted at the insertion mark. This function replaces selected text.

Note:

You can also open the "Assigning Parameters" box by double-clicking the left mouse
button on the desired function.

If you want to edit the parameter assignment yourself, select "Accept" from the pop-up
menu.
The selected function is inserted at the cursor location as "Prototype". This means it
contains a declaration of the data types and the formal parameters. This function replaces
selected text.

You can insert tag names by clicking on the  button. This opens the "Select Tag" box
from which you select the desired tag.
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How to Assign Parameters to a Function:
By clicking the right mouse button on the function name in the "Edit Action" box, you
opened a pop-up menu and selected the "Parameter Assignment" menu item.
The "Assigning Parameters" box opens.

The entries in the "Description" and "Data Type" columns are informational.
You can enter parameters in the following ways:

Once all of the parameters have been entered, close the "Assigning Parameters" box by
clicking on the "OK" button.
The selected function and its parameters are placed at the insertion mark in the "Edit
Action" box.
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How to Enter a Tag as a Parameter:

In the "Setting Parameters" box, you opened the drop-down menu by clicking on the 
button and selected the "Select Tag" entry.
The "Select Tag" box opens.

Select the tag either by double clicking the left mouse button on the tag name, or single
clicking the left mouse button on the tag name and then clicking the "OK" button. The
"Select Tag" box is then closed.
You then return to the "Assigning Parameters" box and the selected tag is entered as a
parameter.
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How to Enter a Picture, Object, or Attribute Name as a Parameter:

In the "Assigning Parameters" box, you opened the drop-down menu by clicking on the 
button and selected the "Graphic Objects" entry.
This opens the "Picture Browser" dialog box:

The left third of the box contains a list of pictures available in the project.
Click on a picture to select it. The "Object" list includes the objects that are contained in the
selected picture.

If you want to use the picture name as a parameter, highlight the object name of the picture
in the "Objects" list by clicking on it ("NewPdl1" in the example above) and then click on
the "OK" button.

If you want to use the object name of an object contained in a picture as a parameter, click
on the desired object name in the "Objects" list. The "Properties" list is filled with the
attribute names owned by the selected object. Click on the "OK" button.

If you want to use an attribute name as a parameter, click on the desired attribute names in
the "Properties" list and then on the "OK" button.

This closes the "Picture Browser" box.
You return to the "Assign Parameters" box and the selected name is entered as a parameter.
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How to Set the Update Event:

Click on the  button. This opens the "Change Trigger" box.

Note

The trigger event is assigned a default value by the system. The default depends on the
contents of your formulated expression in the "Dynamic Value Ranges" box.

If the expression contains one or more tags, the default value for the trigger event is "Tag"
and all tags contained in the expression are entered into the tag list.

If the expression contains no tags, the default value for the trigger event is then "Default
Cycle". The entry for the cycle is set with a default value.

You select an event by opening the "Event" list with the left mouse button and marking the
desired event by clicking on it with the left mouse button.
The following events are offered:

• Tag

• Default Cycle

• Picture Cycle

• Window Cycle
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If you select "Default Cycle," "Picture Cycle", or "Window Cycle" as the event, you can
assign a trigger name to that event.
Input the trigger name by placing the cursor in the "Trigger Name" row using a left mouse
click.
If you enter the name using the keyboard, you delete an entry that was already there.

If you selected "Default Cycle" or "Tag", you may need to change the cycle time.
Do this by opening the "Cycle" list with the left mouse button and marking the desired time
by clicking on it with the left mouse button.
You can select from the following cycle times:

Upon Change 5 min

250 ms 10 min

500 ms 1 h

1 s User Cycle 1

2 s User Cycle 2

5 s User Cycle 3

10 s User Cycle 4

1 min User Cycle 5

The "Upon Change" entry is only available if you selected "Tag" as the event.
If you selected "Tag" as the event, the contents of the "Change Trigger" box change:
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Here you can input one or more tags which serve as a trigger for the action when their value
changes from one cycle to the next. If more than one tag is input, the action is triggered
when the value of one of these tags changes from one cycle to the next.

There are three ways to enter tags:

• Using the left mouse button, place the cursor on the text line "Tag Name" and enter a
name. The name will not be enclosed by quotation marks.
Afterwards, click on the "Add" button.
The entered tag is entered into the tag list.

• Click the right mouse button on the "Trigger Name" column in the tag list. If you want
to use an existing tag, select “DM_Tags” from the displayed pop-up menu. The
"Select Tag" dialog will open from which you can select the desired tag.
If you want to enter the tag name directly, select "New" from the pop-up menu.

• Click on the  button to open the "Select Tag" box. In this box you may select
the desired tag:

Select the tag either by double clicking the left mouse button on the tag name, or single
clicking the left mouse button on the tag name and then clicking the "OK" button. The
"Select Tag" box is then closed.
You then return to the "Change Trigger" box. The selected tag is now entered in the
"Trigger Name" column in the tag list.

The system assigns a cycle time to the entered tags in the "Default Cycle" column. This is
the time span between two sequential scans of the tags for value change.
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If you want to change the cycle time of a tag at a later time, use the following steps:

• Click the right mouse button on the cycle time to be changed to open the pop-up
menu.

• Select the new cycle time from the pop-up menu.

An alternative procedure is the following:

• Double click on the cycle time to be changed to open the "Update" box.

• Select the new cycle time from the list and click the "OK" button to close the box.

Delete entered tags by marking them in the tag list and then clicking the "Remove" button.
Mark a coherent range of tags by marking the first tag in the range and then marking the
last tag with the "Shift" key pressed.
Mark individual multiple tags by marking the first tag and then marking all others with the
"Ctrl" key pressed.
If the update event has been set, close the "Change Trigger" box by clicking on the "OK"
button. This returns you to the "Edit Action" box.

How to Control the Attribute Value:
You can use the return value of your C-Function to control the attribute that is linked to
your action.

Example:
In Graphics Designer, open the picture that contains the object whose attribute you want to
make dynamic.
Open the "Object Properties" box by clicking the right mouse button on the appropriate
object.
In this box, select the property to be made dynamic. In the following figure, this is the
"Circle1" object and the "Colors" property.
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Click the right mouse button on the light bulb for the appropriate attribute that you want to
make dynamic, for example, on the light bulb in the line with the "background color"
attribute.
From the pop-up menu that opens, select "C-Action...". The "Edit Action" window opens.
In the right half of the window, it already contains the completed structure of a C-Function.
Formulate your function and set the trigger that will call your C-Function during runtime.

The function consists of the definition of both local tags xvar and result.
The GetTagDWord ("var") function assigns the value of the process tags var to the local
tags xvar.
The if-else construct assigns the result tags result a value of CO_RED (value for the color
red) if the value of the xvar tags is greater than 128, otherwise it receives the value
CO_BLUE (value for the color blue).
The last line ensures that the function value of the C-Function main receives the value of
the event tags.
A change of the value of the var process tags was selected as the trigger event and the value
of the tags is checked every two seconds by the Control Center.

How to Compile the C-Function:

Click on the  button in the toolbar of the "Edit Action" box. The function is compiled.
This procedure is displayed in the box’s toolbar with a "Compile Action..." message.

If the function was compiled without errors, the status bar displays the message "0 Error(s),
0 Warning(s)".

If errors occurred during the compilation, the message "n Error(s), m Warning(s)" appears
in the status bar. The n and m characters are the number of errors or warnings.
The errors and warnings appear in the lower part of the edit window, dividing the window.
Using the mouse, you can shift the split bar right or left .
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After a successful compilation, close the "Edit Action" box by clicking on the "OK" button.
This returns you to the "Object Properties" box. The attribute linked to the action is marked
with a green lightning bolt in the "Dynamic" column. This shows that this attribute is linked
to a compiled C-Action.

Note:

If you close the box without compiling the action, you are notified of this in a dialog box.
You then have the choice of compiling or returning to the "Object Properties" box without
compiling. If you decide not to compile the action, this is noted with a yellow lightning bolt
in the "Dynamic" column within the "Object Properties" box.

How to Export an Action:

Click on the  icon in the standard toolbar.
This opens the "Save As" box:

Here you select the storage location and the name of the export file. The "act" file name
extension is appended by the system.
Clicking the "Save" button exports the action and loads it in the file you selected.
The "Save As" box is closed.
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How to Import an Action:

Click on the  icon in the standard toolbar.
This opens the "Open" box:

Select the desired import file. Import files are files which were previously created by
exporting an action, and which have the extension "act".
Clicking the "Open" button imports the action and then closes the "Open" box.

Note:

The imported action completely replaces an action that was previously created.
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3.2.5 Adding Dynamics to Objects with a Tag Value

By clicking the right mouse button on the white light bulb in the "Object Properties" box,
you opened a pop-up menu and selected "Tag...".
The "Select Tag" box opens.
Select the tag which you would like to use to add dynamics to the affected object attribute.
The "Select Tag" box is closed and you return to the "Object Properties" box. The
previously white light bulb is now green. It shows that a tag was used to set the dynamics in
the attribute. The tag name is entered next to the green light bulb.

Alternatively, the tag name can also be entered directly in the "Dynamic" column. To do
this, double-click in the "Dynamic" column. A cursor is set and, if present, the tag name
marked. Now enter the desired tag name.

A further possibility is dragging the tag name with the mouse from the tag list and dropping
it in the appropriate line of the "Dynamic" column.

Note:

When the tag name is entered directly in the "Dynamic" column, no check is performed to
determine whether a tag with this name exists.

Next, set the type of addressing in the "Object Properties" box.
There are two addressing methods:

• Direct addressing.
The tag value is assigned to the attribute directly.

• Indirect addressing.
The tag must be of type string and contain, as a value, the name of a tag whose value
is assigned to the attribute.

The default addressing method is direct.

Next, set the update cycle. The default value is 2 seconds.
Through the update cycle, you determine the frequency with which the tag value updates
the attribute value.

This concludes setting the dynamics of the attribute.
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How to Select a Tag from the "Select Tag" Box:
Open the "Select Tag" box.

Select the tag either by double clicking the left mouse button on the tag name, or single
clicking the left mouse button on the tag name and then clicking the "OK" button. The
"Select Tag" box is then closed.
You return to the "Object Properties" box. The tag name is now entered in the object
attribute line in the "Dynamic" column. The white light bulb is colored green.

How to Select a Tag from the Tag Bar:
The tag bar is visible and the "Object Properties" dialog box is open.
Select the desired tag from the tag bar with the left mouse button and drag it into the
"Object Properties" dialog box. Drop the tag in the "Dynamic" column of the appropriate
attribute by releasing the mouse.

How to Select the Method of Addressing:
A string tag for making the attribute dynamic must be provided with indirect addressing.
This string tag contains the name of another tag whose contents trigger the attribute change.
By changing the name in the string tag, you can access different tags dynamically.

Double-click with the left mouse button on the square located in the "Indirect" column in
the object attribute line.
Alternatively, you can open a pop-up menu by clicking the right mouse button on the
appropriate square. From this pop-up menu you can select the method of addressing by
clicking the right or left mouse button.

With an empty square, the addressing method is set to "direct".
In the case of indirect addressing, the square contains a check-mark.



Action Configuration 08.99

3-46 WinCC Handbuch
C79000-G8276-C160-01

How to Set the Update Cycle:
There are two ways to set the update cycle.

Click the right mouse button on the "Object Attribute" line and the "Current" column. This
opens a pop-up menu with the following preset update cycles:

In addition to fixed cycle times, you will also find:

• Picture Cycle.

• Window Cycle.

• Upon Change.
The attribute value is updated when the tag value is changed.

• User Cycle 1 to User Cycle 5.
The times and names are presented as defaults.
The times as well as the names can be changed in the WinCC Control Center under
"Update Cycles".

Using the left or right mouse button, select the desired update cycle from the pop-up menu.
This closes the menu and enters the selected value in the "Current" column in the "Object
Properties" box.

You can also set the update cycle by double-clicking the left mouse button to open the
"Update" box. The box is located in the "Current" column on the line containing the
appropriate object attribute.
Open the list box here by clicking the left mouse button on the list window or on the button
to the right of the list window. Position the entries using the slider and select the update
cycle you want by clicking on it with the left mouse button.
Clicking on the "OK" button returns you to the "Object Properties" box. The update cycle is
now entered.
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3.2.6 Changing Tag Links

The links of object properties to tags can be changed later at any time. This can take place
either directly in the "Properties" dialog box of the respective object or with the aid of the
"Linking" function.
"Linking" offers the following advantages over making changes in the "Properties" dialog
box:

• Links of tags to objects and their properties are clearly displayed

• All links to all objects marked in the picture are displayed

• Links can be easily changed

The "Linking" function can be found in the "Edit" menu or in the pop-up menu of the
respective object.

How to Change Tag Links:

• Mark the objects in the picture whose tag links you would like to change.

• Select the "Linking" function from either the "Edit" menu or from the pop-up menu of a
marked object.

This opens the "Linking the Tag Link" window:

Displayed in the left half of the window are all tags which are linked to the marked objects.
In order to see the objects to which a tag is linked, click on the respective plus sign.
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Displayed in the right half of the window are the following details:

• The objects to which the tag marked in the left half of the window are linked ("Object"
column)

• For each of these objects, the object property that is influenced by the tag or, for a direct
connection, the triggering event ("Place of use" column)

• The "place of use" type ("Type" column)

• The dynamic type ("Dynamic type" column)

Change the column widths by using the mouse to shift the right border of a given column.
A double-click on the border optimally sets the column width so that the longest entry is
entirely visible.
The entries in a column can be sorted in ascending or descending order by clicking the
mouse on the respective column heading.
The border between the two window halves can be moved with the mouse.

Proceed as follows to change the tag link:

• Mark a tag name in the left half of the window.
This changes the link of all objects which are linked to this tag.

or

• Mark an object in the left half of the window.
This changes the link of this one object.

or

• Mark a line in the right half of the window.
This changes the link of the object contained in this line.

• Select "Linking" either in the pop-up menu or with the provided button.
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This opens the "Link Tag" window:

• Open the tag selection dialog box by clicking on the  button and select a tag, or
enter a new tag name by overwriting the old tag name.

• Click on the OK button to create the new tag link.

The tag name can also be changed directly in the left half of the window by marking the
respective tag and, after an additional mouse click, overwriting the tag name.

Note:

If the tag name is entered directly with the keyboard, no check is performed to determine
whether the entered tag actually exists in your project.
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3.3 Reacting to Events

You selected the "Event" tab in the "Object Properties" box and set an object, e.g.
"Rectangle1".
Now select the event category which contains the event for triggering the C-Function from
the left half of the box. This category could be, for example, a "Mouse Event".

Click the right mouse button on the white lightning bolt in the "Action" column, for
example, on the "Press Left" line. Now the function to be formulated is triggered when the
left mouse button is clicked on the "Rectangle1" object.
With keystroke events, the function is executed when the event occurs and the
"Rectangle1" object is selected.

Note:

The following restriction applies to keyboard events: The keys F10, Alt, and Print cannot
be used for process control.

A pop-up menu opens in which you can select any one of the following options:

• Create the function or edit an existing function (C-Action...)

• Establish a direct connection

• Delete the function (Delete)

Select "C-Action..." to formulate a new function or to change an already available function.
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The "Edit Action" box is then opened. Since you have already set the event, the  button
with which you usually configure the triggering event, is set to inactive in this box.
Formulate your C-Function.

See also Section 3.2.1.2, Setting Dynamics with a C-Action

Note:

When you copy the object you just made dynamic in Graphics Designer, the action that is
connected to the object is copied along with it.

3.3.1 Using a Direct Connection

Configuring a direct connection for an event causes the ’value’ of the source element
(source) to be transferred to the target element (target) during runtime if this event occurs.
Sources can be constants, tags, or attributes of picture objects. Targets can be tags or
dynamic attributes of objects, dialog boxes, or tags.
Advantages of a direct connection are its easy configuration and improved performance
during runtime.

The appearance of the dialog box for configuring a direct connection is dependent on the
objects contained in the picture and on the source/target.

Basic Elements

Operating Element Description

Selects a configured picture that is to be displayed during a
picture change.

Opens the "Tag Selection" dialog box.

Object List Lists all objects contained in a picture. A selection can only
be made if an object is used as a source or target.

Property List Lists all dynamic attributes of a selected object. A selection
can only be made if an object is used as a source or target.

Direct/Indirect Tag Set the tag addressing via these option buttons. In direct
addressing, the read/write access is carried out to the
indicated tag. In indirect addressing, the indicated tag must be
a text tag. The read/write access is carried out to the tag
which has been entered in the text tag.

The option buttons can only be accessed if a tag is used as a
source or target.

Tag, Operating Message An operating message will be displayed if the event occurs.
The check-box can only be selected if a tag is used as the
source of the direct connection.

Note:

If an entry is incomplete, a message will be displayed.

WinCC cannot check if your input is logically correct or makes sense. Assignment errors
made can only be detected in the runtime mode.
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How to Configure a Direct Connection:

1. Select an object.

2. Open the pop-up menu using the right mouse button. Select the "Properties" menu
item.

3. In the "Event" tab, select the subject and the corresponding attribute, for example,
"Mouse" - "Mouse Action".

4. Call up the pop-up menu for the action dialog box by clicking the right mouse button
on the lightning bolt.

5. Select the "Direct Connection..." menu item.

6. In the “Direct Connection” dialog box, select the “Source” type:

Constant, to enter a string sequence into the text field (digits are converted by

WinCC) or to select a picture via the  button and the "Select Picture" dialog box

Property, to select an object and a dynamic property

Tag, to select a tag via the  button and the selection dialog box

These actions define the source element.

7. In the “Direct Connection” dialog box, select the “Target” type:

Current Window, to select a dynamic property of the current dialog box (the
"Target" - "Object" field remains empty),

Object in a Picture, to select an object and a dynamic property

Tag, to select a tag via the  button and the selection dialog box

These actions define the target element.

The lightning bolt in the object properties window turns blue.

Note:

If an entry is incomplete, a message will be displayed.

WinCC cannot check if your input is logically correct or makes sense. Assignment errors
made can only be detected in the runtime mode.

The object list contains the entry "this object". This entry should be used if you want to use
the properties of the currently selected object as the source or the target of a direct
connection. If an object is copied, its dynamics will be copied as well. The direct
connection of the object that has been created by the copy procedure will therefore point to
“this object”. The newly created object will therefore be used as the source or target of the
direct connection.
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3.3.1.1 Constants as Source of a Direct Connection

If a constant is selected as the source of the direct connection, a string chain can be entered
into the text field. The following table explains the effects of the text input on various target
elements:

Source Target Explanation

"picture1.pdl" Current Dialog Box/
Picture Name

If the event occurs, a picture change will be
carried out. In the dialog box, the picture
named “picture1.pdl” will be displayed.

"picture1" Button1 / Text If the event occurs, the object “Button1” will
be labeled “picture1”.

50 Rectangle1 / Width If the event occurs, the object “Rectangle1“
will be displayed 50 pixels wide.

50 Tag, with direct
operating message

If the event occurs, the tag will be assigned a
value of 50. An operating message will be
displayed simultaneously.

The  button can also be used to configure a picture change. This will open a dialog box
containing all the previously configured pictures.
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3.3.1.2 Object Properties as Source of Direct Connections

The following table explains the effects of various direct connections if an object property
is used as a source:

Source Target Explanation

Circle1 / Fill
Pattern

Rectangle1 / Fill Pattern If the event occurs, the fill pattern will
adapt to the fill pattern of the object
"Circle1".

Circle1 / Fill
Pattern

Current Window /
Width

If the event occurs, the width of the window
will adapt to the width of the object
"Circle1".

Bar1 / Height Direct Tag If the event occurs, the height of the object
"Bar1" will be assigned to the tag.

Note:

The object list contains the entry "this object". This entry should be used if you want to use
the properties of the currently selected object as the source or the target of a direct
connection. If an object is copied, its dynamics will be copied as well. The direct
connection of the object that has been created by the copy procedure will therefore point to
“this object”. The newly created object will therefore be used as the source or target of the
direct connection.
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3.3.1.3 Tags as Source of Direct Connections

The following table explains the effects of various direct connections if a tag is used as a
source:

Source Target Explanation

Direct Tag Tag2, indirect with
operating message

If the event occurs, the tag which has been
entered in tag2 will be assigned the value of
tag1. Additionally, an operating message will
be displayed.

Direct Tag Circle1/ Radius If the event occurs, the radius of object
"Circle1" will be assigned the value of the
tag.
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4 Appendix
This chapter describes the output formates for I/O fields and the assignments for text lists.

4.1 Output Formats for I/O Fields

Binary Data Format
The "Output Format" attribute controls the representation of the output values for the I/O
field.

You can select the predefined "Binary" output format from the selection list.

e.g. 

You can define your own output format in the "Enter Format" input field. The following
characters are allowed:

Character Effect on the character position
"1" Binary values "0" or "1"

Each "1" represents a character in the output value.
A preceding "0" indicates that leading zeros are inserted where necessary (up to a
maximum number of "1").
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Decimal Data Format
The "Output Format" attribute controls the representation of the output values for the I/O
field.

You can select the predefined "Decimal" output format from the selection list.

e.g. 

You can define your own output format in the "Enter Format" input field. The following
characters are allowed:

Character Effect on the character position
"s" Sign provided
"e" Exponent Display
"9" Number between 0 and 9
"0" Leading zero accompanies output
"." Decimal point

Examples: Value 1.0 is to be displayed

Output Format Display
9.9 1.0
s9.9 +1.0
s9.9e +1.0e+000
09.99 01.00
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String Data Format
The "Output Format" attribute controls the representation of the output values for the I/O
field.

You can select the predefined "String" output format from the selection list.

e.g. 

You can define your own output format in the "Enter Format" input field. The following
characters are allowed:

Character
* Any string with any length
? Any string with a length of "Number ?"

(for example, ???? for any string with 4 characters)

Character Effect on the character position
a Lower- or uppercase letters or numbers "0 ... 9"
AA Uppercase letters or numbers "0 ... 9"
b Lower- or uppercase letters
B Uppercase letters
d Sign ("+" or "-"), decimal point, blank, or numbers "0 ... 9"
t Separator "/", ":", ".", "," or blank
1 Number 0 ... 1
2 Number 0 ... 2
3 Number 0 ... 3
4 Number 0 ... 4
5 Number 0 ... 5
6 Number 0 ... 6
7 Number 0 ... 7
8 Number 0 ... 8
9 Number 0 ... 9
h Hexadecimal character 0 ... 9, A ... F, or a ... f
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Hexadecimal Data Format
The "Output Format" attribute controls the representation of the output values for the I/O
field.

You can select the predefined "Hexadecimal" output format from the selection list.

e.g. 

You can define your own output format in the "Enter Format" input field. The following
characters are allowed:

Character Effect on the character position
"f" Hexadecimal value "0" to "f"

Each "f" represents a character in the output value.
A preceding "0" indicates that leading zeros are inserted where necessary (up to a
maximum number of "f").
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4.2 Assignments for Text Lists

Decimal List Type
Use the "Assignments" attribute to assign the values for the text list.

Four range types ("To Value", "Single Value", "From-To Value", and "From Value") are
provided for the assignment in the "decimal" list type. Depending on the range type that is
set, the value range (relative to the value to be displayed) can be defined. Exactly one value
can be assigned to a text for the "Single Value" range type. The "From-To Value" range
type allows you to enter two values that define a value range (including the values you
enter). The "To Value" range type defines a value range that is open on the bottom and
reaches to include the value you entered. The "From Value" range is analogous to the "To
Value" range type and defines a value range that is open on the top.

If there is no text assigned to the value to be displayed, the text "***" is output in
configuration mode and in runtime mode.

Use the "Append" button to add a new list entry to the end of the list. Use the "Remove",
"Up", and "Down" buttons to remove a list entry or shift it up or down within the sequence
of the list.
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Binary List Type
Use the "Assignments" attribute to assign the values for the text list.

Using the "binary" list type, one text can be assigned to each bit number (relative to the
value to be displayed). The bit number has a value range of 0 to 31.

If there is no text configured for the bit number and if the corresponding bit is set as the
only one in the output value, the text "***" is displayed in configuration mode and in
runtime mode.

Use the "Append" button to add a new list entry to the end of the list. Use the "Remove",
"Up", and "Down" buttons to remove a list entry or shift it up or down within the sequence
of the list.

Bit List Type
Use the "Assignments" attribute to assign the values for the text list.

Exactly two texts can be configured for assignment to the "bit" list type. One is for the case
in which the bit that is observed has a value of 0, and one is for the case in which the bit has
a value of 1. Use the "Bit Number" attribute (value range 0 to 31) to specify which bit of
the value to be displayed is observed.
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1 Functionality
The "Alarm Logging" editor is responsible for acquiring and archiving messages. It
contains functions for accepting messages from processes, and for preparing, displaying,
acknowledging, and archiving them.

Alarm Logging

• provides comprehensive information about error and operating states.

• is used for the early detection of critical situations.

• avoids and reduces downtime.

• increases quality.

• provides targeted documentation of error and operating states.

The message system processes results from functions which monitor actions in the process,
on the automation level and in the WinCC System. The recorded message events are
reported by the system both visually and acoustically. The events are also archived
electronically and on paper. The messages can be accessed individually. Supplemental
information to individual messages ensures rapid error localization and rectification.

Alarm Logging is divided into two components: the Configuration System and the Runtime
System.

Tasks of the Alarm Logging Configuration System
Use the Alarm Logging Configuration System (Alarm Logging CS, ALGCS) to configure
your messages so that they are displayed in runtime the way you want them to be.
Configuration of the message system can be simplified through the use of the Wizards.

• The  System Wizard provides support when making the basic message system settings

• The Interconnection Wizard simplifies the assignment of process tags to messages.

• Moreover, various configuration dialogs are available which allow you to
simultaneously process several messages.

Tasks of Alarm Logging Runtime System
The task of the Alarm Logging Runtime System (Alarm Logging RT, ALGRT) is to
acquire the messages and accept the acknowledgements. It prepares the messages for
display and archiving.
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1.1 Definition of Terms

Archiving
Depending on the message class, changes which occur in message states are written to
configurable message archives.

• For short-term archives, the size of the archive is defined by the number of messages to
be archived. A short-term archive can only be created as a continuous archive. If the
maximum number of archived messages has been reached, the oldest messages are
overwritten. Up to 10000 message status changes can be stored in a short-term archive.
Messages which are stored in a short-term archive are displayed in a message window.

• For long-term archives, the archive size is determined by the time span over which the
messages are to be archived. A long-term archive can be either a continuous or a
sequence archive. In continuous archives, the oldest messages are overwritten after the
maximum number of archived messages has been reached. In sequence archives, the
archive is continued sequentially until the capacity of the storage medium is exhausted.
Messages which are stored in a long-term archive are displayed in a message window.

Single Message, Group Message
In Alarm Logging, a distinction is made between two message forms: single messages and
group messages.

• With single messages, every event is assigned a message.

• Group messages are used to summarize multiple single messages. As a result, the events
linked to the single messages trigger only the common group message. The single
message which triggered the group message cannot be determined.
One group message can be set up for each message class and message type. Moreover,
group messages can also be created using any single messages.

Single Acknowledgement, Group Acknowledgement
A pending message can be acknowledged in one of two ways:

• Messages which do not possess the "group acknowledgement" attribute must be
individually acknowledged.

• Group acknowledgement can be used to collectively acknowledge all individual
messages possessing the "group acknowledgement" attribute which are visible in a
message window.

Events
With events, a distinction is made between binary events and monitoring events:

• Binary events are changes in the state of internal or external tags.

• Monitoring events are not directly supported by Alarm Logging. The following are
monitoring events: overflow of archives and read-only memory, printer messages,
server failure, interrupted process communication.
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Initial Value Message, New Value Message

• The term "initial value message" is used to describe a form of message processing in
which the first message in a list of messages to undergo a state change since the last
acknowledgement is highlighted.

• The term "new value message" is used to describe a form of message processing in
which the first messages in a list of messages to undergo a state change since the last
acknowledgement are highlighted.

Messages
The purpose of a message system is to chronologically signal and archive events at a central
point which occur sporadically during the process. A message can be caused by an event or
a message frame.

• In general, a distinction is made between operating messages, error messages and
system messages. Operating messages are used for displaying a status in the process.
Error messages are used for displaying an error in the process. System messages are
used for displaying error messages from other applications.

• In Alarm Logging, messages with similar behavior (acknowledgement philosophy,
color of message states) can be grouped into message classes and message types.

Message Types, Message Classes

• Message classes differ from one another in acknowledgement philosophy. Messages
with the same acknowledgement philosophy can be integrated in a single message class.
In Alarm Logging, the message classes "Error", "System, requires acknowledgement",
and "System, without acknowledgement" are preconfigured. You can define up to 16
message classes in WinCC.

• Message types are subgroups of the message classes and can differ in the coloring of the
message states. Up to 16 message types can be created in WinCC for each message
class.

Message Blocks
The change in the state of a message is displayed during runtime in a message line. The
information to be displayed in the message line is defined using message blocks. There are
three different types:

• System blocks (e.g. date, time, duration, comments, ...) facilitate the specification of
information which is predefined and cannot be used freely. With system blocks, the
value of the message block (e.g. the time) is displayed in the message line.

• User text blocks make it possible for you to assign a message up to ten, different, freely
definable texts. With user text blocks, the content of the message block - the text
defined by you - is displayed in the message line.

• Using process value blocks, you can display the value of tags in the message line. The
formatting used can be defined. With process value blocks, the content of the message
block - the tag value defined by you - is displayed in the message line.
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Message Event, Message State

• Message events are the "Coming", "Going", and "Acknowledging" of messages. All
message events are stored in the message archive.

• Message states are the states which are possible for a message: "Came In", "Went Out",
"Acknowledged".

Message Window
In runtime, the changes in message states are output in a message window. The appearance
and operating options of the message window can be freely defined in Graphics Designer.
A message window contains in tabular form all messages which have yet to be displayed.
Each message to be displayed is output in its own line, the message line.
Definable filters can be used to influence the contents of the message window.

Depending on the source of the messages displayed in the message window, a distinction is
made between three types of message windows.

• Message lists are used for displaying currently pending messages.

• Short-term archive windows are used for displaying messages which are stored in a
short-term archive.

• Long-term archive windows are used for displaying messages which are stored in a
long-term archive.

Message Frames
Message frames originate from either the process or from the process-control monitoring
system. They are exchanged by the control system (or the monitoring application) and
Alarm Logging.

Message Tag
In the bit message procedure, the control system signals the occurence of an event in the
process via the message tag. Several messages can be masked via one message tag.

Message Procedure
Alarm Logging supports several message procedures: the bit message procedure, the
procedure for chronologically correct messages, as well as the procedure for analog alarms
for limit-value monitoring.

• In the bit message procedure, the control system signals the occurence of an event via
the message tag. The time stamp (date and time) of the message is made by Alarm
Logging.

• With chronologically correct messages, the control system transmits a telegram with the
message data when the event occurs. This is analyzed by Alarm Logging. The time
stamp (date and time) of the message is made by the control.

• With analog alarms, the course of an analog tag can be monitored for violation of the
upper and lower limit values.
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Message Line
In a message window, each message is displayed in its own message line. The contents of
the message line are dependent on the message blocks which are to be displayed. With
system message blocks (e.g. date, time), the value of the message block is displayed; with
process and user text blocks, the contents (e.g. the text defined by you) are displayed.

Reports
There are two types of message reports available in Alarm Logging.

• With message sequence reports, all state changes (came in, went out, acknowledged)
from all currently pending messages are output to a printer.

• With archive reports, all changes in message states stored in an archive are output to a
printer.

Acknowledgement Philosophy
Acknowledgement philosophy is the way in which a message is to be displayed and
processed from the time it "came in" to the time it "went out". In Alarm Logging, the
following acknowledgement philosophies can be realized:

• Single message without acknowledgement

• Single message with "coming" acknowledgement

• Single message with "going" acknowledgement

• Initial value message with single acknowledgement

• New value message with single acknowledgement

• New value message with double acknowledgement

• Message without "Went Out" state without acknowledgement

• Message without "Went Out" state with acknowledgement

Acknowledgement Tag
In the acknowledgement tags, the "acknowledgement state" of a message is stored. A
central signalling device can also be controlled using the acknowledgement tag.

Status Tag
In the status tags, the "Came In / Went Out - status" of the message type and an identifier
for messages requiring acknowledgement are stored.
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1.2 Structure of a Message

In runtime, messages are displayed as rows in a table. Here, an individual message is
composed of information which can be displayed in the fields of the table. These individual
pieces of information are called message blocks.

Message blocks can be divided into three categories.

• System Blocks
contain system data which are assigned by Alarm Logging. These data include date,
time, report ID, etc.

• Process Value Blocks
contain the values supplied by the process, for example, critical fill levels and
temperatures.

• User Text Blocks
texts which contribute to general information and understandability, for example,
explanations of messages, error location, and message source.

Whereas the contents of the system blocks are fixed, the contents of the process value
blocks and user text blocks can be modified by the user. Selections in system blocks affect
only their display; their reporting is not affected.

1.3 Displaying Messages in Runtime

In runtime, the events coming from the controls or process control system are detected by
Alarm Logging, analyzed and displayed in a message window. The appearance and
operating options of the message window can be freely defined in Graphics Designer.

Message Window as an ActiveX Control

The distinguishing feature of the message window, created as an ActiveX Control, is simple
message configuration. All information to be displayed can be set at the object, i.e. in
Graphics Designer.
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2 Structure of the Configuration System

After you open the Alarm Logging configuration system, a window that is divided into four
sections appears.

The menu bar is located at the top of the window. It contains the drop-down menus.

The toolbar is directly under the menu bar. Functions which are used often are loaded as
icons on this bar.

The project window is divided into the navigation window, data window, and table
window.
You can change the size of the individual window sections. The bottom border of the
window contains the status bar, which includes information about the current process.
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2.1 Menu Bar

All of the commands available in the Alarm Logging configuration system are divided
logically into groups and assigned to different menus in the menu bar. To execute a
command, open the appropriate menu, click on the command, and, if necessary, set the
required parameters in the dialog box which opens.

Menu Menu Command Shortcut

File Select Wizard
Save
Print Project Documentation
Project Documentation View
Printer Setup
End

CTRL + S
CTRL + P

Edit Undo
Cut
Copy
Paste
Properties

CTRL + Z
CTRL + X
CTRL + C
CTRL + V

View Toolbar
Status Bar
Large Symbols
Small Symbols
List
Details
Add/Remove columns ...
Language ...
Update F5

Messages Import Single Messages ...
Export Single Messages ...
Change Text Input Mode ...
Multiple Messages ...
Start Interconnection Wizard ...
Texts for Multiple Messages ...

Tools WinCC-System Messages ...
Add Ins ...

? Contents and Index
Direct Help
Using Help
Tutorial
About Alarm Logging

SHIFT + F1

Note:

In the following, only menu commands which vary from those found in standard Windows
applications or whose functionality exceeds that to which you may be accustomed will be
described in detail. Information about these menu commands can be found in the Direct
Help of the individual editors.
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Select Wizard
Use this command to call up various Wizards or important configuration dialogs for
simultaneously processing several messages.

• System Wizard: The Wizard is used for preconfiguring the message system.
Frequently used message blocks, message types and message archives are created
during this preconfiguration process.

• Interconnection Wizard: The Interconnection Wizard supports you when connecting
the messages to the Control Center tags.

• Delete Multiple Messages: This function opens a dialog in which you can delete
multiple messages.

• Delete Tag Connections of Multiple Messages: This function opens a dialog in
which you can delete the tag connections of multiple messages.

• Delete the Texts of Multiple Messages: This function opens a dialog in which you
can delete the message texts of multiple messages.

• Copy Multiple Messages: This function opens a dialog in which you can copy
multiple messages and append them to the list in the table window.

• Define the Texts of Multiple Messages: This function opens a dialog in which you
can define the message texts of multiple messages.

Note:

The System Wizard always generates the messages in German, English, and French. This is
independent of whether the languages are installed or whether the languages were set up in
the text library.
After the System Wizard has run, you can delete the languages which are not desired from
the text library.

All settings changed after the System Wizard has run will be lost if the Wizard is run again.

Print Project Documentation
Project Documentation View
Printer Setup

Use the command "Print Project Documentation" to print the message system to the set
printer. The template for the printout is the page layout "@ALGCS.RPL", which can be
changed with the "Report Designer". The project documentation provides information
about the configured single and group messages, the used message blocks, message classes
and message types as well as about the configured archives.

The command "Project Documentation View" is used to obtain a preview of the project
documentation.

Use the command "Printer Setup" to specify the printer to be used and the page layout.

Note

Additional information on printing project documentation can be found in Chapter Project
Documentation in the System Overview.
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2.1.1 "View" Menu

Add/Remove Columns
Use the "Add/Remove columns..." command to turn individual columns on or off in the
table window.

The table window is updated according to your selection criteria. The columns that are not
marked are turned off.

Language
Use the command "Language..." to open the dialog for switching the configuration
language. You may select the desired language from the list displayed.
The language switch affects only the texts that are stored in the text library. The language
of the user interface is not affected by this switch. If there are no texts stored for the
selected language, the default language (German) is set.

Note:

Enter the texts in the different languages in the Text Library editor.
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2.1.2 "Messages" Menu

Use this menu item to read messages that you created in other applications into the Alarm
Logging system or to store messages that you created in Alarm Logging for further
processing.

Structure of the Import/Export File
ASCII is the reference format for the import and export files. The individual message
blocks are separated by commas; the message lines are separated by paragraph symbols/line
breaks. Data are output/read-in using a standardized procedure which interprets the data in
the following order:

Note

You can find a table in alphabetical order in the Online Help.

The alphabetical order corresponds to the one used in Microsoft Excel.

The messages are only imported individually if they are in the file individually. Both of the
system-internal classes are also exported. System classes changed by the import are to be
disregarded.

Note:

If you want to import texts, the corresponding indices should be set to 0!

• How to Create a Header for an ASCII Table:

1. Export your messages to a text file.

2. Highlight the text and use "Ctrl + C" to copy it.

3. Open the exported text file.

4. Insert a paragraph break (empty line).

5. Use "Ctrl + V" to paste the text copied previously.

6. Save the text file and load it into your spreadsheet program (for example, Microsoft
Excel). Select "Comma" as the separator.

Standard Header for Additional Processing:
Number,Parameter,Class,Type,TextID 1,TextID 2,TextID 3,TextID 4,TextID 5,TextID
6,TextID 7,TextID 8,TextID 9,TextID 10,Block: 1,Block: 2,Block: 3,Block: 4,Block:
5,Block: 6,Block: 7,Block: 8,Block: 9,Block: 10,Process Value 1,Process Value 2,Process
Value 3,Process Value 4,Process Value 5,Process Value 6,Process Value 7,Process Value
8,Process Value 9,Process Value 10,Message Tag, Message Bit,Acknowledgement
Tag,Acknowledgement Bit,Status Tag,Status Bit,PLC Number,PLC
Subnumber,Infotext,Action Type,Function Name,Picture Name,Format DLL,
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Import Single Messages
Use the "Messages" "Import Single Messages..." menu item to import text files in which
messages are loaded in a standard text format into Alarm Logging. A "0" must be assigned
to available or open positions.
You can import single messages that were exported by WinCC Version 1.0 if you activate
the appropriate entry in the dialog.

How to Import Single Messages:

1. Click on the button next to the "File" box.

Select an import file from the file browser dialog which opens.

2. Set the import mode.

3. Select the "Import" button.

4. Use the "Close" button to exit the dialog.

Note:

When you create a text which is to be imported into the message system, make certain not
to use any special characters such as commas, semicolons, tabs, carriage returns or line
feeds as these characters are interpreted as field separators during the import.

Check files imported from external applications for load errors and connection errors.

Only text files (ASCII format) can be imported at this time.



08.99 Structure of the Configuration System

WinCC Manual 2-7
C79000-G8276-C160-01

Export Single Messages
This menu command allows you to export all messages defined or the messages of a certain
message class. By default, all messages to be exported are transferred into a text file.
Individual messages can not be selected.

Element Description

File The name of the export file is displayed here. The export file can

be selected via the  button and the file selection dialog box.

Format Currently, only text files (ASCII format) can be exported.

Selection If not all configured messages are to be exported, the "Selection"
button allows you to define message classes for export.

Set Text Identifiers
to 0

This option defines, if the message ID in the Text Library is
exported as well.
If the messages are to be imported into another project, it is
recommended to set all identifiers to 0.
If the messages are later to be imported back into the current
project, it is recommended to set the text identifiers not to 0.

Set Group Identifiers
to 0

This option defines, if the group identifier of the message is
exported as well.
If the messages are to be imported into another project, it is
recommended to set all identifiers to 0.
If the messages are later to be imported back into the current
project, it is recommended to set the group identifiers not to 0.

Export The "Export" button activates the export of the messages.

Cancel Export The "Cancel Export" button allows you to stop an export in
progress.



Structure of the Configuration System 08.99

2-8 WinCC Manual
C79000-G8276-C160-01

How to Export Single Messages:

1. Click on the button next to the "File" box.

Select an export file from the file browser dialog which opens.

2. Click on the "Selection..." button to select a text file.

3. Click on the "Export" button to start the export function.

4. Click on the "Close" button to exit the dialog.

Note:

Only text files (ASCII-format) can be exported at this time.

Change Text Input Mode
Use the "Text Input Mode" dialog to specify how changes in text affect the boxes of the
single messages.

Icon Description

Changes to the
selected text apply to
all identical texts.

If you change the text in one area, it is also changed in all of the
text boxes of the single messages that contain the same text.

Change applies only to
the selected text.

If you change the text in a text box, it only changes that box (as
you would normally expect).

Keep Setting The selected settings are retained for additional text changes,
otherwise, they only apply to the current change.

How to Change the Text Input Mode:

1. Select the "Change Text Input Mode" menu command from the "Messages" menu.

2. Set the desired options.

3. Exit the dialog.
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Edit Multiple Messages ...
Use the "Multiple Messages..." dialog to simultaneously edit several single messages.

Icon Description

Message numbers Numbers or number range of the single messages to be edited.

Delete Messages Delete the messages listed in the "Message numbers" box.

Append Copied
Messages To The End
Of The List

Add the messages listed in the "Message numbers" box to the end
of the table of the single messages.

Delete Tag
Connections Of The
Messages

Remove the tag connections of the messages listed in the
"Message numbers" box.

Delete Text
Connections Of The
Messages

Delete the text boxes of the messages listed in the "Message
numbers" box.

How to Edit Multiple Messages at the Same Time:

1. Enter the numbers or number range of the single messages you want to edit in the
"Message numbers" box.

2. Select the action to be carried out by means of the appropriate button.

3. Exit the dialog.

Interconnection Wizard
The Interconnection Wizard provides support for connecting the message and
acknowledgement tags of messages with the Control Center tags. The tag connections
generated by the Wizard can be changed later in the table window.

Additional information can be found in the "Configuring a Message System" chapter in this
manual.
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Assigning Text for Multiple Messages
Use the "Text for Multiple Messages" command to assign several user text blocks the same
text.
The entries in the text library will be changed according to the data you enter.

Icon Description

Message Numbers Enter the numbers of the messages to which you want to
assign a message text. The upper right corner of the dialog
contains an example of how to enter the message numbers.

Blocks 1 to 10 You can enter text up to 255 characters in each block. Blocks
1 to 10 represent the corresponding user text blocks.

Use the dialog that opens to insert process variables into your
user text blocks. The Insert Process Value dialog is described
in the properties of single messages.

Keep existing text If you exit the dialog by means of "OK", the entries in the text
library are changed appropriately. If you have already
assigned a text of a different language to a message number, it
is deleted if you do not activate the "Keep existing text"
function.
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2.1.3 "Tools" Menu

WinCC System Messages
The WinCC installation folder contains the file "LTMDaten.CSV" with special system
messages which can be activated at runtime by the various WinCC components. Use the
command "WinCC-System Messages" to open the dialog for integrating these messages
into your message system.
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Add Ins
Add Ins will only be integrated into the message system if needed.
Open the dialog to add the required objects by selecting the "Add Ins" entry from the
"Tools" menu.

After exiting the "Add Ins" dialog via a mouse click on "OK", the selected object will be
entered in the navigation window.

Note:

When you open the "Alarm Logging" editor for the first time in a newly created project, the
dialog for integrating Add Ins will be displayed automatically.
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2.2 Toolbar

The toolbar for the Alarm Logging configuration system has the following appearance:

These icons allow you to execute actions more rapidly. You do not have to make several
selections through the menus until you reach the required function.

Icon Description

Save

Cut

Copy

Paste

Print

View: Large Symbols

View: Small Symbols

View: List

View Details

Properties of a selected object

Call up context-sensitive Help
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2.3 The Project Window

The project window is the area on the monitor where the navigation window, data window,
and table window are located.
Pop-up menus are available for editing the individual objects.

The window is controlled according to the Control Center operation. You can learn more
about this subject in the "Control Center" section of the user manual.

Note:

You can activate any of the properties dialogs by double clicking the left mouse button on
the appropriate object.

2.3.1 Navigation Window

The project window is divided into three windows. The left side displays the navigation
window with a tree structure of the individual configuration sections. Work sequentially
through these areas to configure a message.

Element Description

Message blocks

Message classes

Group messages

Archives

Reports

Use pop-up menus to access the individual areas as well as their elements.
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2.3.2 Data Window

The data window, located on the right side of the screen, contains the icons for the available
objects. These can be used to access the settings for Alarm Logging for the selected project.

In the data window, a detailed list of object properties can be displayed ( Chapter 4.1.3.6
Detail View ). The contents of this list vary according to the selected object.

2.3.3 Table Window

The table window is located in the lower area of the window. It contains a table with all of
the created single messages and the configured properties.
The individual boxes can be edited. You can activate the properties directly by double
clicking on the boxes with the left mouse button.

2.4 The Status Bar

In addition to general program information, the status bar displays the configuration
language and the number of configured messages.

2.5 Find Window

This window type is opened to identify, link, or assign data that were created with other
tools in WinCC. Alarm Logging makes a distinction between the following window types:

• the select tags window,

and

• the selection dialog

2.5.1 Select Tag

A dialog box can be opened for linking tags by clicking the left mouse button on the desired
tag.
You can open folders or select tags with a double click. When you are finished, you return
to the starting point from which you opened the dialog box.

You can find additional details in the "Control Center" chapter of the user manual.

Note:

This dialog is provided via the Control Center. If you link your archive tags with external
tags, the data are read directly from the PLC.
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2.5.2 Selection Dialog

A selection dialog consists of the following items:

• two window sections with data objects

• a bar with buttons between the two window sections

You can shift (select) the data objects between the two window sections by using the
buttons.
Generally, selection dialogs are implemented to create a selection from a group of data
objects. As a rule, the left half of the window contains the starting group or the standard
group of data objects (source) and the right half of the window contains the selected group
of data objects (target).
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3 Configuring a Message System
This chapter explains how you:

• configure messages and message classes

• import and export single messages

• connect messages to the process

• configure the WinCC AlarmControl system for displaying messages in runtime.

How to Construct a Message System:

1. Use the System Wizard to create the basic structure of the message system.

•   The System Wizard

2. Configure the message blocks in accordance with your requirements.

•   Configuring Message Blocks

3. Configure the message system.

•   Configuring Message Classes

•   Configuring Message Types

•   Configuring Single Messages

•   Configuring Group Messages

4. Set the type of data archiving.

•   Configuring Archives

•   Configuring Records

5. Configure the WinCC Alarm Control System in "Graphics Designer" for displaying
the messages in runtime.

•   The WinCC Alarm Control System.

Note

Use the available Wizards and configuration dialogs to completely create the messages.
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3.1 The Wizards

The System Wizard
The Wizard is used for preconfiguring the message system. Frequently used message
blocks, message types, and message archives are created during the preconfiguration
process. You can modify the objects created by the Wizard at a later time to meet your
requirements.

How to Configure a Message System with the System Wizard:

1. Select the "Select Wizard" command from the File menu, then select the System
Wizard from dialog which opens. The Wizard is started after you click on "OK" to
exit the dialog.

2. Following the introductory picture, you can use the "Select Message Blocks" dialog to
specify which message blocks are to be created by the System Wizard.

3. Use the "Preset Classes" dialog to create two message classes with different
acknowledgement philosophies with the corresponding message types.

4. In the "Select Archive" dialog, you can specify whether an archive should be created,
and if so, which archive.

5. In the "Finale!" dialog, you obtain a summary of the message blocks, message classes
and archives to be created by the Wizard.

Note

All settings changed after the System Wizard has run will be lost if the Wizard is run again.

The Interconnection Wizard
The Interconnection Wizard provides support for connecting the message and
acknowledgement tags of messages with the Control Center tags. The tag connections
generated by the Wizard can be changed later in the table window.

How to Create Links with the Interconnection Wizard:

1. Open the "Messages" menu.

2. Select "Start Interconnection Wizard...."

3. In the "Interconnecting Tags: Message Tag" dialog field, use the  button to select
a tag which you would like to use as a message tag.

4. Enter the numbers of the messages to which you would like to link the specified
message tag.

5. In the "Interconnecting Tags: Acknowledgement Tag" dialog field, use the 
button to select a tag which you would like to use as an acknowledgement tag.

6. Enter the numbers of the messages to which you would like to link the specified
acknowledgement tag.

7. When the Wizard is ended, the selected tags are interconnected to the messages.
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3.2 Message Blocks

Message blocks, which are displayed as columns of a table, are used for constructing
messages. Specific data are entered in each block. Message blocks can be created or edited
for the three different block types:

• System message blocks

• User text blocks

• Process value blocks

In the "Available Message Blocks" area, the structure of the message blocks is displayed.
You can work in this window as you would in the project navigation window. There are,
however, no pop-up menus available.

Icon

Add...

Remove The selected message block is removed.

Properties The properties dialog for the selected message block is
opened. The parameters of the message block can be
changed.
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3.2.1 System Blocks

The message data that are internal to the system are entered in system blocks.
You can find a list of the system blocks in the appendix.

You can change the message system by means of a selection dialog.

You can remove system message blocks or add them from a specified selection list. During
configuration, you can change the properties of a system message block.

Note

You can activate the properties dialogs by double clicking the left mouse button on the
appropriate object in the data window.

3.2.1.1 Adding/Removing System Blocks

System blocks are added or removed using the "Add System Blocks" selection dialog.

How to Add or Remove System Blocks:

1. In the navigation window, activate the "Message Blocks" item.

2. Click the right mouse button to open the pop-up menu and select the "Message
Blocks" item.

3. Select the "System Blocks" item. Click the left mouse button on the "Add..." button on
the right side of the dialog.

4. In the selection window, select the desired parameters and then exit the window.

5. Exit the dialog.

or
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1. In the navigation window, open the "Message Blocks" item and select the desired type
(system, user text, or process value blocks).

2.  Click the right mouse button to open the pop-up menu and select the "Add/Remove..."
item.

3.  In the selection window, select the desired parameters and then exit the window.

3.2.1.2 System Block: Displaying/Editing Properties

You can display and edit the properties of system blocks by means of the properties dialog
of the respective system block. Depending on the type of system block, a tab is displayed in
which you can display and edit the specific properties of the respective system block.

How to Display the Properties of a System Block:

1. In the navigation window, activate the "Message Blocks" item.

2. Click the right mouse button to open the pop-up menu and select the "Message
Blocks" item.

3. In the tree structure in the dialog, double click on the "System Blocks" item.

4. Select the block you want to edit.

5. Click the left mouse button on the "Properties" button on the right side of the dialog.

or

1.  In the navigation window or data window, select the block type you want to edit and
select the block you want to edit.

2. Click the right mouse button to open the pop-up menu and select the "Properties"
item.

The "Message Blocks" dialog appears. The appropriate properties are displayed for the
given system block. You can now change the properties (by means of text boxes, options,
etc.).

Note

The status texts of the messages are displayed in the "Status" system block. This system
block should be configured with length sufficient to display the entire text.
You can activate the properties dialogs by double clicking the left mouse button on the
appropriate object in the data window.

3.2.2 User Text Blocks

The message system can be changed using a selection dialog.

You can remove user text blocks or add them from a specified selection list. During
configuration, you can change the properties of a user text block.

Note

The maximum length of text blocks is 254 characters.
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3.2.2.1 Adding/Removing a User Text Block

User texts are configured in the configuration system and output in conjuction with an
associated message. They cannot be changed while online in runtime. User texts include,
for example, plant identifiers, error location, error cause, etc.

User text blocks are added or removed by means of the "Add User Text Blocks" selection
dialog. The maximum length of text blocks is 255 characters. The display is, however, one
line and limited to the width of the monitor. Longer texts are truncated and cannot be
displayed.

How to Add or Remove User Text Blocks:

1. In the navigation window, activate the "Message Blocks" item.

2. Click the right mouse button to open the pop-up menu and select the "Message
Blocks" item.

3. Select the "User Text Blocks" item. Click the left mouse button on the "Add..." button
on the right side of the dialog.

4. In the selection window, select the desired parameters and then exit the window.

5. Exit the dialog.

or

1. In the navigation window, open the "Message Blocks" item and select the desired type
(system, user text, or process value blocks).

2.  Click the right mouse button to open the pop-up menu and select the "Add/Remove..."
item.

3.  In the selection window, select the desired parameters and then exit the window.
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3.2.2.2 User Text Block: Displaying/Editing Properties

You can display or edit the properties of user text blocks using the "Message Blocks"
properties dialog.

The name of the user text block, its length, and the "Flashing" property are displayed and
can be edited.

How to Display the Properties of a User Text Block:

1. In the navigation window, activate the "Message Blocks" item.

2. Click the right mouse button to open the pop-up menu and select the "Message
Blocks" item.

3. Double click in the tree view in the dialog on the "User Text Blocks" item to open it.

4. Select the block you want to edit.

5. Click the left mouse button on the "Properties" button on the right side of the dialog.

or

1.  In the navigation window or data window, select the block type you want to edit and
then select the block you want to edit.

2.  Click the right mouse button to open the pop-up menu and select the "Properties" item.

The "Message Blocks" dialog appears. You can now change the properties (by means of
text boxes, options, etc.).

Note

You can activate the properties dialogs by double clicking the left mouse button on the
appropriate object in the data window.

3.2.3 Process Value Blocks

Process value blocks connect the messages to the process. Each message system has up to
10 individually configurable message blocks available for each single message.

You can change the message system by means of a selection dialog.
You can remove user text blocks or add them from a specified selection list. During
configuration you can change the properties of a process value block.

Note

The display of the process value blocks is limited in runtime to 32 characters, even when
you specify a higher number of characters in the configuration system.
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3.2.3.1 Adding/Removing Process Value Blocks

Use the "Add Process Value Blocks" selection dialog to add or remove process value
blocks.

How to Add or Remove Process Value Blocks:

1. In the navigation window, activate the "Message Blocks" item.

2. Click the right mouse button to open the pop-up menu and select the "Message
Blocks" item.

3. Select the "Process Value Blocks" item. Click the left mouse button on the "Add..."
button on the right side of the dialog.

4. In the selection window, select the desired parameters and then exit the window.

5. Exit the dialog.

or

1. In the navigation window, open the "Message Blocks" item and select the desired type
(system, user text, or process value blocks).

2.  Click the right mouse button to open the pop-up menu and select the "Add/Remove..."
item.

3.  In the selection window, select the desired parameters and then exit the window.
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3.2.3.2 Process Value Block: Displaying/Editing Properties

You can display or edit the properties of process value blocks using the "Message Blocks"
properties dialog.

The name of the process value block, its length, and the "Flashing" property are displayed
and can be edited.

How to Display the Properties of a Process Value Block:

1. In the navigation window, activate the "Message Blocks" item.

2. Click the right mouse button to open the pop-up menu and select the "Message
Blocks" item.

3. Double click in the tree view in the dialog on the "Process Value Blocks" item to open
it.

4. Select the block you want to edit.

5. Click the left mouse button on the "Properties" button on the right side of the dialog.

or

In the navigation window or data window, select the block type you want to edit and select
the block you want to edit.

Click the right mouse button to open the pop-up menu and select the "Properties" item.

The "Message Blocks" dialog appears. You can now change the properties (by means of
text boxes, options, etc.).

Note

You can activate the properties dialogs by double clicking the left mouse button on the
appropriate object in the data window.
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3.3 Message Classes

3.3.1 Message Classes

For configuring messages, WinCC provides 16 message classes with 16 message types
each. A single message is assigned a message type. A message type belongs to a message
class. The assignment is based on system properties and attributes that are assigned to the
classes and types. Single messages can be combined to form group messages.

The following message classes are offered standard in WinCC:

• System, requires acknowledgement

• System, without acknowledgement

Using message classes,

• the acknowledgement type,

• the corresponding status text and

• the output of acoustic/optic signals is defined for all message types of this message
class.

You can edit message classes using the "Message Classes" object in the project navigation
window.

You can perform the following functions with message classes:

• add

• delete

• configure
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3.3.1.1 Adding/Removing a Message Class

Use the "Add Message Class..." selection dialog to add and remove message classes.

How to Add or Remove Message Classes:

1. In the navigation window, select the "Message Classes" item.

2. Click the right mouse button to open the pop-up menu and select the "Add/Remove"
item.

This selection opens the "Add Message Class..." selection dialog.

Add message classes by shifting them from the left half of the window to the right half of
the window. Remove message classes by shifting them from the right half of the window to
the left half of the window.
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3.3.1.2 Configuring a Message Class

Configure message classes by means of the "Configure Message Class" properties dialog.

How to Configure a Message Class:

1. In the navigation window, select the "Message Classes" item.

2. In the navigation window or data window, select the desired "Message Class".

3. Click the right mouse button to open the pop-up menu and select the "Properties"
item.

4. Select the appropriate tab for displaying and editing properties.

5. Exit the dialog.

Use the "General Information" tab to

• define the name of the class,

• add or delete message types. For this purpose, the editor switches to the "Add
Message Type" dialog.

Icon

Name of the Class Enter the name of the class in this text box.

Message Types In this list box, select the message type you want to edit or
remove. The selected message type is displayed in the text
box.
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Icon

Add Click on this button to add a message type to the current
message class. The "Add Message Type" selection dialog
appears.

Remove Click on this button to remove the selected message type
from the message class.

Properties Click on this button to configure the properties of the
selected message type. The "Properties of the Message
Type" properties dialog opens.

How to Add Message Types to a Message Class:

Click the left mouse button on the "Add..." button.

The "Add Message Type" selection dialog appears. Use this selection dialog to select and
add or delete message types.

How to Remove Message Types from the Message Class:

1. In the "Message Types" list box, select a message type by clicking the left mouse
button on it.

The selected message type appears in the text box under the list box.

2. Click the left mouse button on the "Remove" button.

The selected message type is removed from the list of message types for this message class.

How to Change the Properties of a Message Type:

1. In the "Message Types" list box, select a message type by clicking the left mouse
button on it.

The selected message type appears in the text box under the list box.

2. Click the left mouse button on the "Properties" button beside the text box under the
list box.

The "Type" properties dialog appears. Use this properties dialog to configure the selected
message type.

Note

You cannot remove the "Process Control System", "System Message", and "Operator Input
Message" message types.
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Use the "Acknowledgement" tab to:

• set the acknowledgement philosophy

• specify how the acknowledgement of a central signalling device is performed.

You can set nine different states for acknowledging a message in the Acknowledgement
Philosophy box. When some items are selected, other items might be locked (cannot be
selected).
If you want to select one of the locked items, you must undo the selection you made earlier.

Icon

Acknowledgement
Came In

Incoming messages in this message class must be
acknowledged. The message is retained until it is
acknowledged.

Acknowledgement
Went Out

Outgoing messages in this message class must be
acknowledged.

Flashing On Messages in this message class flash in the message window
display.

...Only Initial Value Only the first message in this message class flashes in the
message window display.

Message Without
Status "Went Out"

If this check box is active, the messages in this class do not
have the "Went Out" status. They are not entered in the
message window. These messages are retained in the archive
only.



08.99 Configuring a Message System

WinCC Manual 3-15
C79000-G8276-C160-01

Icon

Separate
Acknowledgement
Key

Uses the separate acknowledgement key in the toolbar or a
keystroke combination to acknowledge central signalling
devices that are triggered when a message comes in. (The
keystroke combination must be provided in the message
window).

By Means of Single
Acknowledgement

Acknowledges central signalling devices that are triggered
when a message comes in by acknowledging the message that
triggered them.

Tag The central signalling device is controlled via the tag defined
here.

Shifts to the "Select Tag" dialog to select a tag to serve as the
acknowledgement tag.

Note

If a message type does not need to be acknowledged or does not possess the state "Went
Out", it does not appear in the message window. It is only archived. (Only message without
state "Went Out" selected)
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Use the "Status Texts" tab to set the texts to be displayed in the message line in the "Status"
system block.

Icon

Came In Text for "incoming" messages, which means moving to the
operating state to be reported

Went Out Text for "outgoing" messages, which means moving from
the operating state to be reported

Acknowledged Text for acknowledged messages

Came In and Went
Out

Text for message which has come and gone

Note

Status texts are only displayed in the message line up to the length that was configured in
the "Status" system block for the message blocks. The "Status" system block should be long
enough to display the longest status text.
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3.3.2 Message Types

Use the "Message Types" item to set uniform text and background colors for all messages
that belong to a message type within a message class. These settings identify the different
message types. This way, you can differentiate among messages in runtime even when they
are in different states.

Note

You can activate the properties dialog by double clicking the left mouse button on the
appropriate object in the data window.

3.3.2.1 Adding/Removing a Message Type

You can add and remove message types by means of the "Add Message Type..." selection
dialog.

How to Add or Remove Message Types:

1. In the navigation window, select the "Message Classes" item.

2. In the navigation window or the data window, select the desired "Message Class".

2. Click the right mouse button to open the pop-up menu and select the "Add/Remove"
item.

3. Shift the message types in the selection dialog.

4. Exit the dialog.
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3.3.2.2 Configuring the Message Type

Use the "Type" dialog and the "Properties of the Message Type" tab to configure the
message type of a message class.
You can configure the name of the message type and the display color of the messages for
the "Came In", "Acknowledged", and "Went Out" states.

Icon

Name of Msg. Type Displays the name of the message type

Text Color Sets the text color for the "Came In",  "Went Out",
and "Acknowledged" messages of the current
message type.

Background Color Sets the background color for the "Came In", "Went
Out", and "Acknowledged" messages of the current
message type.

How to Configure a Message Type:

1. In the navigation window, select the "Message Classes" item.

2.  In the navigation window or data window, open the desired "Message Class".

3.  Click the right mouse button to open the pop-up menu and select the "Properties" item.

4.  Edit the message types in the "Type" dialog.

5.  Exit the dialog.

Note

You can activate the properties dialog by double clicking the left mouse button on the
appropriate object in the data window.
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3.3.3 System Message Classes

System messages are messages which are created system internally, e.g. messages resulting
from operator activity, system failures.

WinCC provides special system classes for processing system messages. You cannot
expand these system classes. The acknowledgement philosophy is preset.

System Message Class That Requires Acknowledgement
System Message Class That Does Not Require Acknowledgement

3.3.3.1 System Message Class That Requires Acknowledgement

As the name of the class implies, these are incoming messages that need to be
acknowledged before they leave. The message disappears immediately following an
acknowledgement.
You can set the parameters in the properties dialog for message classes.
The following message types are available:

• Automation System Messages

• System Messages

Note

The "Went Out" status is not registered or stored in the archive.

3.3.3.2 System Message That Does Not Require Acknowledgement

These are messages that do not require  acknowledgement. You can set the parameters in
the properties dialog for message classes.
The following message types are available:

• Automation System Messages

• Operator Input Messages

3.3.3.3 System Message Types

WinCC Alarm Logging recognizes three system message types. These are

• Process Control Messages
Messages created by the process control system, for example, system startup.

• System Messages
Messages created by the system, for example, failure of system components.

• Operator Input Messages
Messages created during user operation, for example, operation of a component.
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3.4 Single and Group Messages

3.4.1 Single Message

Single messages are edited in the table window. A single message consists of the defined
message blocks. The editable message blocks can be edited by selecting or a pop-up menu.
Multiple single messages can be summarized into one group message.

In the table window you can

• Create single messages

• Copy single messages

• Delete single messages

• Or change the properties of a single message. The parameter of a single message can
be edited either directly in the boxes of the table window or by means of the
"Properties" item in the pop-up menu.

3.4.1.1 Creating Single Messages

How to Create a Single Message:

1. Open the pop-up menu in the table window:
Click the right mouse button on any box within the table window.

2. Select the "Append New Line" menu command.

A line is appended to the end of the table. This contains the contents of the new message
from the table. If necessary, edit the new single message.

How to Copy a Single Message:

1. Select a single message which you would like to copy:
Click the left mouse button on a box of the single message.

2. Open the pop-up menu for this single message.

3. Select the "Copy Line" menu command.

This selection copies the single message to the Clipboard.

Pasting from the Clipboard:

1. Open the pop-up menu in the table window.

2. Select the "Append Copied Line" menu command.

The previously copied single message is pasted from the Clipboard to the end of the table.
Repeat the last step as many times as you would like to copy the line. If necessary, edit the
new single message.
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How to Delete a Single Message:

1. Select a single message which you would like to delete:
Click the left mouse button on a box of the single message.

2. Open the pop-up menu for this single message:
Click the right mouse button on a box of this single message.

3. Select the "Delete Line" menu command.

The single message is deleted and removed from the table.

You can copy boxes within the same column:

How to Copy Boxes in the Table Window:

1. Select a box.

2. Open the pop-up menu.

3. Select the "Copy Cell Contents" menu command.

4. Select the box to which you want to copy the contents.

5. Open the pop-up menu.

6. Select the "Paste Cell Contents" menu command.

The copied contents are pasted into the box.
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3.4.1.2 Properties of a Single Message

You can display and edit the properties of a single message by means of the message’s pop-
up menu with the "Properties" menu command.

How to Display the Properties of a Single Message:

1. In the table window, click the left mouse button on a single message to select it.

2. Click the right mouse button to open the pop-up menu and select the "Properties"
item.

The "Parameter" dialog appears.

Use the "Parameters" tab  to set up the following items:

• The parameters of the single message, such as its association to a message class,
message type, group message, etc.

• The connections to various tags.

Icon

Number Number of the single message

Class Message class of the single message

Type Message type of the single message

Group Provided a single message is to be assigned to a group
message, you can select the already configured group
messages here.
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Icon

is single
acknowledgement
only

The message must be acknowledged individually. It cannot
be acknowledged with a general acknowledgement key.

controls the Central
Siganlling Device

The Central Siganlling Device is triggered when a message
comes in.

will be archived Depending on the selection, the message is saved in an
archive.

will be reported The message is entered in a report or is output (to a
printer).

is created on a
negative edge

The message is created on a negative signal edge,
otherwise on a positive signal edge.

triggers an action The message triggers the standard function
GMsgFunction, which can be changed with the "Global
Script" editor. In the Global Script function browser, the
function can be found under: Standard
functions\WinCC\Alarm\RT.

PLC Number Number of the PLC (subordinate control - PLC) on which
the message originated.

CPU number Number of the CPU on which the message originated.

Message Tag The message tag contains the bit with which the currently
selected message is to be triggered.

Message Bit Number of the bit within the message tag, with which the
currently selected message is to be triggered.

Acknowledgement
Tag

The state of the acknowledgement is stored in one bit of
the acknowledgement tag. Here, you set the tag which is to
be used as the acknowledgement tag.

Acknowledgement Bit Here, you set the bit of the acknowledgement tag in which
the state of the acknowledgement is to be stored. If the
acknowledgement bit has the value 1, the associated
message has been acknowledged. Otherwise, it has not
been not acknowledged.

Status Tag Here, you set the tag in which the states of the group
message ("Came In / Went Out” and acknowledgement
status) are to be stored.

Status Bit The status bit sets both bits of the status tag in which the
states of the currently selected group message are to be
stored.

FormatDLL If the status tag is a raw data tag, the corresponding
compilation program must be selected here.

DLL-Parameters... In this field you set the necessary parameters for the
format DLL.
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Status Tag of a Single Message
A single message always contains two deciding message states:

1. The "Came In / Went Out" status shows that the message came in or went out.

2. The acknowledgement status shows whether the message has to be acknowledged.

Both states of the single message are stored in a status tag. At the same time - depending on
the data type of the tag, up to eight single messages can be recorded in a status tag. Every
single message occupies two bits in the status tag.

If the status tag has the data type "16-bit unsigned" and the status bit = 1, then bit 1 of the
status tag marks the "Came In / Went Out" status of the single message and bit 9 indicates
whether this single message has to be acknowledged. The bits 0-8; 3-10, etc. correspond
accordingly in a 16-bit status tag.

If the status tag has the data type "8-bit unsigned" and the status bit = 1, then bit 1 of the
status tag marks the "Came In / Went Out" status of the single message and bit 5 indicates
whether this single message has to be acknowledged. The bits 0-4; 2-6, etc. correspond
accordingly in an "8-bit" status tag.

Use the  button to open the selection dialog in which the tag to be used as the status tag
is set.

Use the  button to reset the settings of the status tag and of the status bit.
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Acknowledgement Tag of a Single Message
The state of the acknowledgement is stored in one bit of the acknowledgement tag. If an
acknowledgement bit has the value 1, the associated single message has been
acknowledged. Otherwise, it has not been acknowledged. The structure of the
acknowledgement tags is not set, meaning you have the option to use one
acknowledgement tag for each single message or summarize multiple single messages into
one acknowledgement tag. The differentiation of the single messages then takes place via
the acknowledgement bit.
At runtime, this bit is set when a single message is acknowledged.

Use the "Text" tab to set the configurable texts of the single message.

Icon

Infotext Here, you can enter a text up to 255 characters long.

Blocks 1 to 10 Here, you can enter texts, each of which may be up to 255
characters long. Blocks 1 to 10 represent the corresponding user
text blocks.

Use the Insert Process Value dialog that appears to insert
process variables in your user text blocks.
A process value inserted in this manner is identified by means
of @.....@ in the user text.
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Use the "Insert Process Value" dialog to accept the value of a process variable in your user
text block. Be careful not to exceed the maximum length of a user text block (255
characters).

Icon

User text block Shows the user text block in which a process value is to be
inserted.

Length Displays the defined text length of the user text block.

Text Mirrors the look of the user text.

Process value block Here, you can set the process variable that corresponds to
the value you want to insert.

Type Sets the format type of the process value to be inserted.
You can select from the following: text, fixed-point
number (decimal, octal, hexadecimal), and floating-point
number.

Position Sets the position of the format statement within the text. If
it is set to "Position: 10", the process value is inserted in
the user text after the tenth character.

Number of Digits Here, you can set the number of characters that are
reserved for the process value within the user text.

Precision Here, you can define the number of characters of the
process value to be inserted in the user text.
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Icon

pad with 0 If this function is active, floating-point numbers are filled
up to the number of characters specified in "Precision".

align left If the number of spaces in the process value to be inserted
is smaller than the number of spaces reserved, you can use
this function to specify whether the process value is
aligned right or left when it is inserted in the user text.

Format Specifications Displays the format specifications set by your input.

Example Displays examples of how the entries of number of digits,
precision, align left, and pad affect the different types of
process values.

Use the "Tag/Action" tab to connect the configured process value blocks of the single
message with WinCC tags.

Icon

Process Values 1...10 Connect the process tag with the corresponding process value
block.

Picture Name Transfer parameter of the "char" type.

Function Name Name of the called function or of the called script (BOOL type).

Note

In "Loop in Alarm", you can enter any function and set an additional file as the transfer
parameter. In particular, this function can be used to output a system graphic. WinCC
provides the "OpenPicture" standard function for this purpose.
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3.4.1.3 Editing Boxes

You can edit the following boxes directly:

Icon

Number Directly editable

Class Selection box of the configured message classes

Type Selection box of the configured message types

Message Tag The message tag contains the bit with which the currently selected
message is to be triggered.

Message Bit Number of the bit within the message tag with which the currently
selected message is to be triggered.

Status Tag Here, you set the tag in which the states of the group message
("Came In / Went Out” and acknowledgement status) are to be
stored.

Status Bit The status bit sets both bits of the status tag in which the states of
the currently selected group message are to be stored.

Acknowledgement
Tag

The state of the acknowledgement is stored in one bit of the
acknowledgement tag. Here, you set the tag which is to be used as
the acknowledgement tag.

Acknowledgement
Bit

Here, you set the bit of the acknowledgement tag in which the state
of the acknowledgement is to be stored. If the acknowledgement bit
has the value 1, the associated message has been acknowledged.
Otherwise, it has not been acknowledged.

Message Text Directly editable

Error Type Directly editable

Process Value(s) Tag Management

Infotext Infotext Editor

Parameter Parameter

Loop in Alarm Loop in Alarm

Group Provided a single message is to be assigned to a group message,
you can select already configured group messages here.

Format DLL Format DLL
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How to Edit the Boxes in the Table Window:

1. Double click the left mouse button on the box.

A list box or a dialog box appears, or the box opens so that you can edit it.

2. Use the keyboard to enter the new value.

3. Exit the dialog.

Use the "Infotext" dialog to enter additional information text about a single message. An
infotext describes why a message can come. They are not reset after a message "goes out".

Use the keyboard to enter your text. You can edit the text in the text input box by means of
the pop-up menu and the standard edit functions (copy, paste, etc.).

Use the "Parameters" dialog to set the parameters of a single message.

Icon

is single
acknowledgement only

The message must be acknowledged individually. It cannot be
acknowledged with a general acknowledgement key.

triggers a horn The horn is triggered when a message comes in.
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Icon

will be archived Depending on the selection, the message is saved to an archive.

will be reported The message is entered in a report or is output (to a printer).

is created on a negative
edge

The message is created on a negative signal edge, otherwise on a
positive signal edge.

triggers an action The message triggers a configured action. The action is entered
in the "Action" column in the table window.

You can also set the parameters by means of the Properties dialog.

Use the "Loop in Alarm" dialog to assign a function to a single message (picture function
with parameter (picture name)).

Note

If you trigger a "Loop in Alarm" during runtime, the system graphic whose name you
entered in the picture name box is displayed. WinCC provides the "OpenPicture" standard
function for this purpose.

If you would like to use another function, please note the following: use a standard function
which accepts a transfer parameter of type char*, e.g. void MyOwnFunction(char*
NameOfTheFile);

use only standard functions whose return parameters are of types "unsigned char, short int,
long int, float, double, bool, or void". (In the above example, the return parameter is of type
"void".)
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Use the "Format DLL" dialog to set an interface-specific DLL (format DLL) for the current
single message. This format DLL converts the data format of the incoming process values.
Use the DLL-Parameters button to set the parameters.

3.4.2 Group Message

A group message is the summary of multiple single messages into one comprehensive
message.

There are two types of group messages:

1. The summary of all messages of a message class: Group message from the message
class. If a new message class is created, the corresponding group message will also be
created.

2. The summary of any messages: User-defined group message. User-defined group
messages can contain single messages as well as other group messages and can be
edited using the pop-up menu. A single message, though, can only be contained in a
group message.

Note

If a group message occurs in runtime, the single message which triggered the group
message cannot be determined.

A group message can be assigned one of the tags which returns the message state. This
status tag enables you to query the message state of the group message from other WinCC
components.

A group message can be assigned an acknowledgement tag in which the state of the group
message acknowledgement is stored.
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Status Tag of a Group Message
A group message always contains two deciding message states:

1. The "Came In / Went Out" status shows whether one of the subordinate messages (it
can also be another group message) came in or went out.

2. The acknowledgement status shows whether the message triggered by the group
message has to be acknowledged.

Both states of the group message are stored in a status tag. At the same time - depending on
the data type of the tag, up to eight group messages can be recorded in a status tag. Every
group message occupies two bits in the status tag.

If the status tag has the data type "16-bit unsigned" and the status bit = 1, then bit 1 of the
status tag marks the "Came In / Went Out" status of the group message and bit 9 indicates
whether a message that has to be acknowledged is present for this group message. The bits
0-8; 3-10, etc. correspond accordingly in a 16-bit status tag.

If the status tag has the data type "8-bit unsigned" and the status bit = 1, then bit 1 of the
status tag marks the "Came In / Went Out" status of the group message and bit 5 indicates
whether a message that has to be acknowledged is present for this group message. The bits
0-4; 2-6, etc. correspond accordingly in an "8-bit" status tag.

Use the  button to open the selection dialog in which the tag to be used as the status tag
is set.

Use the  button to reset the settings of the status tag and of the status bit.

Acknowledgement Tag of a Group Message

The state of the acknowledgement is stored in one bit of the acknowledgement tag. If an
acknowledgement bit has the value 1, the associated group message has been
acknowledged. Otherwise, it has not been acknowledged. The structure of the
acknowledgement tags is not set, meaning you have the option to use one
acknowledgement tag for each group message to be acknowledged or summarize multiple
group messages into one acknowledgement tag. The differentiation of the group messages
then takes place via the acknowledgement bit.
At runtime, this bit is set when the group message is acknowledged.
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3.4.2.1 Group Messages from Message Classes

When you create a new message class, a group message is also automatically created for
this message class. All message types within the message class are taken over into the
group message.

Using the pop-up menus, you can change the properties of the message classes and the
message types in the group message independently from one another, thereby assigning
different status, lock, and acknowledgement tags.

How to Change the Properties of a Message Class:

1. Select a message class of the group message.

2. Click the right mouse button to open the pop-up menu and select the "Properties"
menu command.

3. The properties dialog appears.

4. Change the settings concerning the status, lock, and acknowledgement tags.

5. Click on "OK" to save or click on "Cancel".

Icon Description

Name Name of the message class

Status Tag Here, you set the tag in which the states of the group message
("Came In / Went Out" and acknowledgement status) are to be
stored.

Status Bit The status bit sets both bits of the status tag in which the states of
the currently selected group message are to be stored.



Configuring a Message System 08.99

3-34 WinCC Manual
C79000-G8276-C160-01

Icon Description

Lock Tag If, in runtime, you use the "Set Lock" button to lock a message, the
appropriate bit is set in the tag specified here.

Lock Bit The lock bit gives you the ability to use one lock tag for multiple
group messages.

Acknowledgement
Tag

The state of the acknowledgement is stored in one bit of the
acknowledgement tag. Here, you set the tag which is to be used as
the acknowledgement tag.

Acknowledgement
Bit

Here, you set the bit of the acknowledgement tag in which the state
of the acknowledgement is to be stored. If the acknowledgement bit
has the value 1, the associated group message has been
acknowledged. Otherwise, it has not been acknowledged.

How to Change the Properties of a Message Type:

1. Select a message type within a message class of the group message.

2. Click the right mouse button to open the pop-up menu and select the "Properties"
menu command.

3. The properties dialog appears.

4. Change the settings concerning the status, lock, and acknowledgement tags.

5. Click on "OK" to save or click on "Cancel".
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Icon Description

Message Class Name of the message class

Name Name of the message type

Status Tag Here, you set the tag in which the states of the group message
("Came In / Went Out" and acknowledgement status) are to be
stored.

Status Bit The status bit sets both bits of the status tag in which the states of
the currently selected group message are to be stored.

Lock Tag If, in runtime, you use the "Set Lock" button to lock a message, the
appropriate bit is set in the tag specified here.

Lock Bit The lock bit gives you the ability to use one lock tag for multiple
group messages.

Acknowledgement
Tag

The state of the acknowledgement is stored in one bit of the
acknowledgement tag. Here, you set the tag which is to be used as
the acknowledgement tag.

Acknowledgement
Bit

Here, you set the bit of the acknowledgement tag in which the state
of the acknowledgement is to be stored. If the acknowledgement bit
has the value 1, the associated group message has been
acknowledged. Otherwise, it has not been acknowledged.
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3.4.2.2 User-Defined Group Messages

The pop-up menu of the "User-Defined Group Message" type allows you to create user-
defined group messages, or display and edit the properties of a user-defined group message.

Use the pop-up menu of a user-defined group message to

− Add additional group messages  to an existing group message,

− Add additional single messages  to an existing group message, or

− Change the properties of a group message or of a single message contained therein.

How to Create a User Defined Group Message:

1.  In the group messages area, select "User Defined" node to create a new user-defined
group message.

or

Select an already created user-defined group message if you want to subordinate a
group message.

2. Use the right mouse button to open the pop-up menu and click on the "Add Group
Message..." menu command.

3. The input dialog for the new group message opens.

4. In the name box, enter the name of the new group message and complete the
parameters concerning the status, lock, and acknowledgement tags.

5. Click on "OK" to save or click on "Cancel".
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Icon Description

Parent Name of the higher-level object in the navigation window.

Name Name of the user-defined group message

Status Tag Here, you set the tag in which the states of the group message
("Came In / Went Out" and acknowledgement status) are to be
stored.

Status Bit The status bit sets both bits of the status tag in which the states of
the currently selected group message are to be stored.

Lock Tag If, in runtime, you use the "Set Lock" button to lock a message, the
appropriate bit is set in the tag specified here.

Lock Bit The lock bit gives you the ability to use one lock tag for multiple
group messages.

Acknowledgement
Tag

The state of the acknowledgement is stored in one bit of the
acknowledgement tag. Here, you set the tag which is to be used as
the acknowledgement tag.

Acknowledgement
Bit

Here, you set the bit of the acknowledgement tag in which the state
of the acknowledgement is to be stored. If the acknowledgement bit
has the value 1, the associated group message has been
acknowledged. Otherwise, it has not been acknowledged.
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How to Change the Properties of a User-Defined Group Message:

1. Select a user-defined group message.

2. Click the right mouse button to open the pop-up menu and select the "Properties"
menu command.

3. The properties dialog appears.

4. Change the parameters concerning the status, lock, and acknowledgement tags.

5. Click on "OK" to save or click on "Cancel".

Icon Description

Parent Name of the higher-level object in the navigation window.

Name Name of the user-defined group message

Status Tag Here, you set the tag in which the states of the group message
("Came In / Went Out" and acknowledgement status) are to be
stored.

Status Bit The status bit sets both bits of the status tag in which the states of
the currently selected group message are to be stored.

Lock Tag If, in runtime, you use the "Set Lock" button to lock a message, the
appropriate bit is set in the tag specified here.

Lock Bit The lock bit gives you the ability to use one lock tag for multiple
group messages.
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Icon Description

Acknowledgement
Tag

The state of the acknowledgement is stored in one bit of the
acknowledgement tag. In this field you set the tag which is to be
used as the acknowledgement tag.

Acknowledgement
Bit

Here, you set the bit of the acknowledgement tag in which the state
of the acknowledgement is to be stored. If the acknowledgement bit
has the value 1, the associated group message has been
acknowledged. Otherwise, it has not been acknowledged.

How to Add a Single Message to a Group Message:

1. Open the pop-up menu of the desired group message (user defined).

2. Select the Add Single Message menu command.

3. Enter the numbers of the single messages from the table window in the "New Single
Message(s)" dialog.

Icon Description

Message Number(s) Here, you enter the numbers of the single messages
(corresponding to the numbers in the table window)
that are to be added to the group message.

Note

Use the "Only then insert the single message(s), if it does not already belong to a group"
button to prevent the multiple assignment of single messages. Single messages which have
already been assigned are not assigned. The program does not, however, provide a message
to this effect.

If a single message is deleted from the table window, all assignments of this single message
will also be deleted in the group messages.
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How to Display the Properties of the Assigned Single Messages:

1. Open the pop-up menu of the desired single message of a user-defined group message.

2. Select the Properties menu command.

Icon Description

Message Number Displayed here are the numbers of the single
messages which are assigned to the single messages
in the table window.

3.4.2.3 Deleting a Group Message

How to Delete a Group Message

1. In the data or project navigation window, open the pop-up menu of the group message
to be removed.

2. Select the Delete Group Message or Delete menu command.

How to Remove Single Messages from a Group Message

Open the pop-up menu in the table window for the single message which is to be removed.
In the "Properties of a Single Message" dialog (tab: Parameters), change the group
assignment of the single message.

As an alternative, you can also edit the "Group" box directly in the table window, thereby
changing the group assignment of the single message.
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3.5 Analog Alarm

The analog alarm allows you to set any number of limit values for a tag. If one of these
limit values is violated, a message will be generated in runtime.

The analog alarm is an add-in to WinCC. Integrate "Analog Alarm" into the message
system via the "Add Ins..." entry of the "Tools" menu. The "Analog Alarm" entry will then
be listed in the navigation window of the message system.

Note

Changes in the dialogs of the analog alarm will be accepted into the database tables
immediately after exiting the dialog.

If the configuration takes place online, the message system must be saved before the
changes will take effect in runtime.

Configuration Procedure

1. Integration of the analog alarm:
In the "Tools" menu, select the "Add Ins..." entry to add the analog alarm to your
message system.

2. Setting the tag to be monitored:
In the pop-up menu of the "Analog Alarm", select the "New" entry. In the following
"Properties" dialog, set the tag to be monitored.

3. Setting the limit values to be monitored:
In the pop-up menu of the "Analog Alarm" entry, select the "New" item and set the
limit value which is to be monitored.
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Setting the Tag to be Monitored
How to Set a Tag to be Monitored:

1. Integrate the "Analog Alarm" into the message system via the "Add Ins..." entry of the
"Tools" menu.

2. In the navigation window, activate the pop-up menu of the "Analog Alarm" via a right
mouse button click.

3. Select the "New..." entry.

Set the tag to be monitored in the "Properties - Tag" dialog.
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Icon

Tag to be monitored The tag to be monitored can be set either by entering the

tag name directly or by clicking on the  button, which
calls up the tag selection dialog.

Number of limit
values

This box displays the number limit values to be monitored.

a message for all limit
values

If this option is activated, the same message will always be
displayed in runtime if one of the configured limit values
is violated.

message number Here, you enter the number of the message that is to be
generated in runtime in the event of a limit value violation.

Delay time Here, you set the delay time that has to pass between the
limit value violation and the generation of the message.
The message will only be triggered if the limit value has
been violated for the entire delay time.
The delay time can be set from 250 to 10000 ms. If you
wish to have no delay time, enter the value "0".

Changing the Properties
of a Tag to be Monitored

How to Change the Properties of a Tag to be Monitored:

1. In the navigation or data window, activate the pop-up menu of the tag to be monitored
via a right mouse button click.

2. Select the "Properties" entry.
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Set the properties of the tag to be monitored in the "Properties - Tag” dialog.

Icon

Tag to be monitored The name of the tag to be monitored is displayed in here.

Number of limit
values

This field displays the number limit values to be
monitored.

a message for all limit
values

If this option is activated, the same message will always be
displayed in runtime if one of the configured limit values
is violated.

message number Here, you enter the number of the message that is to be
generated in runtime in the event of a limit value violation.

Delay time Here, you set the delay time that has to pass between the
limit value violation and the generation of the message.
The delay time can be set from 250 to 10000 ms. If you
wish to have no delay time, enter the value "0".
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Setting the Limit Values to be Monitored
How to Set the Limit Values to be Monitored:

1. In the navigation or data window, activate the pop-up menu of the tag to be monitored
via a right mouse button click.

2. Select the "New..." entry.

Set the limit value to be monitored in the "Properties - Limit Value” dialog.
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Icon

Upper limit If this option is activated, the value entered in the limit value
field is an upper limit, meaning a message will be generated if
the tag value exceeds this limit value.

Lower limit If this option is activated, the value entered in the limit value
field is a lower limit, meaning a message will be generated if
the tag value falls below this limit value.

Direct or Indirect The value to be monitored can either be set directly or
indirectly via a tag. The "Tag" button opens the tag selection
dialog.

After exiting the tag selection dialog via "OK", the "Indirect"
option will be activated.

In case of an indirect limit value input, the value of the tag to
be monitored, that which causes the triggering of the message,
will be stored in process value block 3.

Hysteresis Messages, for which a hysteresis has been defined, will not be
triggered immediately after reaching their limit value, but after
the actual tag value exceeds or falls below the limit value by
the hysteresis amount.

The hysteresis can be entered as either an absolute value or as
a percentage deviation of the limit value.

Depending on the selected setting, the hysteresis will become
effective while a message is triggered or taken back.

Message Number Here, you enter the number of the message that is to be
generated in runtime if a limit value violation occurs.

This box can only be changed if you did not select "a message
for all limit values" in the "Properties - Tag" dialog.

Note

By calling up this dialog multiple times, any number of limit values to be monitored can be
set for a tag.

When entering a limit value, make sure that the tag can really exceed or fall below this
limit. Since the limit is saved once the message has been triggered, the message cannot be
taken back by manually changing the limit value.

If a limit value is set indirectly by a tag, a start value must be used to set the tag to a
reasonable value when starting runtime.
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Changing the Properties
of a Limit Value

How to Change the Properties of a Limit Value:

1. In the data window, activate the pop-up menu of the analog alarm via a right mouse
button click.

2. Select the "Properties" entry.

Set the properties of the limit value in the "Properties - Limit Value" dialog.

Analog Alarm Messages
In the "Properties - Tag” and "Properties - Limit Value” dialogs, the number of the message
which is to be generated if a limit value violation occurs can be set.

− If you enter a number of a message that does not exist yet, a message will be created
according to the requirements of the analog alarm.

− If you enter a number of an already existing message, several properties of the message
will be changed. The entries pertaining to the event and status tags, as well as the
process value block connections, will be deleted.

Note

The values of the limit value, hysteresis, and trigger value are stored in process value
blocks 1 to 3.
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Example 1

Message 4 is triggered (comes in) if the tag to be monitored exceeds the value 220, and will
be taken back if the tag to be monitored falls below the value 200.
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Example 2

Message 4 is triggered (comes in) if the tag to be monitored exceeds the value of the tag
"Limit Value", and will be taken back if the tag to be monitored falls below the value of the
tag "Limit Value" by 10%.
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Deleting
Objects from the Analog Alarm

How to Delete a Tag to be Monitored:

1. In the navigation or data window, activate the pop-up menu of the tag to be monitored
via a right mouse button click.

2. Select the "Delete..." entry.

How to Delete a Limit Value:

1. In the data window, activate the pop-up menu of the analog alarm via a right mouse
button click.

2. Select the "Delete..." entry.
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3.6 Data Archiving

3.6.1 Archives

Use the "Archive Parameter Assignment" dialog to activate a short-term archive and/or a
long-term archive. Depending on the archive type, you can choose to store it on the hard
disk or in main memory (working memory).

Icon

Short-term archive
active

The short-term archive is activated. This means that
messages are written to the short-term archive.

Long-term archive
active

Activates the long-term archive for long-term
archiving.

How to Activate an Archive:

1. Open the pop-up menu for "Archives".

2. Select the "Add/Remove..." menu command.

3. In the "Archive Parameter Assignment" dialog, click the check boxes for the archives
you want to activate.

4. Save your entries.

Note

A message requires approximately 120 bytes of memory space.

If changes are made to configured messages in the configuration system, changes are also
made to the corresponding messages stored in the archives.
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3.6.1.1 Short-Term Archive

Icon

Main Memory
Archive

The archive is stored only in main memory. A maximum
of 10,000 messages can be stored.

Archive On Disk The archive is stored in the hard disk memory.

Reload Message List
After Power Failure

The message list is reloaded after restart.

Number of Messages Number of messages that can be stored in the short-term
archive.

Selection Select the message blocks to be stored in the short-term
archive.

How to Configure the Short-Term Archive:

1. Open the pop-up menu for "Short-Term Archive".

2. Select the "Properties" menu command.

or

1. Open the pop-up menu for "Archives".

2. Select the "Properties" menu command.

3. Select the "Short-Term Archive" tab.

4. Set the necessary parameters.

5. Save your entries.
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3.6.1.2 Long-Term Archive

Icon

Continuous
Archive

The archive is overwritten cyclically after the configured
number of days (see below).

Sequence Archive The archive is continued sequentially.

Archive includes Displays the number of days messages are stored in the
continuous archive.

Selection... Select the message blocks to be stored in the long-term
archive.

How to Configure the Long-Term Archive:

1. Open the pop-up menu for "Long-Term Archive".

2. Select the "Properties" menu command.

or

1. Open the pop-up menu for "Archives".

2. Select the "Properties" menu command.

3. Select the "Long-Term Archive" tab.

4. Set the necessary parameters.

5. Save your entries.
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3.6.1.3 Selecting the Data to be Archived

How to Select the Data to be Archived:

1. Open the dialog for long-term or short-term archives.

2. Click on the "Selection" button.

3. Click on the appropriate sections of the configured messages that you want to archive.

4. Save your entry by clicking "OK".



08.99 Configuring a Message System

WinCC Manual 3-55
C79000-G8276-C160-01

3.6.2 Reports

Icon

Message Sequence
Report

The selected messages are output in the message
sequence report.

Archive Report Active The selected messages from the archive are output in
the archive report.

How to Activate Reports:

1. Open the pop-up menu for "Reports".

2. Select the "Add/Remove..." menu command.

3. In the "Assigning Report Parameters" dialog, select the necessary reports.

4. Save your entries.

Message Sequence Report
With a message sequence report, you can use the "Selection..." button in the properties
dialog to select the message blocks you want to print.
The default blocks for this are only date, time, and number. If you want to print out
additional blocks, you must adapt the standard layout in the Report Designer.
For the output of a message sequence report, the message system calls up the print job with
the specified name " @Report Alarm Logging RT Message sequence". No other print job
can be used for the message sequence report. If necessary, the name of this print job can,
however, be changed. You can also design your own layout for a message sequence report
and link it to this print job.

Note

A message sequence report configured for a line printer should use only this printer.

Archive Report
All of the data of the archive are output.
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3.7 Deleting Objects

How to Delete Objects in the Message System:

1. Open the pop-up menu for the desired object.

2. Select the Delete menu command.

The object is removed from the window.

3.8 WinCC Alarm Control

The "WinCC Alarm Control" object is used as a message window to display message
events. Use of the Alarm Control allows a high degree of configuration flexibility. This is
due to the fact that the message window, the message line and the message blocks which
are to be displayed are configured exclusively within the Graphics Designer.
The messages to be displayed in runtime are accessed from the Alarm Logging
configuration data.

3.8.1 Configuring the WinCC Alarm Control

To display messages in runtime using the WinCC Alarm Control, the following steps must
be performed:

In Alarm Logging

1. Specify the properties of the required message blocks in the configuration system, e.g.
the length of the message text in the table window.

2. Change the properties of message classes and message types to suit your needs, e.g.
the coloring of the alarm message class.

3. Configure the required single and group messages.
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In the Graphics Designer

4. Link the WinCC Alarm Control to a Graphics Designer picture and edit the properties
of the ActiveX Control.

5. To be able to check the message window settings, buttons must be configured in the
Graphics Designer to set and reset message tags.

Note

The message window can be influenced via standard functions. If you do not wish to use
the toolbar functions to operate the message window, any Graphics Designer objects can be
made dynamic using the appropriate functions.

3.8.1.1 Configuring the Message Blocks

If necessary, the message blocks required in the configuration system can be adapted to fit
your needs. For example, the number of displayed characters in the "Message Text" user
text block can be increased.

To do so, select the "Properties" entry from the pop-up menu of the corresponding message
block and modify the properties according to your needs. This is illustrated with the
"Message Text" user text block.

Note

Additional information about configuring message blocks can be found in the Alarm
Logging documentation.
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3.8.1.2 Configuring the Message Classes and Message Types

Using the "Properties" entry from the pop-up menus of the required message classes, the
necessary acknowledgement philosophies can be defined. In the example, the "Error"
message class is used as a single message with incoming acknowledgement.
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For the required message types, the coloring of the message states can be defined via the
"Properties" entry from the pop-up menu. In the example, the "Alarm" and "Warning"
message types are used.

Note

Additional information about configuring message blocks can be found in the Alarm
Logging documentation.

3.8.1.3 Configuring the Single and Group Messages

In the table window, configure four messages using the following data concerning message
class, message type, message tag, message text and point of error:

Num
ber

Class Type Message Tag Message Text Point of
Error

1 Error Alarm Tank1 (binary) Tank 1 empty Tank1

2 Error Alarm Tank2 (binary) Tank 2 empty Tank 2

3 Error Alarm Tank3 (binary) Tank 3 empty Tank3

4 Error Warning Motor (binary) Motor On

The tags used as message tags can be created either via Control Center tag management or
via the table window in Alarm Logging.

Note

Additional information about configuring messages can be found in the Alarm Logging
documentation.
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3.8.1.4 Configuring the WinCC Alarm Control in the Graphics Designer

1. Inserting an ActiveX Control in a picture: Select the "Controls" tab from the object
palette, then select "WinCC Alarm Control".

2. Draw an ActiveX Control of the desired size in the file window.

3. In the dialog for quick configuration of the Alarm Control, you should enter a window
name and enable use of the toolbar and status bar.
The entries to be selected in the "Server Selection" area are dependent on the project
type. For a single-user project, no entries are required.

Note

If you double-click with the left mouse button on the control while holding down the
"CTRL" key, a preview of the Alarm Control’s runtime appearance will be displayed.
To return to the "normal view", click a surface outside of the control.
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The properties of the Alarm Control can be edited most easily in the properties dialog. To
open the dialog, double click the control with the left mouse button.

4. Specifying a selection in the message window: In the "Parameters" tab, you should
activate the "Line" option in the Selection area.

5. Specifying buttons in the toolbar: In the "Toolbar" tab, you can select the buttons to be
displayed in the toolbar. For the example, the selection of "Single acknowledgement",
"Selection", and "Set lock" suffices.
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6. In the "Message Blocks" tab, you can specify the message blocks to be displayed in a
message line. The properties of these message blocks are specified here as well. In the
System Blocks area, select the "Date" and "Time" blocks; in the "User Text Blocks"
area, select the "Message Text" and "Error Location" blocks.

Note

In order to edit the properties of a message block at runtime, e.g. the number of characters
of a message text which are to be displayed, you can select this message block and call up
the properties dialog, with which you are familiar from Alarm Logging, via the
"Properties..." button.



08.99 Configuring a Message System

WinCC Manual 3-63
C79000-G8276-C160-01

7. Sorting the message blocks: In the "Message Line" tab, you can specify the message
blocks to be displayed in a message line. The order of these message blocks is
specified here as well. In the list of available message blocks, all blocks that you have
selected in the "Message Blocks" tab are displayed. Select "Message Text" and "Error
Location". The buttons of the dialog allow you to move message blocks between the
two lists and modify their order within the message line.
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3.8.1.5 Configuring the Buttons for Modifying Message Tags

Four messages have been configured in Alarm Logging during the configuring of the single
messages. To check the operation of the Alarm Control in the example, several buttons
must be still be configured in order to be able to set and reset the corresponding message
tags.

1. Insert a button in your picture.

2. Add dynamics to the "Press Left" event of the mouse via a direct connection between
the "1" constant and the "Tank1" tag. Add dynamics to the "Press Right" event of the
mouse via a direct connection between the "0" constant and the "Tank1" tag.

Create three additional buttons and add dynamics for the "Tank2", "Tank3", and "Motor"
message tags.

Note

Additional information about adding dynamics to objects can be found in the
documentation for the Graphics Designer editor.
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3.8.1.6 Activating the Alarm Control Example

Before activating the WinCC Alarm Control example, check if

• "Graphics Runtime", "Alarm Logging Runtime", and "Text Library Runtime" have been
selected in the control center’s "Startup" tab (in the Control Center, "Computer
Properties" dialog)

• the picture has been saved and entered as the start picture in the "Computer Properties"
dialog.

Note

Additional information about activating a project can be found in the Control Center
documentation.
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3.8.2 Properties Dialogs

3.8.2.1 Quick Configuration of the WinCC Alarm Control

When inserting the WinCC Alarm Control into the Graphics Designer picture, a dialog for
quick configuration of the control opens.

Box Description

Window The title of the message window is defined here.

Display With the options "Display Toolbar" and "Display Status Bar", you
can specify whether the message window is to contain a toolbar and
a status bar in runtime.

Server Selection In a multi-client system, you can specify here from which servers
the data which are to be displayed are to be retrieved. This can be
performed by either directly entering the server names or via the
"Selection..." button. With the "All Servers" option, all servers
participating in the project on which Alarm Logging is activated are
selected.

Note

All entries in the dialog for quick configuration can be edited via the control properties.

In the dialog for server selection, which can be opened via the "Selection..." button in a
multi-client system, only those servers whose "packages" were loaded on the multi-client
are listed.
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3.8.2.2 Properties of the WinCC Alarm Control

The properties of an ActiveX Control can be changed by right-clicking on the object and
selecting the "Properties" entry from its pop-up menu.
In the displayed "Object Properties" dialog, select the "Control Properties" entry from the
"Properties" tab.

Note

A complete description of all properties of the WinCC Alarm Control can be found in the
online help.

You can also double-click with the left mouse button on the Alarm Control object to open a
dialog box in which the attributes of the WinCC Alarm Control can also be set.
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Style Tab

Box Description

Window Title The title of the message window is defined here. The "Display"
option is used to determine whether the title bar of the message
window is displayed or not.

Server Selection In a multi-client system, you can specify here from which servers
the data which are to be displayed are to be retrieved. This can be
performed by either directly entering the server names or via the
"Selection..." button. When entering directly, the server names
must be separated by a semicolon.
With the "All Servers" option, all servers participating in the
project on which Alarm Logging is activated are selected.

Message Window With the "Message Window" setting, you can specify that the
currently pending messages are to be displayed when a picture is
opened.

Short-Term Archive
Window

With the "Short-term Archive" setting, you specify that the
messages archived in a short-term archive are to be displayed
when a picture opens.

Long-Term Archive
Window

With the "Long-Term Archive Window" setting, you specify that
the messages archived in a long-term archive are to be displayed
when a picture opens.

Background color Use "Selection" button to open a dialog box for selecting the
background color of the message window.

Selection... With this button, you open a dialog in which you can make
settings to display only those messages which meet certain
criteria.
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The selection criteria for the messages to be displayed in the message window can be
defined in the "Specify Selection" dialog. In this way you can, for example, specify that
only messages of a certain message class or the messages of a certain error location be
displayed.
For certain message blocks, such as the date and time system blocks, a dialog can be
opened by double-clicking on the name of the selection criterion. In this dialog you can
specify the start and end times or define search texts.

Note

In the dialog for server selection, which can be opened via the "Selection..." button in a
multi-client system, only those servers whose "packages" were loaded on the multi-client
are listed.

The settings regarding the messages to be displayed (Message Window, Short-Term
Archive Window, Long-Term Archive Window) and the selection criteria can be changed
in runtime via the toolbar or the standard Alarm Control functions.
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Parameters Tab

Box Description

Separation Lines The "horizontal" and "vertical" check boxes specify whether the
message window is to contain horizontal and vertical separation
lines.

Selection A single acknowledgement always affects the selected message
line, i.e. the line on which you last clicked. The "Cell" and "Line"
options set the highlighting effect of the selected message. Either
the entire line or one cell is highlighted. The selected message line
will not be highlighted if "No Selection" is selected.

The direct selection of messages is only possible if the "Auto-
Scrolling" option is not active!

Line Title Here, you specify whether the message window is to contain a
column that sequentially numbers the pending messages.

Column Title Here, you specify whether the message window is to contain a title
bar with the names of the message blocks.

The "Change Column Width" option allows you to change the
width of the message window columns in runtime. If the "Shorten
Title" option is active, the contents of the title bar boxes will be
shortened in runtime if necessary.
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Box Description

Auto-Scrolling If the "Auto-Scrolling" option is active, the most recent message in
the message window will always be selected. The visible area of the
message window is moved if necessary.

If "Auto-Scrolling" is not active, a new incoming message will not
be selected. The visible area of the message window will not be
changed.

A direct selection of message lines is only possible if "Auto-
Scrolling" is not active. Auto-Scrolling can be dynamically
influenced via the "AXC_OnBtnScroll" function or the button in
the toolbar.

Shorten Cell Content If the "Shorten Cell Content" option is active, the contents of the
message line boxes will be shortened in runtime if necessary.

Font Tab

Box Description

Properties Here, you specify the name of the font which is to be used.

Font Style Here, you set the font style for the selected font (e.g. bold, italic).

Size Here, you set the size of the selected font.

Effects Using these options, you can specify whether the text to be
displayed in the message window is underlined or striked through.

Example: Displayed here is a preview of the settings you have made.
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Toolbar Tab

Box Description

Display Toolbar With this option, you specify whether a toolbar is to be displayed
for the Alarm Control. The message window can be operated via
the buttons in the toolbar.

Alignment Depending on the settings made here, the toolbar is displayed either
in the upper or lower border of the message window.

Button Functions With the check boxes, you can specify which buttons are to be
displayed in the toolbar.

Properties With this button, you open the "Operator Function" dialog. In this
dialog, you can assign operator authorization to the button function
selected in the selection window as well as create a keyboard
shortcut.

All Button Functions In this selection, you can specify that all available buttons are to be
displayed in the toolbar.
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The name and icon of the keyboard function which is to be edited are displayed in the upper
area of the "Operator Function" dialog.

Box Description

Operator Authorization With the selection button, you can assign the button function
selected in the selection window one of the operator
authorizations which have been configured in the User
Administrator.

Keys/Key Combination Here, you can assign a keyboard shortcut to the button function
selected in the selection window. To do this, use the tab key or
the mouse to place the cursor in the input box and use the
keyboard to enter the desired key or keystroke combination.
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Status Bar Tab

Box Description

Display Status Bar With this option, you specify whether a status bar is to be
displayed for the Alarm Control.

Alignment Depending on the settings made here, the toolbar is displayed
either in the upper or lower border of the message window.

0Elements of the Status
Bar

With the check boxes, you can specify which elements are to be
displayed in the status bar.

All Status Bar
Elements

In this selection, you can specify that all available elements are to
be displayed in the status bar.
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Message Blocks Tab

Box Description

Type The available message blocks are displayed in the selection
window for each type.

Selection All selected and correspondingly labelled message blocks are
available in the "Message Line" tab and can be selected there for
display.

Properties... With the check boxes, you can change the properties of one of the
message blocks selected in the selection window, for example, to
change the date format or the length of a text block.

Apply Project Settings This setting makes the Control apply the message block
properties configured in Alarm Logging concerning the number
of characters, alignment, etc.
If a message block is changed via the "Properties" button, this
change willalso affect the Alarm Logging settings and the display
of all Controls thatuse these project settings.

Note

Descriptions of all message block properties can be found in the Alarm Logging
documentation.
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Message Line Tab

Box Description

Existing Message
Blocks

Displayed here is a list of the message blocks selected in the
"Message Blocks" tab that have not yet been assigned to the
message line.

Elements of the
Message

Displayed here is a list of the message blocks which are to be
displayed in the Alarm Control.

 

 

These buttons allow you to move message blocks between the list
with the existing message blocks and the list with the message
elements.

 
These buttons can be used to change the order of the message
blocks within the message window.
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3.8.3 Operation of the Alarm Control in Runtime

3.8.3.1 The Toolbar of the WinCC Online Trend Control

If you do not want to operate the WinCC Online Trend Control using the toolbar in
runtime, several standard functions are available from the "Alarm" group of the "Global
Script" editor.

Icon Description

Display Process Message Window
Displays the messages currently pending.

Display Short-Term Archive
Displays the messages archived in a short-term archive.

Display Long-Term Archive
Displays the messages archived in a long-term archive.

Central Indicator Acknowledgment
Acknowledges an optical or acoustical signal indicator.

Single Acknowledgment
Acknowledges a selected single message.

Group Acknowledgment
Acknowledges all pending and visible messages that require
acknowledgment in the message window, provided that they do
not require single acknowledgments.

Auto-Scroll On/Off
If the "Auto-Scroll" function is active, the most recent message
in the message window will always be selected. The visible
area of the message window is moved if necessary.
If "Auto-Scroll" is not active, a new incoming message will not
be selected. The visible area of the message window will not be
changed.
A direct selection of message lines is only possible if "Auto-
Scroll" is not active.

Selection
Definition of selection criteria for the messages to be displayed
in the message window. All messages meeting these criteria
will not be displayed, but still be archived.

Set Lock
Definition of lock criteria. All messages meeting these criteria
will not be displayed and not be archived.

Report Functions
Function for generating the paper documentation.

City Call Functions
These functions are not available yet.

Reset
Non-acknowledgment of a message that requires
acknowledgment. This function sends the acknowledgment bit
of a selected message directly to the PLC, even if the message
is not pending.
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Icon Description

Beginning of the List
Selects the first of the currently pending messages. The visible
area of the message window is moved if necessary. This
function is only operational, if the "Auto-Scroll" function has
been deactivated.

End of the List
Selects the last of the currently pending messages. The visible
area of the message window is moved if necessary. This
function is only operational, if the "Auto-Scroll" function has
been deactivated.

Next Message
Selects the next message (the message after the currently
selected one). The visible area of the message window is
moved if necessary. This function is only operational, if the
"Auto-Scroll" function has been deactivated.

Previous Message
Selects the previous message (the message before the currently
selected one). The visible area of the message window is
moved if necessary. This function is only operational, if the
"Auto-Scroll" function has been deactivated.

Info Text
Opens a dialog box for entering information texts.

Comments
Opens a text editor for entering comments.

Loop in Alarm
Displays a screen or triggers a script to the selected message.
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Selection of Messages
For the messages to be displayed in the message window, selection criteria can be defined
in the "Message Selection" dialog box. In this way you can, for example, specify that only
messages of a certain message class or messages pertaining to a certain error location be
displayed.
For certain message blocks, such as the date and time system blocks, a dialog box can be
opened by double-clicking on the name of the selection criterion. In this dialog box you can
specify the start and end times or define search texts.

Locking of Messages
Compared to the selection of messages, the lock criteria not only suppress the display but
also the archiving of messages.
In the "Lock List" dialog box, accessed by clicking on the "Set Lock" icon on the toolbar of
the Alarm Control, there two options to define the lock.



Configuring a Message System 08.99

3-80 WinCC Manual
C79000-G8276-C160-01

Locking Single Messages based on the Message Number

Locking Messages based on the Message Class or Message Type

Note:

In a multi-client system, the server list will only list those servers, whose "Packages" have
been loaded on the multi-client.
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Emergency Acknowledgment of Messages
In special cases, the "Reset" button can be used to acknowledge a message based on its
message number. In this case, the acknowledgment bit will be sent to the PLC even if the
message is currently not pending. Therefore this function should only be used in emergency
cases. The non-acknowledgment is performed by clicking on the "Acknowledgment Job"
button.

Note:

In a multi-client system, the dialog box for the server selection (accessed via the
"Selection..." button) will only list those servers, whose "Packages" have been loaded on
the multi-client.

3.8.3.2 Standard Functions for Operating the WinCC Alarm Control

Standard Functions
If you do not wish to operate the WinCC Alarm Control via the toolbar in runtime, several
standard functions are available from the "Alarm" group in the "Global Script" editor.

Function Description

AXC_OnBtnArcLong This function switches the message window to display
messages archived in a long-term archive.

AXC_OnBtnArcShort This function switches the message window to display
messages archived in a short-term archive.

AXC_OnBtnComment This function opens the dialog box for entering a comment to
the message.

AXC_OnBtnEmergAckn This function serves for the non-acknowledgment of a
message.

AXC_OnBtnHornAckn This function can be used to acknowledge a central signalling
device assigned to the selected message.
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Function Description

AXC_OnBtnInfo This function opens an information window, in which the
stored infotext is displayed.

AXC_OnBtnLoop This function performs a picture change to the configured
"Loop-In-Alarm" picture of the selected message.

AXC_OnBtnMsgFirst This function selects the first message and moves the visible
area of the message window if necessary.

AXC_OnBtnMsgLast This function selects the last message and moves the visible
area of the message window if necessary.

AXC_OnBtnMsgNext This function selects the next message and moves the visible
area of the message window if necessary.

AXC_OnBtnMsgPrev This function selects the previous message and moves the
visible area of the message window if necessary.

AXC_OnBtnMsgWin This function switches the message window to display the
currently pending messages.

AXC_OnBtnPrint Depending on the current display type (message window,
short-term archive window, long-term archive window), this
function generates a printout of the currently pending or
archived messages and the messages whose selection criteria
are filled. The layout which is used is also dependent on the
message window type.

AXC_OnBtnScroll This function switches the Auto-Scroll behavior of the
message window.

AXC_OnBtnSelect This function opens the dialog to specify the selection of
messages.

AXC_OnBtnSingleAckn This function acknowledges a selected single message.

AXC_OnBtnVisibleAckn This function acknowledges all visible messages in the
message window.

AXC_OnBtnLock This function opens a dialog box, which is used to lock
messages.

AXC_SetFilter This function defines a filter for selecting the messages to be
displayed in the message window. The definition of the filter
criteria must be made within the action script.

Note

A complete description of all standard functions for operating the WinCC Alarm Control
can be found using the online help index.
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Example of Using the Standard Functions
To operate the WinCC Alarm Control, e.g. acknowledge pending messages, the
corresponding functions must be configured. This is done by adding dynamics to objects
using Global Script standard functions.
In general, any object can be used to operate the Alarm Control. To achieve a resemblance
to the toolbar of an application window, the example uses "Graphic Objects". The
following segment illustrates the steps necessary to configure a function for acknowledging
a message:

1. Determining the object name of the OLE Control: When you place the mouse over an
object, the name of the object, e.g. OLE-Control1, is displayed in the tooltip text.

2. Adding a "Graphic Object" to the picture: In your picture, create a "Graphic Object"
of the desired size and select the picture to be displayed from its configuration dialog.

3. Adding Dynamics to the "Graphic Object":
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Display the properties of the "Graphic Object" via its pop-up menu. In the "Events" tab,
select the "Mouse" entry and add dynamics via a C-Action to the "Mouse Action"
attribute.

To make possible the single acknowledgement of messages, the
"AXC_OnBtnSinglAckn" function must be selected via a double-click from the
"Alarm" group of the standard functions in the "Edit Action" window.
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The "Assigning Parameters" dialog can be closed without modifications by clicking
on the "OK" button.

In the "Edit Action" window, replace the lpszObjectName character string with the
object name of the Alarm Control. In the example, with "OLE-Control1". After
successfully creating the action, the window can be closed by clicking on the "OK"
button.

Note

Additional information about configuring actions can be found in the documentation for the
Global Script editor.
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1 Functionality
Tag Logging contains functions for taking over data from processes which have executed
and prepares that data for display and archiving. These data can provide significant
industrial and technical information concerning the operating status of a system.

Tag Logging

• simplifies the early detection of danger and fault conditions.

• helps to increase productivity.

• helps to improve product quality.

• facilitates optimization of maintenance cycles.

• documents the course of process values.

Tag Logging is divided into two components: the Configuration System and the Runtime
System.

Tasks of Tag Logging in the Configuration System
The archives, the process values which are to be archived, and the archiving cycles are
defined in the Tag Logging editor. Configuration within Tag Logging is simplified through
the use of the Archive Wizard.

Data are displayed in runtime with the aid of the "WinCC Online Trend Control" and
"WinCC Online Table Control" ActiveX Controls, which are configured in the Graphics
Designer.

Tasks of Tag Logging in Runtime
The Tag Logging Runtime System archives and displays process values which arise.

Displaying Data in the Runtime System
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1.1 Definition of Terms

1.1.1 Data Types

The data can be divided into the following groups:

•  Operating data: serve as the basis for transmitting the current status, the workload,
and the future development of an operation.

•  Batch data: are the sum of the messages, process data, and recipes (setpoint values)
per production section which are loaded under a specific batch identifier.

•  Lab data (manually input data records): include all data which are input manually.

•  Machine data: allow statements to be made about the status of a "machine".

•  Process data: allow statements to be made about the current and past (historical)
version of a continuing process.

•  Quality data: allow statements regarding characteristic properties of a product which
should be maintained.

It is possible for some data to appear in multiple classes at the same time or for the same
data to be assigned to different data types.

Tag Logging makes it possible to acquire or edit process data. It also provides basic
mechanisms for acquiring and editing additional data types.

1.1.2 Archiving Methods for Process Data

The chapter on archiving methods explains the possibilities implemented in process data
acquisition for saving data from a process in a personal computer system and editing that
data further.

Process data are measurement values that are acquired by means of special sensors. In
order to process them in WinCC, tags are assigned to the data.

Data archiving is controlled through a combination of events and cycles. The person who
configures the system determines what kind of data should be stored in each archive.
This person can select from the following methods of archiving:

• Cyclic continuous archiving monitors tag / measurement values.

• Acyclic archiving accepts the current value when the corresponding, configured event
occurs.

• Cyclic-selective archiving links the event control with the archiving controlled
through cycles.

• Process-controlled archiving takes over the execution of message frames.
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1.1.2.1 Tags

Tags are created within WinCC and are distributed by the data manager throughout the
system. These tags can represent internal calculations, limit values, link results, or simple
system events such as time, mouse or keyboard use, or even measurement values.

Tags are divided into the following types: external/internal and message frame tags.

External/Internal Tags
External tags are used for acquiring process variables.Internal tags are used for acquiring
system-internal values and states.

• Binary and analog tags are Tag Logging components which contain archive
properties of the process values (external tags) and internal tags.

• Tags for compressed archives serve for long-term archiving of all other Tag Logging
tag types. Optional functions include high/low values or the implementation of user-
defined functions by means of scripts.

Message Frame Tags
One or more measurement points of a process can be grouped in message frame tags. This
type of transmission is used especially when very rapid process executions are recorded or
when there is data acquisition in blocks in the PLC. Generally, binary or analog values are
used. The number formats are configured to correspond to the settings in the WinCC data
manager. They are accepted by the system in the form of raw data tags.

1.1.2.2 Measurement Values

Measurement values are data which are transferred from the actual process by way of the
linked communication channels to the WinCC archiving system. These measurement values
represent the actual process. They include, for example, temperatures, pressures, speeds,
alarm messages, and limit switches.

1.1.2.3 Events

Events can occur in various forms. A distinction is made between the following event
types:

•  Binary events

•  Limit value events

and

•  Timed events

Events and combinations of events are programmed in the Global Script module using
script functions. They can be assigned to the appropriate tag in the configuration system of
Tag Logging with the help of a function browser.
The functions are activated when runtime starts.
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Binary Events
Binary events react to an edge change of binary tags (internal and external).

Limit Value Events
Limit value events react to the following with or without hysteresis:

• In excess of high limit value

• Below low limit value

• Limit value reached.

Timed Events
Timed events react to the following:

• Set point in time

• Shift change

• Time period after start.

1.1.2.4 Cycles

Different time cycles are set up for acquisition and archiving. They form the basis for data
acquisition in digital systems. When they are input, the period length is also entered (the
time between two scans). The minimum period length is 500 ms. All of the time bases
which can be set are integer multiples of this length.
Tag Logging differentiates between acquisition cycles and archiving cycles. The period
length of archiving cycles is an integer multiple of the period length of the corresponding
acquisition cycle.

Acquisition Cycles
The acquisition cycle helps the Tag Logging Runtime System acquire the data manager
tags.
The data manager executes its process image continuously. The Tag Logging Runtime
System accepts the data contents at the times set in the acquisition cycle (te).

When defining acquisition cycles with small periods, be sure that the period is significantly
higher than the hardware acquisition period. With small periods, it is more sensible to store
the data for the interim in the PLC and send it to WinCC by means of a message frame.

Archiving Cycles
The archiving cycle serves to transfer the acquired and processed data manager tags into the
archive prepared for them.

At set times (ta), the archiving cycle regularly releases tags for displaying and archiving
purposes. The relationship of the archiving cycle to the acquisition cycle determines the
amount of process data that are to be processed at the same time. The acquisition cycle
provides the process data.
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1.1.2.5 Cyclic Continuous Archiving

Data acquisition begins when the system starts (runtime) and is continued at regular time
cycles until the system is turned off.
You can configure the acquisition cycle and archiving cycle independently of each other in
each archive of the WinCC archiving system. The cycle can be configured from 1 second
to 1 year. The time cycles are set in the configuration phase for each tag/measurement
value or for a group of tags/measurement values and are therefore statically hard-coded in
the runtime module. With each archive function, you can generally choose to store the
mean, minimum, or maximum value within the storage cycle, or the actual value.
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1.1.2.6 Cyclic-Selective Archiving

Archiving is started when an event occurs and is carried out at regular time cycles until a
second event occurs. In the event of a stop signal, the most recently acquired value is also
stored.
The following are examples of start or stop events:

• Status change of a logical tag/measurement value

• Reaching a limit value of a tag/measurement value

• Time and date

• Keyboard or mouse use in WinCC

• Commands from higher-level computer systems by way of the data manager or external
application

• A combination of the above

Events are processed with the help of action programming.
The assignment of events, archiving cycles, and acquisition cycles is defined during the
configuration phase for each tag or group of tags. It is statically hard-coded in the runtime
module. The same applies for measurement values and measurement value groups.
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1.1.2.7 Acyclic Archiving

In acyclic archiving, a binary or analog tag/measurement value is stored once when an
event occurs.
The following are examples of start or stop events:

• Status change of a binary tag/measurement value (edge triggered)

• Reaching a limit value of an analog tag/measurement value

• A combination of the above

• Events which are generated dependent of time and date

• Message frames

Events are processed with the help of action programming.
The assignment of events, archiving cycles, and acquisition cycles is defined during the
configuration phase for each tag or group of tags. It is statically hard-coded in the runtime
module. The same applies for measurement values and measurement value groups. In
acyclic archiving, the actual value is always stored in the archive.
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1.1.2.8 Process-Controlled Archiving

In process-controlled archiving, the process values to be archived are grouped into blocks
in the PLC and are sent as raw data tags to Tag Logging by way of the data manager. The
data are then prepared in Tag Logging using a conversion program, the format DLL, and
stored in the archive. This format DLL is channel-dependent and must, therefore, conform
to the specifications of the manufacturer of the channel or of the PLC. The Tag Logging
Runtime System offers a defined interface for this purpose.
If process-controlled archiving is performed with a SIMATIC S5, the message frames
detailed in the appendix must be used as the communication basis.

1.1.2.9 Recording

Each measurement point can be recorded in three different ways by Tag Logging:

• in a main memory ring buffer

• in a ring buffer on the local hard disk

or

• in a long-term archive on the local hard disk.

Main Memory Ring Buffer
A main memory ring buffer is used for recording current trends with a brief history. It
offers time-limited process-value recording. If the buffer is full, the oldest data are
overwritten.
This means that the user can store the current measurement value buffer contents — in the
sense of a snapshot — when a configured event (operation, event, etc.) occurs.

The size of the ring buffer is calculated for a tag as follows:

Number of measurement values  * 28 bytes.

Ring Buffer on the Hard Disk
Measurement values are recorded in a ring buffer of configurable length. If the buffer is
full, the oldest data are overwritten.
It is possible to swap measurement values contained in the ring buffer to a configured event
(operation, event, etc.). The type and scope of the measurement values to be swapped must
be contained in the script.

The measurement values can be stored in either the database or in dBase III tables. If the
volume of measurement values to be processed is large, it is recommended to use dBase III
tables.
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Long-Term Archives
Tag Logging also offers the option to automatically construct long-term archives. This
means that practically unlimited archiving of measurement values along the time axis is
supported. Historical recording is thus limited only by the available memory space.

Note

Before you set up a long-term archive, you should check to see if there is sufficient free
memory available on the storage medium for the time frame to be archived.
Long-term archives can be swapped for any given time frame by using the "Storage"
option. On the user interface, it is implicitly possible to view the contents of old archives.

1.1.3 Protection from Unauthorized Access

With the help of the  user authorizations defined in the User Administrator, you can protect
your archive data from unauthorized access. This applies, in particular, to the runtime
output. For this purpose, assign an authorization level to each archive. If another user logs
onto the system, the user authorizations assigned to that user are compared with those of the
archive system. Only those archives whose authorization levels are identical to those of the
user are released. For details, refer to the "User Administrator" chapter of the manual.
User authorizations are assigned in Tag Logging in relation to the archives. Separate
authorizations are given for write and read access. This means that a user who can read the
data in a given archive does not necessarily possess write access for the archive.
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2 Structure of Tag Logging

After you open the Tag Logging Configuration System, the opening window appears. It is
divided into four areas.

A menu bar, which contains the drop-down menus, is located along the upper edge of the
screen.
Directly below the menu bar is the toolbar. Functions which are used often are available
here as icons.
The project window is divided into the navigation window, data window, and table
window.
The lower edge of the screen contains the status bar, in which you can view information
about the current operation.
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2.1 Menus of the Tag Logging Configuration System

The menu bar contains all of the commands available in the Tag Logging Configuration
System. They are divided logically into groups and assigned to different menus. In order to
execute a command, open the appropriate menu, click on the command, and set the
necessary parameters.

After you open the Tag Logging Configuration System, you will see the following menu
items and buttons:

Menu Menu Command Shortcut

File Save
Print Project Documentation
Project Documentation View
Setup Project Documentation
Exit

CTRL + S
CTRL + P

Edit Undo
Cut
Copy
Paste
Properties

CTRL + Z
CTRL + X
CTRL + C
CTRL + V

View Toolbar
Status Bar
Large Symbols
Small Symbols
List
Details
Add/Remove columns
Update F5

Help Contents and Index
Direct Help
Using Help
Tutorial
About Tag Logging

SHIFT + F1

Note

In the following, only menu commands which vary from those found in standard Windows
applications or whose functionality exceeds that to which you may be accustomed will be
described in detail. Information about these menu commands can be found in the Direct
Help of the individual editors.
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Print Project Documentation
Project Documentation View
Printer Setup

 Use the command "Print Project Documentation" to print the archive system to the set
printer. The template for the printout is the page layout "@TLGCS.RPL", which can be
changed with the "Report Designer". Project Documentation provides you with information
about the configured timers as well as about the configured archives and tags.

The command "Project Documentation View" is used to obtain a preview of the project
documentation.

Use the command "Printer Setup" to specify the printer to be used and the page layout.

Note

Additional information about printing the project documentation can be found in the
"Project Documentation" chapter of the system description.

Add / Remove Columns
Use the "Add/Remove columns..." command to turn individual columns on or off in the
table window.
The table window is updated according to the selection criteria you set. The columns that
are not marked are hidden.
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2.2 Toolbar

The toolbar has the following appearance:

These icons allow you to execute actions more rapidly. You do not have to make several
selections through the menus until you reach the required function.

Icon Description

Save

Cut

Copy

Insert

Print

View: Large Symbols

View: Small Symbols

View: List

View Details

Properties of a selected object

Call up context-sensitive Help



08.99 Structure of Tag Logging

WinCC Manual 2-5
C79000-G8276-C160-01

2.3 Navigation Window

The project-specific components are displayed in the navigation window in a tree structure.

Element Description

Project properties for setting the data format of continuous
archives.

Timers for creating archiving and acquisition cycles.

Archives for creating and configuring archives and tags.

Use the pop-up menus to comfortably create, edit, and delete the individual ranges and their
elements.

Displaying Timers

If you select the "Timers" configuration area in the navigation window, the data window
contains the icons for the individual timers.

The table window remains empty.

Displaying Archives

If you select "Archives" in the configuration area of the navigation window, the data
window contains the configured archives.

If you select the list view (  button in the toolbar), the parameters (archiving method,
archive type, date of last change) associated with each configured archive can also be
entered.

If you select an archive in the data window, the associated tags with their parameters (such
as tag type, archiving method, archiving cycle, ...) are displayed in the table window.
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2.4 Data Window

The data window displays the icons for the available configuration areas in which the
settings for the selected project are laid out.

2.5 Table Window

The table window contains, for example, all tags of an archive and the properties of these
tags.

In the table window, you can change the column width and the order of the columns.
The change in the column width is permanent, i.e. the next time Tag Logging is started, the
table window will be opened with the column widths you set. The change to the order of
the columns is only temporary.

2.6 The Status Bar

In addition to general program information, the status bar displays the number of
configured archives.

2.7 Selection Dialogs

This window type is opened to identify, link, or assign data that were created with other
tools in WinCC. The following three window types are used for this purpose in Tag
Logging:

• the "Select Tags" dialog box,

• the Function Browser, and

• the Selection Dialog
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2.7.1 Select Tag

The system provides a dialog window for linking tags. Select the tag to be linked by
clicking on it with the left mouse button.

You can find additional details in the "Control Center" chapter of the user manual.

2.7.2  Function Browser

Use the function browser to select project-specific functions. These may be available as
default elements or they can be created as script programs.
These functions are stored in the "Control Center" under the "Global Script" editor.

2.7.3 Selection Dialog

A selection dialog consists of the following items:

• two window sections with data objects

• a bar with buttons between the two window sections

You can shift (select) the data objects between the two window sections by using the
buttons.
Generally, selection dialogs are implemented to create a selection from a quantity of data
objects. As a rule, the left half of the window contains the starting group or the standard
group of data objects (source) and the right half of the window contains the selected group
of data objects (target).
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3 Configuring in Tag Logging
This chapter explains how you:

• Specify the data format of a continuous archive.

• Specify acquisition and archiving timers.

• Configure process value archives and compressed archives.

How to Configure Tag Logging:

1. Specify the data format of the continuous archives.

 The Data Format of Continuous Archives

2. Configure the acquisition and archiving timers you require.

 Acquisition and Archiving Timers

3. Configure the required process value archives.

 Configuring Process Value Archives

 Configuring the Tags in Process Value Archives

4. Configure the required compressed archives.

 Configuring Process Value Archives

 Configuring the Tags in Process Value Archives

5. If necessary, configure the WinCC Online Trend Control in the "Graphics Designer"
to display the process values in trend form.

 WinCC Online Trend Control

6. If necessary, configure the WinCC Online Table Control in the "Graphics Designer"
to display the process values in table form.

 WinCC Online Table Control
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3.1 Project Properties

The first entry in the project navigation window is the name of your project. An
information dialog window can be opened via the entry’s pop-up menu. In this window,
you can set, among other items, the data format in which the measurement values of a
continuous archive are to be stored.

How to Change the Data Format of a Continuous Archive:

1. In the project navigation window, select the entry with the name of your project.

2. Click the right mouse button to open the pop-up menu and select the "Properties"
item.

3. Click on the check-box "Continuous archive using dBase III format" to change the
data format of the continuous archive. A check mark indicates that the measurement
values will be stored in dBase III tables.

4. Exit the dialog by clicking on "OK".

Note

The use of the dBase III format is advantageous if large amounts of data are to be
processed.
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3.2 Timers

Tag Logging recognizes two different timer systems: the acquisition timer and the
archiving timer.

Acquisition timers are time intervals in which values are copied by Tag Logging from the
process image of the data manager.

Archiving timers are the time intervals in which the data are loaded into the archive. The
archiving timer is always an integer multiple of the set acquisition timer. The last value is
always loaded at an archiving interval. The first value belongs to the previous interval.

Compression timers are timers that are used to set the time ranges in which data are to be
compressed.

These timers can be created and edited in the "Timers" configuration area.
How to Create New Acquisition or Archiving Timers:

Use the pop-up menu to open the dialog box belonging to the "Timers" configuration area
and select "New".
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Editing Timers
In the "Timers" dialog window, the cycle time of an archiving cycle can be edited.

Icon Description

Name Short name of the timer.

Base The set time base. The cycle time is the result of multiplying the time
base by the factor.

Factor Multiplier of the time base. The cycle time is the result of multiplying
the time base by the factor.

System Start If this option is activated, one archiving cycle will be performed,
independent of the configured cycles, when the system is started.

System End If this option is activated, one archiving cycle will be performed,
independent of the configured cycles, when runtime is exited.

Start Time Use this entry to specify a start time at which the first archiving cycle
is to be performed. Afterwards, the archives will be started according
to their set cycle time.
Depending on the used time base, some of the fields for entering the
start time may not be editable.

The archiving cycle, i.e. the length of time between two archiving cycles, is the result of
multiplying a time base by a time factor:

Cycle Time = Factor x Base
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3.3 Archives

The archives folder contains the default settings for creating an archive and defining the
associated tags along with their links to the data manager tags, etc.

The archives can be created and edited in the "Archives" configuration area. Every time a
new archive is created, the presettings are used.

For information on making the presettings, please refer to the "Archive Presettings"
chapter.

Note

Beginning with WinCC V4.0, data can also be stored in dBase-III format. This data format
is especially recommended if large data amounts are to be archived. The format is set in the
"Project Properties" dialog (see the "Project Properties" chapter of this manual).

3.3.1 Archive Presettings

WinCC offers you the opportunity to implement presettings for archives and tags. This
saves you the effort of repeatedly entering frequently used properties.

How to Create a Presetting for the Archive Creation:

1. Select the "Presettings" menu item under "Archives".

This brings up another menu.

2. Select the project-specific components for which you are creating presettings.

3. After you select the menu item to be set, the appropriate properties dialog box
appears.
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3.3.2 Creating an Archive

How to Create a New Archive:

1. After you select the "Archives" configuration area, a pop-up menu appears.

2. To create new archives, select "Archive Wizard" in the pop-up menu for the
"Archives" configuration area.

3. The database manager cover page appears for creating new archives.

The individual boxes are accessed using the left mouse button. If the box labelled "Do not
display this page anymore" is still marked when you exit the last page of the dialog, the
cover page will not appear in the future.

Icons Description

Next Use this button to page forwards within the dialog.

Back Use this button to page backwards within the dialog.

Cancel Use this button to abort the dialog.
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4.  When you activate the "Next" button, you advance to the next dialog window, where
you can choose to create a process value archive or a compressed archive.

Note

An archive type assigned to an archive cannot be changed after you exit the Wizard. If you
used the incorrect type, the only way to correct it is to delete the entire archive.

3.3.3 Process Value Archives

This archive type accepts the contents of the data manager tags.

3.3.3.1 Process Value Archives

How to Create a New Process Value Archive:

1. In "Step 1," enter the name of the archive under "Archive" and select the archive type
with the left mouse button (process value archive in this case).

2. Advance to the next dialog box with the "Next" button.
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3. In the "Creating an Archive: Step 2" dialog box, assign the archive tags the data
manager tags.

Each process value archive accepts data manager tags. The link is constructed by activating
the "Select..." button.

4. Select the desired data manager tags for each archive tag from the list of tags in
"Select a Tag". An archive tag is created for each data manager tag selected. The
parameters are set with the values set under "Presettings".

Archive-specific entries are set directly by means of the archive properties.

You can also change the properties of the created tags directly in the dialog for tag
properties.
Create new tags by means of the pop-up menu of the respective archive.
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3.3.3.2 Editing Process Value Archives

How to Edit Process Value Archives:

1.  Use the left mouse button in the data window to activate the process value archive you
want to edit.

2.  Use the right mouse button to activate the pop-up menu and then select the "Properties"
item with the left mouse button,

or

select the desired archive by double clicking on it with the left mouse button,

or

in the "File" menu, select the "Properties" item.
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General Properties of the Process Value Archive

Icon Description

Archive Name Brief name of the archive

Server Name Server addressed by the archive

Comments Brief description of the archive or comments
about the archive

Archiving at System Start
Enabled/Locked

Begin or do not begin archiving immediately
after the system starts

Archive Type Type of the selected archive (cannot be
changed)

Authorization Level for
Write/Read Access

Access authorizations for write or read access

Password Enable access when a password is entered

Action During Archive
Start/Enable

Here, you can enter an action to be triggered on
certain events. The action can be selected using
the function browser or can be input directly
with its complete path name.
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Archive Parameters of the Process Value Archive
Set the general archive parameters here. The current archive name and the archive type are
in the upper left corner of the tab.

Icons Description

Size of Data Records Size of the circulating memory. This point
is not relevant for long-term archives, as
long-term archives are dynamic.

Memory location Where the memory is swapped. You can
select the hard disk or RAM.

Action for exporting the short-
term archive

Here, you set which action triggers the
exporting of a file. These actions can be
selected by using the "Select" button.
When you click on this button, the
function browser is opened.

Fill level message If one of the two options is selected, Tag
Logging outputs a message when the
corresponding amount of data has been
loaded in memory.
This function is not available at this
time.
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Icons Description

Archive Type In this options box, you can set the
archive type. You may select between
continuous archives and long-term
archives.

Long-term archives are archives which are written
continuously when there is a new archive
value. They are dynamic.

Continuous archives require that the user specify a size in data
records. If memory is full, the oldest
value in memory is lost when there is a
new write operation.

3.3.3.3 Process Tags in the Process Value Archive

Before you create a new tag, you must have previously created an archive.

How to Set Up a New Tag in a Process Value Archive:

1. To create new tags, select the appropriate process value archive in the data window
and activate the corresponding pop-up menu.

2.  Select "New Tag".

This selection opens a dialog window for tag management. Here, you set the access
for the archive tags to the corresponding data manager tag.

3. Use the left mouse button to select the appropriate data manager tag.

Depending on whether you selected "analog" or "binary" tags, the "Properties" dialog for
analog or binary process tags opens.
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3.3.3.4 Editing Process Tags

How to Edit a Tag in a Process Value Archive:

1. Use the left mouse button in the table window to activate the process tag that you want
to edit.

2. Open the pop-up menu and select the "Properties" item in the drop-down menu,

or

select the desired tag by double clicking on it with the left mouse button,

or

in the "File" menu, select the "Properties" item.

You can find information on the rest of the process in the chapter "Setting Up New Tags in
the Process Value Archive"
a) under analog process tags or
b) binary process tags.

- How to Edit Single Boxes in a Process Value Archive:

Double click on the box of the process value archive you want to edit. Depending on
the box type, you can change the contents of the box any way you wish or make a
selection from a selection list.

Note

Boxes that you cannot edit in a process value archive are marked in color!



Configuring in Tag Logging 08.99

3-14 WinCC Manual
C79000-G8276-C160-01

3.3.3.5 Analog Process Tags

Archive Tag

Icon Description

Name of the Archive Tag Name of the created analog archive tag

Name of the Process Tag Name of the corresponding data manager tag

Comments Brief description of the analog archive tag

Supplying Tags Here, you can choose between manually inputting the
tag and automatically transferring data to the archive
from the selected data manager tag.

Archiving at System Start
Enabled/Locked

Begin or do not begin archiving immediately after the
system starts.

Archiving type You can enter an acyclic, cyclic-continuous, or cyclic-
selective archive in this box.

Also put archived value in tag Here, you can set whether the accepted value should
also be input in tags, and select which tags should
receive that value.
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Note

If you link your archive tags with external tags by means of "Also put archived value in
tag", the data are sent directly to the PLC!

Parameters

Icons Description

  Cycle The cycles must be defined in the "Timers" configuration area
before they are used.

The cycle that acquires data from the data manager tag is input
under Acquisition.

The cycle that is used to archive data is input under Archiving.
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Icons Description

Editing Tag Logging is capable of executing brief commands for
preprocessing data. The preprocessing can be set by the user.

With Actual Value, only the actual value of a data manager tag is
accepted.

Mean Value means that the acquired data are averaged during the
course of an archiving cycle. It should be noted that the last value at
the moment of archiving is also processed. It is not included in the
next cycle.

The process is the same for acquired data in the case of Sum. Here,
however, the acquired data are added.

Maximum Value means that the largest accepted tag value within
an archive cycle is stored in the archive. Minimum Value means
that the smallest value is stored. The actual value also belongs to the
current cycle.

Action is a special type of data preparation. Here, the user can select
more complex functions via a data path.

An implemented user function can be selected by using "Select".

Number of Values For every archived value, Tag Logging can store a variable number
of values which occur in front of the actual value, the leader. Tag
Logging can also store a number of values which occur after the
actual value, the trailer.These entries allow you to prepare
statements about how a value was created in the short term, or how
it developed further.

Unit Enter the unit of the input time value here under Direct or use
Structure Element to select the appropriate unit of the tag. This
entry is used primarily for tag display.

Save on Error If transmission or system errors occur which are detected by Tag
Logging or the Control Center, the incorrect value can be corrected
using the last value or a substitute value. The substitute value is
calculated as the average of the previous value and the following
value.

Archive only upon
change

Here, you can specify that an analog process tag only be archived
when it has changed.

Hysteresis With the value entered here, you specify how much an analog
process tag must change in order for it to be archived.

Depending on whether "abs." or "%" is selected, you specify that the
value entered here is to be interpreted as either an absolute value or
as a percentage.
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Display

In this dialog window, the display range of the tag is set. This is represented by the vertical
axis.

Icon Description

No Display Limitation Select this item if you do not want to select a transfer
range.

Configured Directly  Set the transfer range of the tag. Using the low and
high limits, you can set a transfer range for the tag.

Indirectly by means of structure
element

This function is not available at this time!
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Events

Input the situations in the "Events" dialog window under which archiving is triggered.

Icon Description

Start Event Function that delivers a value of TRUE or FALSE. If the value
TRUE appears, the system can begin archiving. Actions can be
selected and input in a list with "Select". Depending on the type of
archive, this box may be disabled.

Stop Event Function that delivers a value of TRUE or FALSE. If the TRUE
value appears, archiving is stopped. This function has precedence
over the function in "Start Event". Actions can be selected and
input in a list with "Select". Depending on the type of archive, this
box may be disabled.

Dynamic Dynamic means that timers can be changed dynamically. This
makes it possible to change the archive or acquisition timer when
certain events occur (the function you enter delivers a value of
TRUE). Depending on the type of archive, this box may be
disabled.
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3.3.3.6 Binary Process Tags

Archive Tag

Icon Description

Name of the Archive Tag Name of the created binary archive tag

Name of the Data Manager Tag Name of the corresponding data manager tag

Comments Brief description of the binary archive tag

Supplying Tags Select between manual tag input (Manual Input)
and the automatic transfer of data from the selected
data manager tag to the archive (System).

Archiving at System Start
Enabled/Locked

Begin or do not begin archiving immediately after
the system starts.

Archiving type In this box, you can define the archive as acyclic,
cyclic-continuous, or cyclic-selective.

Also put archived value in tag Here, you can set whether the accepted value
should also be input in tags, and select which tags
should receive that value.
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Parameters

Icon Description

Archive on In this area of the window, you can select the logical
signal status change on which the type of change
(e.g. from high to low) as well as the time stamp are
to be archived. If you select "on every signal
change" , the signal is archived each time the status
changes. "Always" means constant archiving. In that
case, the status of the tags is acquired at every
archive time stamp. If you select "on signal change
0 -> 1", the value is accepted after a signal change is
detected. If you select "on signal change 1 -> 0", the
value is accepted after a signal change is detected.

Name of States The state is assigned a name up to 40 characters long
in the State 0 box; e.g. "Machine Off". It also
receives a brief identifier, such as "Machine On" in
the State 1 box.

Cycle The cycles must be defined in the "Timers"
configuration area before they are used. Enter the
cycle that is used to archive data under Cycle.
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Icon Description

Number of Values For every archived value, Tag Logging can store a
variable number of values which occur in front of
the actual value, the leader. Tag Logging can also
store a number of values which occur after the actual
value, the trailer. These entries allow you to prepare
statements about how a value was created in the
short term, or how it developed further.

Save on Error If transmission or system errors occur which are
detected by Tag Logging or the Control Center, the
incorrect value can be corrected using the last value
or a substitute value. The substitute value is
calculated as the average of the previous value and
the following value.
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Events

Input the situations under which archiving is triggered in the "Events" dialog window.

Icon Description

Start Event Function, that delivers a value of TRUE or FALSE. If the
value TRUE appears, the system can begin archiving.
Presettings can be selected and input in a list with Select.
Depending on the type of archive, this box may be
disabled.

Stop Event Function, that delivers a value of TRUE or FALSE. If the
TRUE value appears, archiving is stopped. This function
has precedence over the function in "Start Event".
Presettings can be selected and input in a list with Select.
Depending on the type of archive, this box may be
disabled.

Dynamic Dynamic means that timers can be changed dynamically.
This makes it possible to change the archive or
acquisition timer when certain events occur (the function
you enter delivers a value of TRUE). Depending on the
type of archive, this box may be disabled.
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3.3.3.7 Process-Controlled Tags in the Process Value Archive

The process values to be archived in the process-controlled archive are grouped in blocks in
the PLC and sent as raw data tags by way of the data manager to Tag Logging. In this
process, the raw data tag must be transferred to the data manager in a specific format. For
more information about the structure of raw data tags, refer to the appendix.
Tag Logging prepares the incoming data with the appropriate format DLLs and stores them
in the archives.
Before you create a new tag, you must have previously created an archive.

How to Create a Process-Controlled Tag

1. Select the appropriate process value archive in the data window and activate the "New
Tag" function in the corresponding pop-up menu.

3.3.3.8 Editing Process-Controlled Tags

How to Set Up a Process-Controlled Tag:

1. Use the left mouse button in the table window to activate the process-controlled tag
you want to edit.

2. Open the pop-up menu and select the "Properties" item in the drop-down menu,

or

select the desired tag by double clicking on it with the left mouse button,

or

in the "File" menu, select the "Properties" item.
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3. Set the links between archive, decoding, and raw data.

Icon Description

Format DLL Here, you select the format DLL appropriate for
your PLC as specified by the PLC manufacturer.

Raw Data Tag Here, you enter the name or identification number of
the raw data tag made available by the data manager.

Options Here, you can set DLL-specific parameters.

Tag Here, Tag Logging enters the tag name created by
system-internal data.

Comments Brief remarks about the process-controlled tag.
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3.3.4 Compressed Archives

Compressed archives are used to compress data as well as to combine values efficiently.
This way, measurement values can be edited directly and then recorded immediately.
Compressed archives are used for the long-term archiving of all other Tag Logging tag
types. Optional functions include user-defined functions as well as maximizing or
minimizing values.

3.3.4.1 Compressed Archives

How to Create a New Compressed Archive:

1. In the "Creating An Archive: Step -1-" dialog box, enter the name of the archive under
"Archive Name" and select the "Compressed Archive" option with the left mouse
button.

2. Exit the Wizard.

Set the archive-specific inputs and the tag assignments directly in the archive.
The properties of the created tags can also be changed directly in the tag properties.
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3.3.4.2 Editing a Compressed Archive

How to Edit a Compressed Archive:

1.  Use the left mouse button in the data window to select the compressed archive you want
to edit.

2. Use the right mouse button to activate the pop-up menu and use the left mouse button
to select the "Properties" item,

or

select the desired archive by double clicking on it with the left mouse button,

or

in the "File" menu, select the "Properties" item.
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General Properties

Icons Description

Archive Name Brief name of the archive

Server Name Server addressed by the archive

Comments Brief description of the archive or comments
about the archive

Archiving at System Start
Enabled/Locked

Begin or do not begin archiving immediately
after the system starts

Archive Type Type of the selected archive (cannot be changed)

Authorization Level for
Write/Read Access

Access authorizations for write or read access

Password Enable an authorization level

Action during Archive
Start/Enable

Here, you can enter an action to be triggered on
certain events. The action can be selected using
the function browser or can be input directly with
its complete path name.
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Archive Parameters
Here, the general archive parameters are set. The current archive name and the archive type
are in the upper left corner of the tab.

Icons Description

Processing method Here, you specify how the data are handled during
and after the compression. You can specify that the
source data either be deleted or not be deleted
following calculations. You can also store the source
data in the compressed archive.

Compression time period Enter a time period over which the data are to be
compressed. You can select from the base times
defined in "Timers", which are larger than or equal
to a minute.

Fill level message If one of the two options is selected, Tag Logging
releases a message when the appropriate amount of
data has been loaded in memory.
This function is not available at this time.
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Icons Description

Archive Type In this options box, you can set the archive type. The
choice is between continuous archives and long-term
archives.

Long-Term Archives/Continuous
Archives

Compressed archives are always long-term archives.
They are always selected at this location.

3.3.4.3 Setting Up Compressed Archives

You must have created tags in the user archive or process value archive and in a
compressed archive before you create a link from tags in a compressed archive.

How to Link a Compressed Archive with the Tags to Be Compressed or How to Delete
Those Tags from the Compressed Archive:

1. To create new tags, select the appropriate compressed archive in the data window and
activate the corresponding pop-up menu.

2. Select "Selection Tag" to acquire tags in a compressed archive. A selection dialog
appears.

The left half of the dialog window contains the uncompressed archives and tags in a
tree structure. The right half of the window contains the selected compressed tags or
archives which are to be made into compressed tags.

3. Link your tag with the compressed archive. You can find information about the
procedure for the selection dialog in the appropriate chapter.

4. Exit the dialog.

Use Tag Properties to edit the created compressed tags.
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3.3.4.4 Editing the Tags of a Compressed Archive

How to Edit the Tags of a Compressed Archive:

1. Use the left mouse button in the table window to activate the compressed tag and
activate the "Properties" menu item in the pop-up menu.

2. Open the pop-up menu and select the "Properties" menu item in the drop-down menu,

or

select the desired tag by double clicking on it with the left mouse button,

or

in the "File" menu, select the "Properties" item.

How to Edit Individual Boxes in a Compressed Tag:

Double click on the box of the compressed tag you want to edit. Depending on the box
type, you can change the contents of the box any way you wish or make a selection
from a selection list.

Note

Boxes that can be edited in a compressed archive are marked in color!
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Archive Tag

Icon Description

Name of the Archive Tag Name of the created analog archive tag.

Name of the Data Manager Tag Name of the corresponding data manager tag.

Comments Brief description of the analog archive tags.

Supplying Tags With compressed archives, you can only assign
tags via the system. This option is selected and
cannot be changed.

Archiving at System Start
Enabled/Locked

Begin or do not begin archiving immediately
after the system starts.

Archiving type You can enter an acyclic, cyclic-continuous,
or cyclic-selective archive in this box.

Also put archived value in tag Here, you can set whether the accepted value
should also be input in tags, and select which
tags should receive that value.
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Parameters

Icon Description

Editing Tag Logging is capable of executing brief commands for
preprocessing data. The preprocessing can be set by the user.
Mean value means that the acquired data are averaged during
the course of an archive cycle. It should be noted that the last
value at the moment of archiving is also processed. It is not
included in the next cycle. The process is the same for
acquired data in the case of Sum. Here, however, the
acquired data are added. Maximum value means that the
largest accepted tag value within an archive cycle is stored in
the archive. Minimum value means that the smallest value is
stored. The actual value also belongs to the current cycle.

Unit Enter the unit of the timer value here under Direct or use
Structure Element to select the appropriate unit of the tag.
This entry is used primarily for tag display.



08.99 Configuring in Tag Logging

WinCC Manual 3-33
C79000-G8276-C160-01

3.4 Deleting a Project-Specific Component

How to Delete a Project-Specific Component:

1. In the navigation window, use the left mouse button to activate the configuration area
from which you want to delete an object.

2. In the data window, use the left mouse button to select the component to be deleted.

3.  Select "Delete" from the drop-down menu,
or
activate "Delete" from the corresponding pop-up menu.

The selected object is deleted.

Note

Tags that are linked to a trend or a column can only be deleted after deleting the link.

3.5 Displaying Process Values in Trends

For the graphical display of tags, WinCC provides the option of displaying tag values as
trends. The trend type to be used can be selected. The values to be displayed may be either
current or archived.

A tag’s course is displayed in runtime by an ActiveX Control, which is set up in the
"Graphics Designer". Tags which can be displayed are those that are configured either in
the WinCC Explorer or in a process value archive.
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3.5.1 Trend Display Types

To graphically display tag values, three basic trend types are available.

Individual Values

Linear Interpolation

Stepped Trend

With the exception of the display of individual values, the area under the trend can also be
displayed filled.

The trend type to be used is specified in the "Value Axis" tab of the "Properties" dialog of
the Online Trend Control.
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Using Shared Axes
If multiple trends are to be displayed in a trend window, you have the choice of using
individual axes for each trend or using shared X/Y-axes for all trends.

If the tag values to be displayed in a tag window differ greatly, the use of shared axes for
the trend display is not recommended. The tag values can be read more easily if different
axial scales are used.

If you want to display multiple trends in a trend window and are particularly interested in
the comparability of the trends, the trend should be displayed with shared axes. In runtime,
the exact tag values can also be determined by enlarging a segment or by inquiring about
the coordinates.

In the "General" tab of the "Properties of WinCC Online Trend Control" dialog, the use of a
shared X-axis and a shared Y-axis can be configured independently of one another.
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Staggered Trends
In a staggered display, the trends are displayed superimposed on each other in the trend
window. For each trend, the value range to be displayed can be set for the Y-axis.

Display Trends Vertically
With the "Write Direction" option, you specify where the current measurement values are
to be displayed. The "from the bottom" setting specifies that the current measurement
values are to be displayed at the lower border of the trend window.

Note

If you select as write direction either "from the top" or "from the bottom", you should use
True-Type fonts within the trend window to ensure a clean display of the time axis
labelling.
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3.5.2 Time Range of a Trend Display

The trend display of tags, in regard to the time ranges to be displayed, can take place in
several ways:

Static Display of a Trend
This display type can display the course of a tag within a set time interval, based on the
archived values.

The static display type is configured in the "Time Axis" tab of the "Properties" dialog by
deactivating the "Update" option. The time range to be displayed is set either

− by entering a start time and a time range.

− by entering a start time and an end time.

− by entering a start time and the number of measurement points which are to be
displayed.

Note

This display type can only be used for archive tags.
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Dynamic Display of a Trend
In this display type, the end time of a trend always corresponds to the current system time.
New measurement values coming in will be included in the display.

The dynamic display type is configured in the "Time Axis" tab of the "Properties" dialog by
activating the "Update" option. The time range to be displayed is set either

− by entering a time range.

− by entering the number of measurement points to be displayed.

− by the time difference between the specified start and end times

Note

If a trend window picture is opened in runtime, the tag values to be displayed are either
read from the archive or set to zero. This function is set in the "General" tab of the
"Properties" dialog.
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Time Jumps, Time Overlaps
 By changing the time, e.g. by switching from daylight saving to standard time or vice
versa, time jumps or time overlaps may occur in the archive.
When displaying a trend for archived values, the labelling of the time axis is modified and
marked with a vertical line should a time jump or time overlap be present. In the "Limit"
tab of the "Properties of WinCC Online Trend Control" dialog, the marker line can be
assigned a color.
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3.6 WinCC Online Trend Control

The "WinCC Online Trend Control" object is used for displaying process data as a trend.
Using the Online Trend Control gives you a high degree of flexibility during the
configuration, since the table window configuration is performed exclusively within the
Graphics Designer.
To make possible access to the tags which are to be displayed, they must be configured
either in the WinCC Explorer or in a process value archive.

3.6.1 Configuring the WinCC Online Trend Control

To display process values in runtime using the WinCC Online Trend Control, the following
steps must be performed:

In Tag Logging

1. Using the Archive Wizard, create a process value archive.

2. Configure the process value tags contained therein.

In Graphics Designer

3. Link the WinCC Online Trend Control to a Graphics Designer picture and edit the
properties of the ActiveX Control.
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3.6.1.1 Creating a Process Value Archive

A process value archive is created most easily with the help of the Archive Wizard. Start
the Wizard by selecting the Tag Logging editor, then selecting the "Archive Wizard..."
command in the pop-up menu for archives.

Allow the Wizard to create a process value archive. Specify which tags are to be included
in the archive either in the second step of the Wizard or, after creating the archive, by using
the "New Tag..." command in the archive’s pop-up menu.

Note

Additional information about configuring archives can be found in the Tag Logging
documentation.
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3.6.1.2 Configuring the Process Tags in the Process Value Archive

Provided that the process tags contained in an archive were not defined within the Archive
Wizard, new tags can be added by using the pop-up menu of a process value archive.

Note

Additional information about configuring archives can be found in the Tag Logging
documentation.



08.99 Configuring in Tag Logging

WinCC Manual 3-43
C79000-G8276-C160-01

3.6.1.3 Configuring the WinCC Online Trend Control in the Graphics
Designer

1. Inserting an ActiveX Control in a picture: Select the "Controls" tab from the object
palette, then select "WinCC Online Trend Control".

2. Draw an ActiveX Control of the desired size in the file window.

3. In the dialog for quick configuration of the Online Trend Control, you should enter a
window name and enable use of the toolbar, status bar and shared axes.
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In the "Elements" tab, you specify the appearance of the column pairs which are to be
displayed and link them to a process tag.

Note

If you double-click on the Online Trend Control while holding down the "CTRL" key, you
will see a preview of the Online Trend Control’s runtime appearance.
To return to the "normal view", click a surface outside of the control.
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3.6.1.4 Activating the Online Trend Control Example

Before activating the WinCC Online Trend Control example, you must:

Á Save the picture you have drawn.

Á Use the pop-up menu in the WinCC Explorer to set the stored picture as the start
picture.

Á Check whether "Graphics Runtime" and "Tag Logging Runtime" have been selected
in the Control Center’s "Startup" tab (in the Control Center, "Computer Properties"
dialog).

Note

Additional information about activating a project can be found in the WinCC Explorer
documentation.
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3.6.2 Properties Dialogs

3.6.2.1 Quick Configuration of the WinCC Online Trend Control

When drawing the WinCC Online Trend Control in a Graphics Designer picture, the dialog
for quick configuration of the control opens.

Box Description

Window Name The title of the trend window is defined here.

Display Ruler If the "Display Ruler" option is activated, the ruler for determining
coordinate values will automatically be displayed in the trend
window every time a picture change occurs in runtime.

Load Data from
Archive

Here, you specify whether the trend window should be filled with
archived values when a picture opens or whether only the current
values should be displayed.

Data Supply If the tag which is to be displayed is recorded in a process value
archive, you must select the "Archive Tags" setting.

If the tag which is to be displayed is an internal or an external tag that
is not recorded in a process value archive, you must select the
"Online Tag" setting.

Toolbar With the "Toolbar" option, you can specify whether the trend
window is to contain a toolbar in runtime.

Status Bar With the "Status Bar" option, you can specify whether the trend
window is to contain a status bar in runtime.
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Box Description

Write Direction With the "Write Direction" option, you specify where the current
measurement values are to be displayed. The "from the bottom"
setting specifies that the current measurement values are to be
displayed at the lower border of the trend window.

Staggered Trends If the "Display Trends Staggered" option is activated, the trends will
be displayed superimposed on each other in a trend window. For each
trend, the value range to be displayed can be set for the Y-axis.

Shared
X-Axis

If this option is activated, all trends in the trend window will use a
shared X-axis in runtime. The first element in the list of trend
window elements specifies the color and the value range of the axis.

Shared
Y-Axis

If this option is activated, all trends in the trend window will use a
shared Y-axis in runtime. The first element in the list of trend
window elements specifies the color and the value range of the axis.

Persistance If the option “Persistent in RT” is not activated, the changes made to
the settings will only be effective for the current picture. After a
picture change, the settings configured in CS will be used again.
If the option “Persistent in RT” is activated, the changes made to the
settings will remain until runtime is exited. If runtime is activated
again, the settings configured in CS will be used again.

Note

Changes made at a later time to the "Data Supply" setting result in a loss of all configured
links of the tags which are to be displayed in the trend window.
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In the "Elements" tab, you specify which tags are to be displayed and the appearance of the
trends.

Box Description

Trends Here, you set which trends are to be displayed.

Use the "+" and "-" buttons to add new or delete existing trends.

Use the "Up" and "Down" buttons to change the order of the trends in the
list. When using shared axes, the first element in the list determines the
color and the value range of the axes.

Name The name of the trend is set here. This name is used in the list of elements.

Display The appearance of the trend is set here.

With the "Visible" setting, you can suppress the display of configured
elements without deleting the elements.

With the "Color" button, you can use a selection dialog to set the color
with which the trend is to be displayed.

Selection of
Archives/Tags

Here, you can specify from which archive the tag which is to be linked in
the currently selected element originates. The entry can be made either
directly or by using the "Selection..." button.

Note

All entries in the dialog for quick configuration can be edited via the control properties.

In the dialog for server selection, which can be opened via the "Selection..." button in a
multi-client system, only those servers whose "packages" were loaded on the multi-client
are listed.
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3.6.2.2 Properties of the WinCC Online Trend Control

The properties of an ActiveX Control can be changed by right-clicking on the object and
selecting the "Properties" entry from its pop-up menu.
In the displayed "Object Properties" dialog, select the "Control Properties" entry from the
"Properties" tab.

Note

A complete description of all properties of the WinCC Online Trend Control can be found
in the online help.

You can also double-click on the object to open a dialog box in which the attributes of the
WinCC Online Trend Control can also be set.
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Curves Tab
In the "Elements" tab, you specify which tags are to be displayed and the appearance of the
trends.

Box Description

Trends Here, you set which trends are to be displayed.

Use the "+" and "-" buttons to add new or delete existing trends.

Use the "Up" and "Down" buttons to change the order of the trends
in the list. When using shared axes, the first element in the list
determines the color and the value range of the axes.

Name The name of the trend is set here. This name is used in the list of
elements.

Display The appearance of the trend is set here.

With the "Visible" setting, you can suppress the display of
configured elements without deleting the elements.

With the "Color" button, you can use a selection dialog to set the
color with which the trend is to be displayed.

Selection of
Archives/Tags

Here, you can specify from which archive the tag which is to be
linked in the currently selected element originates. The entry can be
made either directly or by using the "Selection..." button.

Note

In the dialog for server selection, which can be opened via the "Selection..." button in a
multi-client system, only those servers whose "packages" were loaded on the multi-client
are listed.
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General Tab
In the "General" Tab, you define the general appearance and behavior of the trend window.

Box Description

Window Name The title of the trend window is defined here.

Display Ruler If the "Display Ruler" option is activated, the ruler for determining
coordinate values will automatically be displayed in the trend
window every time a picture change occurs in runtime.

Load Data from
Archive

Here, you specify whether the trend window should be filled with
archived values when a picture opens or whether only the current
values should be displayed.

Data Supply If the tag which is to be displayed is recorded in a process value
archive, you must select the "Archive Tags" setting.

If the tag which is to be displayed is an internal or an external tag that
is not recorded in a process value archive, you must select the
"Online Tag" setting.

Toolbar With the "Toolbar" option, you can specify whether the trend
window is to contain a toolbar in runtime.

Status Bar With the "Status Bar" option, you can specify whether the trend
window is to contain a status bar in runtime.

Write Direction With the "Write Direction" option, you specify where the current
measurement values are to be displayed. The "from the bottom"
setting specifies that the current measurement values are to be
displayed at the lower border of the trend window.
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Box Description

Staggered Trends If the "Display Trends Staggered" option is activated, the trends will
be displayed superimposed on each other in a trend window. For each
trend, the value range to be displayed can be set for the Y-axis.

Shared
X-Axis

If this option is activated, all trends in the trend window will use a
shared X-axis in runtime. The first element in the list of trend
window elements specifies the color and the value range of the axis.

Shared
Y-Axis

If this option is activated, all trends in the trend window will use a
shared Y-axis in runtime. The first element in the list of trend
window elements specifies the color and the value range of the axis.

Persistance If the option “Persistent in RT” is not activated, the changes made to
the settings will only be effective for the current picture. After a
picture change, the settings configured in CS will be used again.
If the option “Persistent in RT” is activated, the changes made to the
settings will remain until runtime is exited. If runtime is activated
again, the settings configured in CS will be used again.

Note

Changes made at a later time to the "Data Supply" setting result in a loss of all configured
links of the tags which are to be displayed in the trend window.

If you select as write direction either "from the top" or "from the bottom", you should use
True-Type fonts within the trend window to ensure a clean display of the time axis
labelling.

Font Tab
In the "Font" tab, you set the font to be used in the trend window.

Box Description

Font Here, you specify the name of the font which is to be used.

Size Here, you set the size of the selected font.

Effects Here, you set the font style for the selected font (e.g. bold, italic,
underline).

Sample Text Displayed here is a preview of the settings you have made.

Note

If you select as write direction either "from the top" or "from the bottom", you should use
True-Type fonts within the trend window to ensure a clean display of the time axis
labelling.
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Toolbar Tab
In the "Toolbar" tab, you set the positioning of the toolbar in the trend window and the
number of buttons to be displayed.

Box Description

Display Toolbar The table window can be operated via the buttons in the toolbar.

Alignment The toolbar is always displayed at the top border of the trend
window.

Keyboard Functions With the check boxes, you can specify which buttons are to be
displayed in the toolbar. With the "All Keyboard Functions"
option, you can specify that all available buttons are to be
displayed in the toolbar.

Key/Key Combination In this dialog, you can assign a keyboard shortcut to the button
function selected in the selection window.

Note

The "First data record", "Previous data record", "Next data record" and "Last data record"
buttons can only be selected when the tag to be displayed comes from a process value
archive.
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Time Axis Tab
Changes to the X-axis (X-axes) of the trends to be displayed are made in the "Time Axis"
tab. If a shared X-axis has been selected in the "General" tab, the current settings of the axis
will be displayed for all trends. Changes can only be made, however, if the first trend of the
trend window is selected.
Information on other options related to the displayed time range of a trend, i.e. the settings
"Autorange", "Update", Start Time", "End Time", "Time Range", can be found in the "Time
Range of a Trend Display" section of this manual.

Box Description

Trend The selection box can be used to select all trends configured in the
"Elements" tab.

Label Here, you set the labelling for the time axis.
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Box Description

Time Selection The time interval to be displayed in the trend window can be set

Á by entering a start time and an end time ("Time Range" and
"Number of measurement points" settings not activated).

Á by entering a start time and a time range. ("Time Range"
setting activated and "Number of measurement points" setting
not activated). The length of the time interval to be displayed is
determined by multiplying the "Factor" by the "Range".

Á by entering a start time and by specifying the number of
measurement points to be displayed ("Time Range" setting
activated and "Number of measurement points" setting not
activated).

Depending on how the "Update" option is set, values entered here
are interpreted as either absolute values for static display or as
relative values for dynamic display.

Display With the "Coarse Scaling" and "Fine Scaling" settings, you can
specify that either large or small tick marks be displayed along the
time axis.

Update If the "Update" option is activated, entries made under time
selection are interpreted as relative values for dynamic display of
trends.

If the "Update" option is not activated, entries made under time
selection are interpreted as absolute values for the static display of
trends.

Note

If a shared axis has been set in the "General" tab, the settings of this dialog can only be
edited for the first trend to be displayed.



Configuring in Tag Logging 08.99

3-56 WinCC Manual
C79000-G8276-C160-01

Value Axis Tab
Changes to the Y-axis (Y-axes) of the trends to be displayed are made in the "Value Axis"
tab. If a shared Y-axis has been selected in the "General" tab, the current settings of the axis
will be displayed for all trends. Changes can only be made, however, if the first trend of the
trend window is selected.
Additional information on trend display types can be found in the "Trend Display Types"
section of the manual.

Box Description

Trend The selection box can be used to select all trends configured in the
"Elements" tab.

Label Here, you set the labelling for the value axis.

Coarse Scaling If this option is activated, the Y-axis is subdivided into major scale
segments. The distance between two major scales can be set.

If not all major scale segments can be discerned in runtime, the
trend window is too small for the selected scale.

Fine Scaling If this option is activated, the Y-axis is subdivided into minor scale
segments. The distance between two minor scales can be set.

If not all minor scale segments can be discerned in runtime, the
trend window is too small for the selected scale.

Grid Lines Here, you can specify whether grid lines should be inserted in the
trend display parallel to the X-axis. The distance between two grid
lines can be set.

Display Decimal
Places

Here, you specify how many decimal places are entered in a scale
entry.
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Box Description

Range Selection If the "Automatic Range Selection" option is selected, the trend will
fit optimally into the selected trend window. If a shared Y-axis has
been selected from the "General" tab, the value range of the Y-axis
will be determined by the minimum and maximum values of all
trends in the trend window.

If the "Automatic" option is not activated, you can specify a fixed
value range by entering the minimum and maximum values which
are to be displayed.

Display Type Here, you select the trend type which is to be used to display the
course of a tag. You can select from the following:

Á Points connected by lines

Á Stepped trend

Á Display points only

Á Fill, interpolated trend

Á Fill, stepped trend

Note

If a shared axis has been set in the "General" tab, the settings of this dialog can only be
edited for the first trend to be displayed.
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Limit Tab
In the "Limit" tab, settings are made for the colored markings of limit value violations, time
jumps, and time overlaps, as well as for substitute values.

Box Description

Trend The selection box can be used to select all trends configured in the
"Elements" tab.

Low Limit Value Here, you can set the color in which trend values that are smaller
than their set lower limit value are to be displayed.

The limit value is entered as a floating point number. The color in
which all measurement values having a value less than the specifed
limit value are to be displayed can be selected with the "Color..."
button. The preview window displays your color selection.

High Limit Value Here, you can set the color in which trend values that are greater
than their set upper limit value are to be displayed.

The limit value is entered as a floating point number. The color in
which all measurement values having a value greater than the
specifed limit value are to be displayed can be selected with the
"Color..." button. Your color selection is displayed in the preview
window.

Time Overlap A time overlap in the trend window can be indicated by a vertical
line.

The "Color..." button allows you to select a color for the vertical
line. Your color selection is displayed in the preview window.
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Box Description

Time Jump A time jump in the trend window can be indicated by a vertical line.

The "Color..." button allows you to select a color for the vertical
line. Your color selection is displayed in the preview window.

Subs. Value If a measurement value is replaced by a set substitute value, this
action will be indicated by a rectangle surrounding the
measurement point.

The "Color..." button allows you to select a color for the rectangle.
Your color selection is displayed in the preview window.

3.6.3 Operating the Online Trend Control in Runtime

3.6.3.1 The WinCC Online Trend Control Toolbar

Icon Description

F1 "Online-Help System"

Calls up the online-help

F2 "Open the Configuration Dialog"

Select the dialog for configuring the display.

F3 "First Data Record "

After activating the button, the course of a tag within the set time
range is displayed. The display starts with the first archived value.

F4 "Previous Data Record"

After activating the button, the course of a tag within the previous
time range is displayed. The display starts with the currently set time
interval.

F5 "Next Data Record"

After activating the button, the course of a tag within the following
time range is displayed. The display starts with the currently set time
interval.

F6 "Last Data Record"

After activating the button, the course of a tag within the set time
range is displayed. The display ends with the last archived value.

F7 "Display Value at this Position"

With this function, you can determine the coordinate points of a trend.

F8 "Enlarge Area"

With the enlarge area function, you can enlarge any area of the trend
window.

F9 "Activate Original View"

With this button, you can return to the configured normal view from
an enlarged trend display.

"Dialog for the Archive and Tag Selection"

With this button, you open a dialog to select archives and tags.
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Icon Description

"Dialog for Selecting Trends"

With this button, you open a dialog for making trends
visible/invisible.

"Select Time Range"

With this button, you open a dialog to set the time range displayed in
the trend window.

"Previous Trend to the Front"

With this button, you can display a different trend in the foreground of
the trend window.

"Next Trend to the Front"

With this button, you can display a different trend in the foreground of
the trend window.

F10 "Start/Stop the Update"

Stops the updated display. The values are stored in a clipboard and
reentered after activating the button again.

F10 "Start/Stop the Update"

Resumes the display.

Note

The buttons for "scrolling" in archives are only available when the trend which is to be
displayed originated in a process value archive.
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Displaying Archived Values
The buttons in the toolbar of a trend window, or the corresponding keyboard shortcuts,
allow you to "scroll" through an archive.
The trend window will display the archived values of a tag within a time interval. The
width of this interval is determined by the time range to be displayed or results from the
time difference of entered start and end times.

In the trend window, the course of a tag within the set time range, beginning with the first
archived value, will be displayed.

In the trend window, the course of a tag within the previous time interval, starting with the
currently displayed time interval, will be displayed.

In the trend window, the course of a tag within the next time interval, starting with the
currently displayed time interval, will be displayed.

In the trend window, the course of a tag within the set time range, ending with the last
archived value, will be displayed.

Note

The buttons for "scrolling" in archives are only available when the trend which is to be
displayed originated in a process value archive.

Display in Front
When using shared axes, the axes set for the first trend are used in the display. The order of

the trends can be changed either in the toolbar via the dialog for trend selection (

button) or via the  and  buttons.
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Determining Coordinate Points
With the "Display Value at this Position" function, you can query the coordinates of the
measurement points of a trend.

After activating the  button, a vertical line - the ruler - is displayed. Below the trend
window, the X- and Y-coordinates of the measurement value are displayed in addition to
the archive and tag names.

Other measurement values can be determined by positioning the mouse pointer on the ruler
and moving it - while keeping the left mouse button pressed - to the desired position.

Enlarged Display in the Trend Window
To enlarge the display of a trend segment, use the "Enlarge Area" button or the
corresponding keyboard shortcut.
The trend display is stopped. You can highlight the area to be enlarged by holding down the
left mouse button and dragging a border around it. If the highlighted area contains at least
two measurement values, the selected trend area will be displayed in the trend window.
The coordinate points of a trend also can be determined with the “Display Value at this
Position” function within the enlarged display.

To return to the updated trend display, activate the  button again and then use the
"Start/Stop the Update" function to activate the updated trend display. For the value ranges
of the X- and Y-axes, the preset values will automatically be used.

The enlarged trend display can be exited via the "Activate Original View" function. The
trends will then be displayed again with the preset values of the X- and Y-axes value
ranges.
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3.6.3.2 Configuration Dialogs in Runtime

The display of tag values in runtime can be influenced by several dialogs. These dialogs
can either be called up via the toolbar buttons of the trend window or via keyboard
shortcuts.

The operation of the "Configuration" dialog corresponds to that of the "Properties of the
Online Trend Control" dialog in the configuration system. The "Configuration" dialog can
be accessed via the "Open the Configuration Dialog" button. All essential settings for the
trend display can be made in this dialog.

The "Dialog for the Archive and Tag Selection" button calls up a dialog for setting the tags
that are linked to the trends of a trend window.

Box Description

Element Here, you can select one of the configured trends.

Selection Use the "Selection" button to open the dialog for
selecting an archive and the tags contained therein.

Persistance If the option “Persistent in RT” is not activated, the
changes made to the settings will only be effective for
the current picture. After a picture change, the settings
configured in CS will be used again.
If the option “Persistent in RT” is activated, the
changes made to the settings will remain until runtime
is exited. If runtime is activated again, the settings
configured in CS will be used again.
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Use the "Dialog for Selecting Trends" button to open a dialog via which trends can be made
visible/invisible.

Box Description

Trend to the Front If shared axes are used, the settings for the first trend
will be used for the display. The first trend can be
changed either in this dialog or by using the "Previous
Trend to the Front" and "Next Trend to the Front"
buttons in the toolbar.

Trend
Visible/Invisible

In this area, you can specify which configured trends
are not to be displayed.

Persistance If the option “Persistent in RT” is not activated, the
changes made to the settings will only be effective for
the current picture. After a picture change, the settings
configured in CS will be used again.
If the option “Persistent in RT” is activated, the
changes made to the settings will remain until runtime
is exited. If runtime is activated again, the settings
configured in CS will be used again.

Note

The first trend of a trend window cannot take the "invisible" attribute.
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The "Select Time Range" button opens a dialog for specifying the time range to be
displayed. If the trends of a trend window are to be displayed with a shared X-axis, the
specified time range will apply to all trends.

Box Description

Element Here, you can select one of the configured trends.

Time Selection The time interval to be displayed in the trend window
can be set

Á by entering a start time and an end time ("Time
Range" setting not activated).

Á by entering a start time and a time range. ("Time
Range" setting activated). The length of the time
interval to be displayed is determined by
multiplying the "Factor" by the "Range".

Persistance If the option “Persistent in RT” is not activated, the
changes made to the settings will only be effective for
the current picture. After a picture change, the settings
configured in CS will be used again.
If the option “Persistent in RT” is activated, the
changes made to the settings will remain until runtime
is exited. If runtime is activated again, the settings
configured in CS will be used again.

The entry format of the date and time is dependent on the runtime language used.
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3.7 Displaying Process Values in Tables

WinCC gives you the ability to display tag values in a table format.

The display of the tag values takes place in runtime in an ActiveX Control. This ActiveX
Control has to be created in the "Graphics Designer" and be linked to the process value
archive configured in "Tag Logging".

3.7.1 Table Display Types
Two basic display types are available for displaying tag values in table form.

Shared Time Column
In this display type, the table contains only one time column. This column displays the
archived times of the tag output in the first column. A table in which the values of three
tags are to be displayed consists of four columns in runtime.

Note

The display of tags with different acquisition times in a table with a shared time column is
problematic, since the tag values might not correspond to the indicated archived times of
the time column. Such a configuration can, however, still be set up and is not prevented by
the "Tag Logging" editor.

Separate Time Columns
In this display type, the archived times of each tag are displayed in a separate column. A
table in which the values of three tags are to be displayed consists of six columns in
runtime.

The display type to be used is specified in the "General" tab of the "Properties" dialog of
the "WinCC Online Table Control".
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3.7.2 Time Range of a Trend Display
The table display of tags, in regard to the time ranges to be displayed, can take place in
several ways:

Static Display
This display type displays the archived values of a tag within a set time interval.

The static display type is configured in the "Column" tab of the "Properties" dialog of the
"WinCC Online Table Control" by deactivating the "Update" option. The time range to be
displayed is set either by specifying a start and end time or by specifying a start time and a
time range.

Dynamic Display
In this display type, the end time of a table always corresponds to the current system time.
New measurement values coming in will be included in the table.
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The dynamic display type is configured in the "Column" tab of the "Properties" dialog of
the "WinCC Online Table Control" by activating the "Update" option. The time range to be
displayed is set either

− by specifying a time range, or

− by the time difference between the specified start and end times.

Note

Depending on the setting, the tag values to be displayed are either read from the archive or
set to zero when runtime is started.
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3.8 WinCC Online Table Control

The "WinCC Online Table Control" object is used for displaying process data as a table.
Use of the Table Control gives you a high degree of flexibility during the configuration,
since the table window configuration is performed exclusively within the Graphics
Designer.
To make possible access to the tags which are to be displayed, process value archives and
the tags contained therein must be configured in Tag Logging.

3.8.1 Configuring the WinCC Table Control

To display process values in runtime using the WinCC Online Table Control, the following
steps must be performed:

In Tag Logging

1. Using the Archive Wizard, create a process value archive.

2. Configure the process value tags contained therein.

In Graphics Designer

3. Link the WinCC Table Control to a Graphics Designer picture.

4. Link the columns to be displayed in the Table Control to the tags of the process value
archive.

Note

The table window can be influenced via standard functions. If you do not wish to use the
toolbar functions to operate the table window, any Graphics Designer objects can be made
dynamic using the appropriate functions.
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3.8.1.1 Creating a Process Value Archive

A process value archive is created most easily with the help of the Archive Wizard. Start
the Wizard by selecting the Tag Logging editor, then selecting the "Archive Wizard..."
command in the pop-up menu for archives.

Allow the Wizard to create a process value archive. Specify which tags are to be included
in the archive either in the second step of the Wizard or, after creating the archive, by using
the "New Tag..." command in the archive’s pop-up menu.

Note

Additional information about configuring archives can be found in the Tag Logging
documentation.
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3.8.1.2 Configuring the Process Tags in the Process Value Archive

Provided that the process tags contained in an archive were not defined within the Archive
Wizard, new tags can be added by using the pop-up menu of a process value archive.

Note

Additional information about configuring archives can be found in the Tag Logging
documentation.

3.8.1.3 Configuring the WinCC Table Control in the Graphics Designer

2. Inserting an ActiveX Control in a picture: Select the "Controls" tab from the object
palette, then select "WinCC Table Control".

2. Draw an ActiveX Control of the desired size in the file window.

3. In the dialog for quick configuration of the Table Control, you should enter a window
name and enable use of the toolbar and status bar.
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In the "Columns" tab, you specify the appearance of the column pairs which are to be
displayed and link them to a process tag.

Note

If you double-click on the Table Control while holding down the "CTRL" key, you will see
a preview of the Table Control’s runtime appearance.
To return to the "normal view", click a surface outside of the control.



08.99 Configuring in Tag Logging

WinCC Manual 3-73
C79000-G8276-C160-01

3.8.1.4 Activating the Table Control Example

Before activating the WinCC Table Control example, you must:

Á Save the picture you have drawn.

Á Use the pop-up menu in the WinCC Explorer to set the stored picture as the start
picture.

Á Check whether "Graphics Runtime" and "Tag Logging Runtime" have been selected
in the Control Center’s "Startup" tab (Control Center, "Computer Properties" dialog).

Note

Additional information about activating a project can be found in the Control Center
documentation.
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3.8.2 Properties Dialogs

3.8.2.1 Quick Configuration of the WinCC Table Control

When drawing the WinCC Table Control in a Graphics Designer picture, a dialog for quick
configuration of the control opens.

Box Description

Window Name The title of the table window is defined here.

Open Picture Here, you specify whether the table window should be filled with
archived values when a picture opens or whether only the current
values should be displayed.

Display With the options "Toolbar" and "Status Bar", you can specify
whether the table window is to contain a toolbar and a status bar in
runtime.

Every column containing data of a tag also possesses a column with
the acquisition times of a measurement value. Use the "Shared
Selection" option to specify whether all columns of a table are to
use a shared time column.

Persistance If the option “Persistent in RT” is not activated, the changes made
to the settings will only be effective for the current picture. After a
picture change, the settings configured in CS will be used again.
If the option “Persistent in RT” is activated, the changes made to
the settings will remain until runtime is exited. If runtime is
activated again, the settings configured in CS will be used again.
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In the "Elements" tab, you specify the number of columns or column pairs to be displayed
in the table window and the appearance of these columns. An element always consists of
two columns. One contains the data of a tag, and one contains the corresponding acquisition
times of the measurement values. Use the "Shared Time Column" setting in the "General"
tab to specify that a shared time column be used for all data columns of the table window.

Box Description

Column Here, you specify the columns or column pairs that are to be
displayed in the table window.

Use the "+" and "-" buttons to add new or delete existing elements.

Use the "Up" and "Down" buttons to change the order of the columns
in the list, thereby also changing their order in the table window. An
element displayed at the top of the list is displayed on the left border
of the table window.

Name Here, you specify the name of the column or column pair. The name
is used in the list of elements and in the header line of the table.

Display Here, you define the appearance of the column or column pair.

With the "Visible" setting, you can suppress the display of configured
elements without deleting the elements.

With the "Color" button, you can open a selection dialog to select the
color with which the value of the element is to be displayed in the
table window.

Selection of
Archives/Tags

Here, you can specify from which archive the tag which is to be
displayed in the currently selected element originates. The entry can
be made either directly or by using the "Selection..." button.
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Note

All entries in the dialog for quick configuration can be edited via the control properties.

In the dialog for server selection, which can be opened via the "Selection..." button in a
multi-client system, only those servers whose "packages" were loaded on the multi-client
are listed.

3.8.2.2 Properties of the WinCC Table Control

The properties of an ActiveX Control can be changed by right-clicking on the object and
selecting the "Properties" entry from its pop-up menu.
In the displayed "Object Properties" dialog, select the "Control Properties" entry from the
"Properties" tab.

Note

A complete description of all properties of the WinCC Table Control can be found in the
online help.

Alternatively, you can double-click on the object to open a dialog box in which the
attributes of the WinCC Table Control can also be set.
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Columns Tab
In the "Columns" tab, you specify the number of columns or column pairs to be displayed
in the table window and the appearance of these columns. An element always consists of
two columns. One contains the data of a tag, and one contains the corresponding acquisition
times of the measurement values. Use the "Shared Time Column" setting in the "General"
tab to specify that a shared time column be used for all data columns of the table window.

Box Description

Elements Here, you specify the columns or column pairs that are to be
displayed in the table window.

Use the "+" and "-" buttons to add new or delete existing elements.

Use the "Up" and "Down" buttons to change the order of the columns
in the list, thereby also changing their order in the table window. An
element displayed at the top of the list is displayed on the left border
of the table window.

Name Here, you specify the name of the column or column pair. The name
is used in the list of elements and in the header line of the table.

Display Here, you define the appearance of the column or column pair.

With the "Visible" setting, you can suppress the display of configured
elements without deleting the elements.

With the "Color" button, you can open a selection dialog to select the
color with which the element is to be displayed in the table window.

Selection of
Archives/Tags

Here, you can specify from which archive the tag which is to be
displayed in the currently selected element originates. The entry can
be made either directly or by using the "Selection..." button.



Configuring in Tag Logging 08.99

3-78 WinCC Manual
C79000-G8276-C160-01

General Tab
In the "General" Tab, you define the general appearance and behavior of the table window.

Box Description

Window Title The title of the table window is defined here.

Open Picture Here, you specify whether the table window should be filled with
archived values when a picture opens or whether only the current
values should be displayed.

Display With the options "Toolbar" and "Status Bar", you can specify
whether the table window is to contain a toolbar and a status bar
in runtime.

Every column containing data of a tag also possesses a column
with the acquisition times of a measurement value. Use the
"Shared Selection" option to specify whether all columns of a
table are to use a shared time column.
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Font Tab
In the "Font" tab, you set the font to be used in the table window.

Box Description

Font Here, you specify the name of the font which is to be used.

Size Here, you set the size of the selected font.

Effects Here, you set the font style for the selected font (e.g. bold, italic,
underline).

Sample Text Displayed here is a preview of the settings you have made.
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Toolbar Tab
In the "Toolbar" tab, you set the positioning of the toolbar in the table window and the
number of buttons to be displayed.

Box Description

Display Toolbar The table window can be operated via the buttons in the toolbar.

Alignment Depending on the settings made here, the toolbar is displayed
either in the upper or lower border of the table window.

Keyboard Functions With the check boxes, you can specify which buttons are to be
displayed in the toolbar. With the "All Keyboard Functions"
selection, you can specify that all available buttons be displayed
in the toolbar.

Key/Key Combination In this dialog, you can assign a keyboard shortcut to the button
function selected in the selection window.
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Column Tab

Box Description

Column The selection box can be used to select all columns configured in
the "Elements" tab.

Time Display If the "Update" option is not activated, the tag values are displayed
statically. The time interval to be displayed in the table window is
defined by the values entered in the "Selection of Time" area.
If the "Update" option is activated, the tag values are displayed
dynamically. The values entered in the "Selection of Time" area
define a time interval. The table window will display this time
interval, starting with the current time.
With the "Left", "Centered", and "Right" option buttons, you
specify whether the time is to be displayed in the column left
justified, right justified, or centered.

Value Display In the "Decimal places" area, you can set the accuracy with which
the values are to be displayed. Up to 16 decimal places can be
displayed.
With the "Left", "Centered", and "Right" option buttons, you
specify whether the time is to be displayed in the column left
justified, right justified, or centered.
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Box Description

Time Selection The time interval to be displayed in the table window can be set

Á by entering a start time and an end time ("Time Range" setting
not activated).

Á by entering a start time and an end time ("Time Range" setting
not activated). The time range is determined by multiplying the
"Factor" and "Range" values.

3.8.3 Operating the Table Control in Runtime

3.8.3.1 The WinCC Online Table Control Toolbar

Icon Description

F1 "Online-Help System"

Calls up the online-help

F2 "Open the Configuration Dialog"

Select the dialog for configuring the display.

F3 "First Data Record "

With this button, a selected archived value can be displayed while
the display is stopped.

F4 "Previous Data Record"

With this button, a selected archived value can be displayed while
the display is stopped.

F5 "Next Data Record"

With this button, a selected archived value can be displayed while
the display is stopped.

F6 "Last Data Record"

With this button, a selected archived value can be displayed while
the display is stopped.

F7 "Edit"

After activating this button, double click on any table field to edit its
contents. For this, the current display will be stopped.

"Dialog for the Archive and Tag Selection"

With this button, you open a dialog to select archives and tags.

"Dialog for Selecting Columns"

This button opens a dialog for making columns visible/invisible.

"Select Time Range"

This button opens a dialog to set the time range displayed in the
trend window.
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Icon Description

"Previous Column to the Front"

This button allows you to display the current last column of the table
window as the first data column of the table. The corresponding
archived times will be displayed in the time column if a shared time
column has been selected.

"Next Column to the Front"

This button allows you to display the next column of the table
window as the first data column of the table. The corresponding
archived times will be displayed in the time column if a shared time
column has been selected.

F10 "Start/Stop the Update"

Stops the updated display. The values are stored in the clipboard and
reentered after activating the button again.

F10 "Start/Stop the Update"

Resumes the display.

Displaying Archived Values
The buttons in the toolbar of a table window, or the corresponding keyboard shortcuts,
allow you to "scroll" through an archive.
The table window displays the archived values of a tag within a time interval. The width of
this interval is determined by the time range to be displayed or results from the time
difference of entered start and stop times.

In the table window, the tag values within the set time range, beginning with the first
archived value, will be displayed.

In the table window, the tag values within the previous time interval, starting with the
currently displayed time interval, will be displayed.

In the table window, the tag values within the following time interval, starting with the
currently displayed time interval, will be displayed.

In the table window, the tag values within the set time range, ending with the last archived
value, will be displayed.
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Display in Front
If a shared time column is used, the archived times of the first column of the table will be
displayed in the time column.
The order of the columns in the table window can be changed either in the toolbar via the

dialog for column selection (  button) or via the buttons  and .

Edit 
With the "Edit" function you can manually enter lab or correction values in a process value
archive.
When you activate the function, the display of the table stops. Double click on any box in
the table to change the contents of that box. Values that occur during the edit process are
archived.

Note

You can view the values that occur during an edit process by means of a static display
("Update" function in the "Properties" - "General" dialog).
If the time stamp is changed through editing in a shared selection, the new value will only
be written into the first column of the database. The time stamp in the other columns will
remain the same.
Return to the table display in runtime mode by clicking on the "Edit" button again.

3.8.4 Configuration Dialogs in Runtime

The display of tag values in runtime can be influenced by several dialogs. These dialogs
can either be called up via the toolbar buttons of the trend window or via keyboard
shortcuts.

The operation of the "Configuration" dialog corresponds to that of the "Properties of the
Table Control" dialog in the configuration system. The "Configuration" dialog can be
accessed via the "Open the Configuration Dialog" button. All essential settings for the table
display can be made in this dialog.
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The "Dialog for the Archive and Tag Selection" button calls up a dialog for setting the tags
that are linked to the columns of a table window.

Box Description

Element Here, you can select one of the configured column
pairs.

Selection Use the "Selection" button to open the dialog for
selecting an archive and the tags contained therein.

Persistance If the option “Persistent in RT” is not activated, the
changes made to the settings will only be effective for
the current picture. After a picture change, the settings
configured in CS will be used again.
If the option “Persistent in RT” is activated, the
changes made to the settings will remain until runtime
is exited. If runtime is activated again, the settings
configured in CS will be used again.
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Use the "Dialog for Selecting Columns" button to open a dialog via which columns can be
made visible/invisible.

Box Description

Column in Front If a shared time column is used, the archived times of
the first column of the table will be displayed. The
first column can be changed either in this dialog or by
using the "Previous Column to the Front" and "Next
Column to the Front" buttons in the toolbar.

Column On/Off In this area, you can specify which configured column
pairs are not to be displayed.

Persistance If the option “Persistent in RT” is not activated, the
changes made to the settings will only be effective for
the current picture. After a picture change, the settings
configured in CS will be used again.
If the option “Persistent in RT” is activated, the
changes made to the settings will remain until runtime
is exited. If runtime is activated again, the settings
configured in CS will be used again.

Note

The first column of a table window cannot take the "invisible" attribute.
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The "Select Time Range" button opens a dialog for specifying the time range to be
displayed. If the columns are to be displayed with a shared time column, the indicated time
range will be valid for all columns.

Box Description

Element Here, you can select one of the configured columns.

Time Selection The time interval to be displayed in the table window
can be set

Á by entering a start time and an end time ("Time
Range" setting not activated).

Á by entering a start time and a time range. ("Time
Range" setting activated). The length of the time
interval to be displayed is determined by
multiplying the "Factor" by the "Range".

Persistance If the option “Persistent in RT” is not activated, the
changes made to the settings will only be effective for
the current picture. After a picture change, the settings
configured in CS will be used again.
If the option “Persistent in RT” is activated, the
changes made to the settings will remain until runtime
is exited. If runtime is activated again, the settings
configured in CS will be used again.

The entry format of the date and time is dependent on the runtime language used.
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4 Appendix

4.1 Structure of a Raw Data Tag

Telegram Header Telegram Footer with Block Status Word
Time Information, Measurement Area, Measured Values, ...

A message frame for the transfer of a raw data tag consists of two parts: a header and a
footer.

Message Frame Header
The header contains general data, i.e. length of the message frame. The highbyte of
dataword 0 is not used by the system and can, therefore, be used by the user.

Lowbyte: Number of Blocks
Highbyte: Type of Blocks

Lowbyte: CPU - Nr.
Highbyte: AG - Nr.

Bit 0 - 8: Length of Block

Dataword 0 Dataword 1 Dataword 2

Bit 9 - 15: reserved

Message Frame Footer
In the block status word, the format of the measurement values and the format of the
measurement areas, among other things, are defined. Bit 10 is reserved and will be used in
future versions for switching daylight saving and standard times (daylight saving time = 1).

015

Measurement area of the tag present
Unit of tag present

Status wordof the tagpresent

reserved for switching thesummer/winter time

Measured Value Format 00 - BCD, 16 Bit
01 - BCD, 32 Bit
10 - Integer, 32 Bit
11 - Floating Point, 32 Bit

Time and date are structured in accordance with the definition of the sequential time
indication.

Bit 0 - 5: Minutes
Bit 6 - 10: Hours

Bit 0 -6: Milliseconds, in 10 ms increments
Bit 7 - 12: Seconds

Bit 0 - 4: Day

Dataword 2 Dataword 1 Dataword 0

Bit 5 - 8: Month
Bit 9 - 15: Year, (1990 - 2117)
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To transfer a measurement area, 8 data words are necessary. In these words, the upper and
lower limits of the tag and the archive are specified.

Dataword 1, 2 Dataword 7, 8Dataword 5, 6Dataword 3, 4

Upper Limit Archive

Upper Limit Tag
Lower Limit Archive

Lower Limit Tag

The following shows sample message frame structures.

Type 1
Measurement Value of a Process Variable + Date and Time

1 Word

1 Word
1 Word Tag Number

Block Status

2 Words Measured Value

optional, depending on the contents
of the block status word

Tag Status Word
Unit
Measurement Area

3 Words

3 Words Date / Time

8 Words

Type 2
n Measurement Values of a Process Variable + Date and Time of Each Measured Value

1 Word

1 Word
1 Word
1 Word

Number n of Measured Values

Tag number
Block status

2 sWord Measured Value

n blocks

optional, depending of the contents
of the block status word

Tag Status Word

Unit
Measurement Area

3 sWord
3 sWord Date / Time

8 Words
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Type 3
n Measurement Values of a Process Variable + Date/Time and Sample Cycle

1 Word

1 Word

1 Word
1 Word

Number n of the Measured Values

Tag Number
Block Status

2 Words

2 Words

Measured Value

Sample Cycle in ms

n Blocks

optional, depending on the contents
of the block status word

Tag Status Word

Unit
Measurement Area

3 Words

3 Words Date / Time

8 Words

Type 4
n Measurement Values of Various Process Variables with Date/Time

1 Word

1 Word

1 Word
1 Word

Number n of Measured Values
Tag Number
Block Status

2 Words Measured Value

n Blocks

optional, depending on the contents
of the block status word

Tag Status Word
Unit
Measurement Area

3 Words

3 Words Date / Time

8 Words

Type 5
n Measurement Values of Various Process Variables without Date and Time

1 Word

1 Word

1 Word
1 Word

Number n of Measured Values
Tag Number
Block Status

2 Words Measured Value

n Blocks

optional, depending on the contents
of the block status word

Tag Status Word
Unit
Measurement Area

3 Words
8 Words
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4.2 Templates for Function Calls

There are several dialogs in the Tag Logging Configuration System that allow you to set
actions that will be executed if certain events occur. Actions developed in the "Global
Script" editor must comply with the nomenclature specifications of the corresponding
template.

Note
For description of the templates see online help.

4.3 Diagnostic Tags of Tag Logging Runtime

Tag Logging contains several diagnostic tags that allow you to take measures against
critical situations, e.g. react to overflowing database queues by locking individual archives
or tags.
Diagnostic tags are created as internal tags in the Control Center and are contained in the
tag group "TagLoggingRT".

- @TLGRT_SIZEOF_DATABASE_QUEUE
This tag contains the current number of entries in the database queue. All database and
main memory archives that are recorded cyclic, cyclic-selective, or acyclic by Tag Logging
Runtime, are archived via this queue.

- @TLGRT_SIZEOF_NOTIFY_QUEUE
This tag contains the current number of entries in the ClientNotify queue. All local client
windows (trends/tables) receive current data via this queue.

- @TLGRT_SIZEOF_DBASE_QUEUE
This tag contains the current number of entries in the dBase queue. Continuous archives are
archived in a dBase III format via this queue.

4.4 Meaning of the Archived-Value Flags

Tag Logging sets a flag for each value written in the archive. These flags provide
information about the state of the tags.
These flags are represented as a 2-word value which is decimal coded and is stored in the
third column of the TagLogging archive of the database. To analyze the flags, the value
must be converted to its hexadecimal value. Here, the "left" word of the flag refers to the
data manager, while the "right" word refers to the status flag from Tag Logging.

Hinweis
You will find a list of the WinCC Status Flags in the online help.
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1 Functionality of the Text Library
Use the "Text Library" editor to edit texts which are used by the various modules in the
runtime system.

Use the "Parameter" tab of the "Computer Properties" dialog in the Control Center to
specify in which language texts are to be output in the runtime system. In the Text Library,
you can define the foreign-language output texts for many configured texts. Some
configurable text, such as tooltips for graphic objects, are, however, not managed by the
Text Library.

All changes that you make are accepted and stored in the database when the given box is
exited!

1.1 Structure of the Text Library

The Text Library is structured as a table. The text IDs entered in the first column are
assigned to the texts to be used in runtime which are contained in the various language
columns.
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1.2 Menu Bar

All commands available in the configuration system of the "Text Library" editor are
divided logically into groups and assigned to different menus in the menu bar. To execute a
command, open the appropriate menu, click on the command, and, if necessary, set the
required parameters in the dialog box which opens.

Menu Menu Command Shortcut

File Import
Export As
Print
Print Preview
Printer Setup
Send Changes to Active Project
Exit

CTRL + I
CTRL + E
CTRL + P

Edit Cut
Copy
Paste
Find
Replace
Add Line
Delete Line
Properties

CTRL + X
CTRL + C
CTRL + V
CTRL + F
CTRL + H
Ins
Del
CTRL + E

View Toolbar
Status Bar
Update F5

Tools Default Font
Add Language
Delete Language
Language Font

Help Index
Using Help
About WinCC Text Library
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1.2.1 "File" Menu

The "File" menu contains functions applicable to the currently opened Text Library.

Import
Use the "Import" function to import data which are in the CSV format (Comma-Separated-
Value format). The semicolon is used as separator.
For an example of an import/export file, please refer to the appendix.

Export As
Use the "Export As" command to store the data for your Text Library on a data medium in
CSV format (Comma-Separated-Value) under any name. The semicolon is used as
separator. As the output format of the export file, you can select either the format from
Version 4 or the new format from Version 5. Therefore you have to choose in the field "File
type":

Á for Version 4: "Text files Version 4 (*.csv)"

Á for Version 5: "Text files (*.csv)"

For an example of an import/export file, please refer to the appendix.

Send Changes to Active Project
Use this command to take over the texts changed in the Text Library into an active project.

1.2.2 "Edit" Menu

Cut
Use the "Cut" command to remove the content of a text box or of a text line from the Text
Library and store it in the Clipboard. The contents of the Clipboard remain stored until a
new "Cut" or "Copy" replaces it.

Note

When cutting a text line, the box contents of the selected line are separated by semicolons
and stored in the Clipboard.

Copy
Use the "Copy" command to create a copy of text boxes or text lines and store it in the
Clipboard. The object is stored on the Clipboard until a new "Cut" or "Copy" replaces it.

Note

When copying a text line, the box contents of the selected line are separated by semicolons
and stored in the Clipboard.
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Paste
Use the "Paste" command to copy the contents of the Clipboard and insert them in the Text
Library. Text boxes are inserted in the marked text box. Text lines are inserted at the
location of the next unused text ID or appended to the Text Library. The contents of the
Clipboard do not change.

Note

If you have not marked a text line when inserting a text line, the Clipboard contents, i.e. the
box contents making up a line separated by semicolons, are inserted in this form in the
marked text box.

Add Line
Use the "Add Line" command to add a line to the Text Library. The inserted line is always
appended to the end of the Text Library.

Delete Line
Use the command to delete the box contents or, if a line is marked, the contents of this line
of the Text Library.
If a box is marked, the text contained in the box is deleted without user confirmation.
When deleting lines, user acknowledgment is required before the deletion is performed.

Properties
This command opens the "Properties" dialog box. For your information, the number of
configured languages and the number of created data records will be displayed.



08.99 Functionality of the Text Library

WinCC Manual 1-5
C79000-G8276-C160-01

1.2.3 "Tools" Menu

The basic settings for the Text Library can be set in this menu item.

Default Font
The "Default Font..." command opens the Windows dialog window for setting a font. This
font is used as the default font in all subsequently created languages columns.

Add Language
Use the "Add Language..." command to add a new language (new column). The
translations of the terms are entered in this column.

Note

Only the primary languages are available in WinCC for editor input. These include, for
example, German (Germany), English (USA) etc. Sublanguages, such as German
(Switzerland) or English (Australia) are not available.
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Delete Language
Use the "Delete Language..." function to delete an existing language (column).

Language Font
Use the "Language Font..." function and the "Properties" button to assign a font to each
language.
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1.3 Toolbar

The icons in the toolbar allow you to execute actions more rapidly. You do not have to
make several selections through the menus until you reach the required function.

Icon Description

Cut

Copy

Paste

Print

Properties

Call up context-sensitive Help

1.4 The Status Bar

General program information is displayed on the left side of the status bar. The "Control
Center" section of the user manual contains information about the significance of the boxes
on the right side of the bar.

1.5 The Table Window

The text IDs are allocated during configuration and should not be changed within the Text
Library. It is not possible to assign texts to a configured object. "Global Script" functions
can be used to access the Library texts via the IDs.

In addition to changing the column width and editing individual text boxes, you can also
paste, copy or delete to/from text boxes.

1.6 Column Width

Move the mouse pointer in the top of the table window to the right border of the column
whose width you would like to change.
When the mouse pointer changes into a line with two arrowheads, press the left mouse
button. Move the mouse to change the width of the table column. As soon as you release
the mouse button, the column is displayed in the width set by you.

Set the optimum column width by double clicking on the right border of the column header.
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1.7 Using the Text Library

In order to demonstrate the use of the Text Library for configuring multi-lingual output,
you must perform the following steps:

1. Open the Text Library editor in a new WINCC project to view the Text Library in its
initial state.

2. Open the Alarm Logging editor and configure the message system parameters in order
to enter several English terms in the Text Library.

3. To translate the message texts into different languages, open the Text Library editor
again.

4. Create an example in the Graphics Designer to test the effects of the languages.

5. In runtime mode, the message texts are output in foreign languages.

Initial State of the Text Library
In order to view the Text Library in its initial state, create a new project and open the Text
Library editor. The following picture illustrates the Text Library of this project.

We will use Alarm Logging as an example.

Configuring Alarm Logging
Open the Alarm Logging editor and configure a message. To do this, link the user text
blocks "Message text" and "Point of error" to your message system.

Link a message to a binary tag, e.g. "Message tag". Enter as the message text e.g. "Tank
empty" and for the point of error e.g. "Tank1". Then store the current configuration and
close Alarm Logging. The picture displayed below illustrates the table window after
configuring.

No. Class Type Message Tag Message Text Point of
Error

1 Error Alarm Message Tag, binary Tank empty Tank1

Note

For additional information, please refer to the Alarm Logging manual.
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Translating Message Texts into a Different Language
To translate the message text into a different language, open the Text Library editor again.
Use the "Tools - Add Language" menu item to add a new language (column), e.g. Italian, to
the Text Library. Translate all relevant texts and enter them in the appropriate boxes of the
foreign language column. The following picture contains the translated terms.
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Creating a Runtime Picture in the Graphics Designer
Open the Graphics Designer to create a new picture.
Insert a button in order to set and reset the message tag using a C action. Link an ActiveX
Control to your picture to display the messages configured in Alarm Logging. Link the
message blocks to your ActiveX Control. For acknowledgement of the messages, you need
another button. The properties of this button are linked to the ActiveX Control by means of
a C action using the standard functions.

Note

For additional information, please refer to the WinCC "Alarm Control" documentation.

Outputing the Message Texts in a Foreign Language
Change the runtime language in the Control Center to the Text Library extended language,
Italian. In order to display the effects of the translated texts, activate your project.
Only the texts in the ActiveX Control are displayed in the translated language, which is, in
this case, Italian. Button labels must be translated later into Italian in the Graphics Designer
on the object. The language setting for the button can be changed in the Text Library editor.
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1.8 Appendix

1.8.1 Structure of the Import/Export File

The reference format for the import and export files is the CSV format (Comma-Separated-
Value). The individual table boxes are separated by semicolons; the table lines are
separated by paragraph symbols/line breaks.

General information, such as version number, file name, language identifiers or font
information are stored in the file header.

Example of an Import/Export File:
Text Library V1.0; DEMO.CSV
0;7;9
0;16,7,0,0,700,0,0,0,0,1,2,2,34,System;16,7,0,0,700,0,0,0,0,1,2,2,34,System
Text-ID;German;English
1;Motor;engine
2;Pumpe;pump
11;Temp. LOW;Warning
12;TEMP. HIGH;Failure
21;Lock Messages;
22;Release Messages;
23;Acknowledge Messages;
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1 Introduction
Global Script is the generic term for C functions and actions that - depending on the type -
can be used project-wide or even project-spanning.

You can differentiate among the following types:

Project functions
You can create new project functions and change existing project functions.
The project functions are unique to the project in which they were created.

Standard functions
You can create new standard functions and change existing standard functions.
The standard functions are recognized across projects.

Internal functions
Internal functions cannot be created or changed. They are recognized across projects.

Actions
Actions can be created and changed as global scripts.
These actions are unique to the project in which they were created.

Use project functions, standard functions, and internal functions in the following areas:

In object-related C actions

In object-related actions that you create in the dynamic dialog

for adding dynamics to
process value archives
user archives
compressed archives.

At runtime, you can implement global script actions in the process control.
To do so, first activate the project and start the runtime system.
To activate the project, see Control Center, Section 2.1.4.
To start the run-time system, see Control Center, Section 6.3.

Note

Actions are processed interpretively. When implementing numerous or extensive actions,
you should plan for a higher system load. It is therefore better to replace extensive actions
with separate DLLs (Dynamic Link Libraries).

Functionalities of available DLLs can be made available to functions and actions in
WinCC. Use the following command sequence for this purpose:

#pragma code("<NAME>.dll")
#include "<NAME>.h"
#pragma code()

The catalog project_path\library will be searched for the include files (including those
include files that are called). If these files are found in another location in the file system,
the complete path must be given.
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Note

If you define your own structures in connection with project or standard functions, the
following construction will cause translation errors:

struct MyOwnStruct;
{
....
}
void MyFunction (struct MyOwnStruct...);
{
...
}

The prototype of this function will be transferred to the file “ap_pbib.h” or “ap_glob.h”, but
the structure is not defined there.

To realize the transfer of such a structure or call back function, proceed as follows:

In the project catalog (projectpath\library), insert “apdefap.h” before the ‘#include "ap-
pbib.h"’ structure

struct MyOwnStruct;
{
....
}
#include "ap-pbib.h"

Correspondingly also:

#pragma code ("pdlcsapi.dll")
#include "pldcsapi.h"
#pragma code()

#include "ap_pbib.h"

The structure of MyOwnStruct and the structure of the callback function will therefore be
known to the object, while the prototype of the project function is transferred.
In the project function itself, write only the following

#include "apdefap.h"
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2 Project Functions
Project functions are C functions, which you program and modify yourself.
They are only valid in the actual project in which they were created.
You can use project functions to make graphic objects and archives dynamic. You can also
use them in other project functions and Global Script actions.
Create a project function by means of the Global Script editor. Start this editor in the
Control Center.

Use the following steps in creating a project function:

• Formulate function

• Supplement function information

• Compile function

• Save function and, if necessary, rename

• If necessary, generate header files

You have now created your project function.

The first time you create a project function, the header file apdefap.h is loaded in the
project folder ...\<Projektname>\LIBRARY.
The file contains the header file from the project library ap_plib.h which contains the
header file ap_glob.h.
The header file ap_plib.h contains the definitions of the project functions.
If a project function is loaded and other default or project functions are used there, you
must integrate the header file apdefap.h or ap_glob.h.

How to Formulate a Function:
Start the Global Script editor in the Control Center.
The "Global Script" box opens.

Open the pop-up menu by clicking the right mouse button on the function type (project
function, standard function, or action) in the function browser.
Open the submenu by placing the cursor or clicking on "New" and select the "Function"
submenu item.

Alternatively, use one of the buttons  on the Toolbar.
This selection opens a window that already contains the outline of a C function.
Formulate your function.
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The following edit functions are available:

Function Key Stroke

New line Enter

Delete character to the right Delete

Delete character to the left Backspace

Jump to the beginning of the line Home

Jump to the end of the line End

Jump to the beginning of the text Ctrl+Home

Jump to the end of the text Ctrl+End

Move the cursor with the cursor keys

Cut selected text Ctrl+X

Copy selected text Ctrl+C

Paste text from the Clipboard Ctrl+V

Function Mouse Operation

Mark text with the left mouse button

Highlight a word Double click with the left
mouse button

Move the insertion point with the left mouse button

Additional edit functions include the following:

• Write mode is "Insert".

• The selected text is replaced by the next character entered using the keyboard.

• Expanded selection
Select an area:
Place the cursor where you wish the selection to begin, hold down the Shift key, and
then place the cursor where you wish the selection to end.
Expand a selection:
Hold the Shift key and place the cursor at the desired end of the selection.

You can place fully programmed project functions, standard functions, and internal
functions within your function at the cursor location or you can replace selected text with
such functions.
Proceed as follows:

• Position the cursor or highlight the text you want to replace.

• In the function browser, open the appropriate folder and click the right mouse button
on the desired function to open the pop-up menu.

• Select the "Send to..." menu item in the pop-up menu.

• Select the appropriate editing window from the submenu listing. If you have multiple
editing windows open, the submenu contains an entry for each one.

• If necessary, update the parameters of the function you pasted.
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Enter tag names by clicking on the  button. This action opens the "Select a Tag" dialog
in which you can select the desired tag. If you need to open directories.

How to Add Information about a Function:
If you have more than one editing window open, make the window that contains the desired
function/action the active window.

Click on the  button to open the "Description" dialog box.

Date created, date changed, and version are already entered. The date created and date
changed formats are (left to right) "Day", "Month", "Year"

Enter the names for "Created by" and "Edited by".
Enter a comment, for example, a brief description of the function, in the "Comment" box.

If you want to assign a password to your function to protect it from changes, check the
"Password" checkboxto activate the "Change" button. Click on the "Change" button and
enter your password in the "Enter Password" box. Retype your password to confirm it.
Click on the "OK" button to close the box. You have now protected your function with a
password.

Click the "OK" button to close the "Description" box. The entries are applied.
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How to Compile the Function/Action:
If you have more than one editing window open, make the window that contains the desired
function/action the active window.

Click on the  button to start the compilation process.
The active editing window is divided into two areas. The top portion contains your
function/action and the bottom displays the messages from the compiler.

If you have changed the name of an existing function, an asterisk will prefix the not-yet-
updated function names in the browser. This indicates that the function has not yet been
saved with the modified function name. As soon as you save the function, its name will be
updated in the browser and the asterisk will be deleted.

How to Save the Function:
If you create a new function or a new action, it receives a default name from the system.

If you want to save your function or action under its current name, proceed as follows:

• Click on the  button. The editing window stays open.

• Select the "Save" command in the "File" menu. The editing window stays open.

• Click on the "Close" box in the editing window. This action opens a box that tells you
that there are changes that have not been saved. You can then choose to save the
function/action, reject the changes, or cancel the procedure. If you cancel the
procedure, the editing window stays open, otherwise it closes.

If you want to save your function/action under another name, select "Save As..." in the
"File" menu. This selection opens a box in which you can set the name and the storage
location.

Generally, the storage area is set as follows:

• For project functions:
In the "Library" subfolder in the project folder

• For actions:
In the "Pas" subfolder in the project folder

• For standard functions:
In the WinCC system folder in the "Aplib" subfolder.

How to Generate the New Header Files:
If functions are programmed autonomously, you can make them available to the project by
copying them to the appropriate directories.

This makes the functions available but unknown to the system.

Use the  button or select the "Generate header" menu item to regenerate the header
files. The system can then recognize these new or changed functions.

In the same way, deleted functions are made unrecognizable to the system.

When the new header files are generated, the new functions appear in the Global Script
editor function browser.
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3 Standard Functions
The system includes standard functions. You can modify the functions to suit your
requirements. Furthermore, you can create your own standard functions.
Standard functions are recognized across projects.
Use standard functions to make graphic objects and archives dynamic. You can also use
them in project functions, other standard functions, and Global Script actions.
Create a standard function with the Global Script editor. Start this editor in the Control
Center.

You must follow these steps to create a standard function:

• Formulate function (see section 2)

• Supplement function information (see section 2)

• Compile function (see section 2)

• Save and, if desired, rename the function (see section 2)

• If necessary generate header files (see section 2)

You have now created your new standard function.

The header file apdefap.h integrates the header file ap_glob.h that contains the definition of
the standard functions.
The files apdefap.h and ap_glob.h are located in the ...\APLIB folder.
If a new standard function is created and if other standard functions are used there, you
must integrate the header file apdefap.h or ap_glob.h.

New standard functions are added to the available standard functions on the server
computer in the WinCC installation folder under ...\APLIB.

The system provides standard functions.
They are divided into the following function groups:

Alarm

GRAPHICS

TAGLOG

WINCC

WINDOWS

If the corresponding options are installed, the system will include the following additional
function groups.:

Options

Report

Split Screen Manager

userarc (user archives)

Descriptions of the individual functions can be found in the online help.
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4 Internal Functions
Internal functions are used to add dynamic animation to graphic objects and archives as
well as project functions, standard functions and Global Script actions.

Internal functions are recognized across projects.
You cannot create new internal functions or change existing internal functions.

Internal functions are divided into the following groups

allocate
contains functions for reserving and enabling work memory

c_bib
contains functions from the C standard library

graphics
contains functions for reading and setting the properties of graphic objects

tag
contains functions for writing and reading process tags

wincc
contains functions for language switching, for deactivating runtime, and for exiting
WinCC

You will find a description of each function in the online-help.



Internal Functions 08.99

4-2 WinCC Manual
C79000-G8276-C160-01



08.99 Actions

WinCC Manual 5-1
C79000-G8276-C160-01

5 Actions

Global Script actions are actions you can create and change yourself.
They are only valid in the actual project in which they were created.

Use Global Script actions at run time to control the process. They are executed by means of
a trigger.

Create a Global Script action with the Global Script editor. Start this editor in the Control
Center.

Use the following steps to create a Global Script action:

• Formulate function (see section 2)

• Supplement function information (see section 2)

• Set a trigger as the initiating event

• Compile action (see section 2)

• Set the authorization level

• Save the action and, if necessary, rename it
(see section 2)

You have now created your own Global Script action.

Global script actions can be exported and imported.
An imported action completely replaces the action in the active window.

You can assign a level of authorization to your action.

If a new action is created, the header file apdefap.h is integrated automatically by the
project folder ...\<Projektname>\LIBRARY.
If there is no project function available, the header file from the ...\APLIB folder is
integrated.
This makes the standard and project functions available in the actions.

In the case of multi-user system, there is a difference between global and local actions.
Global actions are - regardless of the processor - stored in the project directory
(...\<Projektname>\PAS). These are accessible for all the network stations.
Local actions are stored in the project directory on their respective system
(...\<Projektname>\<Rechnername>\PAS). This means that local actions are only active on
the corresponding computer.

To assist in checking the operation of the action at run-time, diagnostic support is offered
via the application window.
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How to Set the Trigger:
If you have more than one editing window open, make the window that contains the desired
function/action the active window.

Click on the  button to open the "Description" dialog box.
Switch to the "Trigger" tab.

You can select from the following types of triggers:

• Acyclic: The action is only triggered once at a defined point in time.

• Cyclic: The action is continuously triggered in a set time frame.

• Tag: The action is triggered when the value of a certain tag changes.

How to Select a Trigger Type:
Mark the desired trigger type in the "Description" dialog box and click the "Add..." button.
or
Click the right mouse button on the trigger type and select "Add" in the pop-up menu. If
necessary, open the "Timer" folder.
The "Add Trigger" dialog box opens. It has a contents specific to the type of trigger
selected.
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Make the following additional selections:

• Acyclic:
Set the date and time for the trigger.
Enter an optional trigger name. The trigger name appears in the "Description" dialog
box as the label for the icon in the trigger browser. If you do not enter a trigger name,
the date and time you created the trigger appears with the icon.

• Cyclic:
From the "Cycle" list box, select the desired cycle time, which is the time that passes
between two action triggers.
Enter an optional trigger name. The trigger name appears in the "Description" dialog
box as the label for the icon in the trigger browser. If you do not enter a trigger name,
the cycle time you set appears with the icon.

• Tag:
In the "Tag Name" text line, enter the name of the tag you want to use as a trigger
when the value changes. Click on the "Apply" button to transfer the tag to the tag list.

Alternatively, click on the  button to open the "Select tag" dialog in
which you can select the desired tag.

Click on "OK" to close the "Add Trigger" dialog box.

All of the triggers entered in the trigger browser are effective. Each single trigger event will
start the action.

Example:

• In the trigger type "Tag", you have entered multiple tags as trigger: The action starts
as soon as the value of one of these tags changes.

• In the "Cyclic" trigger type, you entered multiple cyclic triggers: Each of these
triggers starts the action itself. If several trigger events are concurrent, the action starts
as many times as there are trigger events at that point in time.

Note

Since you can assign multiple trigger events to an action, the interaction of the individual
triggers and the run time of the action can lead to unexpected effects. You should take this
into consideration when assigning triggers.

Change one of your entered triggers by marking it in the trigger browser and clicking the
"Change" button (or use the "Change" menu item in the pop-up menu).

Delete an entered trigger by marking it in the trigger browser and clicking the "Delete"
button (or use the "Delete" menu item in the pop-up menu).

Once you have set the trigger, close the "Description" box by clicking on the "OK" button.
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How to Set the Operator Authorization:
If you have more than one editing window open at the same time, select the window that
contains the action to which you want to assign the authorization level. This selection
makes the window active.

Click on the  button to open the "Authorization Levels" dialog box.
From the list of authorization levels, select the desired authorization level. Click the "OK"
button to close the dialog box.
You have now set the operator authorization for your action.

How to export an action:

In the Toolbar, click on the  button.
The "Save as" dialog box will open:

Name the export file and select the location where it should be saved. The system will
append the extension "act" to the file name.
Click on the "Save" button and the action will be exported and stored in the file you have
specified.
The "Save as" dialog box will close.
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How to import an action:

In the Toolbar, click on the  button.
The "Open" dialog box will open.:

Select the desired import file. Import files are files with the extension "act", which were
created by the export of an action.
Click on the "Open" button to insert the action and close the "Open" dialog box.

Note

The imported action will completely replace a previously created action.

How to use the diagnostic support:
At run-time you can view the following diagnostic help in an application window in your
picture:

• the window "Global Script - Runtime":

This window shows information regarding every Global Script action shown in the
picture.
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If you click with the right mouse button on an action name in in the "Action" column,
a pop-up menu will open with the functions to halt (Stop Action), continue (Start
Action) Single-pass (Start) and Edit the action:

To insert this diagnostic window in your picture, proceed as follows:

• mark the check box "Global Script Runtime" in the tab "Startup" der project
component "Computer" in the Control Center

• use the Graphics Designer to create an application window in your picture

• in the window "Window Contents", select the entry "Global Script":

and close the window by clicking on the "OK" button.

• in the window "Template" select the entry "GSC - Runtime":

• and close the window by clicking on the "OK" button.
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• the window "Global Script - Diagnostics":

It contains the output - programmed with printf - of all the actions in the sequence that
they occur.

To insert this diagnostic window in your picture, proceed as follows:

• use the Graphics Designer to create an application window in your picture

• in the window "Window Contents", select the entry "Global Script":

and close the window by clicking on the "OK" button.

• in the window "Template" select the entry "GSC - Diagnostics":

and close the window by clicking on the "OK" button.



Actions 08.99

5-8 WinCC Manual
C79000-G8276-C160-01

Alternatively, you can also insert this diagnostic window as an OLE control in your picture:

Proceed as follows:

• use the Graphics Designer to create an OLE control object in your picture

• in the window "Insert a Control", select the entry "WinCC Global Script - Diagnostic
Control":

and close the window by clicking on "OK" button.
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1 WinCC "Cross Reference"
With the WinCC component "Cross Reference", it is possible to:

- find all places of use for specific objects, e.g. tags and pictures,

- display an object’s place of use in order to edit or delete the place of use ("Go to Place
of Use" function),

- change tag names using the "Linking" function without the risk of causing
inconsistencies in the configuration.

The use of Cross Reference is advantageous in the following casing:

- Searching for the places of use of deleted process tags in order to change or delete the
place of use ("Go to Place of Use"), e.g. for output boxes, in trend displays.

- Finding associations between the existing process pictures of a project in order to
structure the process visualization exactly as the existing parts of the project in the event
of a project expansion.

Clarification of Terms
Several terms must be clarified before the "Cross Reference" component can be described:

Á Cross Reference
This is the designation of the WinCC component and is displayed in the WinCC
Explorer together with the editors.

Á Editor
The Cross Reference editor is started in the WinCC Explorer and makes available the
user interface for working with cross-reference lists.

Á Internal data management
All cross references which are to be managed and updated are recorded here. When
specific cross references are queried, the editor applies a filter to this "complete cross-
reference list" and obtains a filtered result, the cross-reference list.

Á Cross-reference list
This is the result displayed in the editor for a filter which has been applied to the data
contained in internal data management. The editor can be used to save the cross-
reference list together with the used filter.

Á Filter
A set of criteria applied to internal data management to obtain a "filtered" cross-
reference list. The editor is used to enter the filter criteria.

Á Results file
This is the stored form of a cross-reference list and contains, in addition to the data,
the underlying filter.

Á Go to Place of Use
This function can be used to spring from a displayed cross-reference list to the place in
which a found object is used. What happens after engaging this function is dependent
on the object selected, e.g. the appropriate editor may open.

Á Linking
This describes the function which can be used to change the name of a tag in a limited
area of the project without causing inconsistencies.



WinCC "Cross Reference" 08.99

1-2 WinCC Manual
C79000-G8276-C160-01

Properties
The Cross Reference component is made up of two parts:

Á The editor is responsible for manipulating the filter criteria and displaying the results,
the cross-reference lists. It also provides the functions for springing directly to the
place at which an object is used and for "linking", i.e. changing tag names.

Á The second component is internal data management. This part maintains and updates
the project data relevant to the "Cross-Reference List" function.

FilterE
di

to
r

WinCC Data

A variable filter can search for the following object types and create a cross-reference list:

Á process and internal tags

Á pictures and picture windows

Á archives

Á project and standard functions

Á OLE elements

Á ActiveX Controls

The following table illustrates how the search for specific objects is supported.

Objects searched for Possible use in

Archive Messages Function Picture

Tag: process & internal X X X X

Archive -- -- -- X

Function: project & standard -- X -- X

Picture (PDL-file) -- X X X

OLE elements -- -- -- X

ActiveX Controls -- -- -- X

The search results can be saved, printed or exported for further processing in other
Windows applications (CSV or Excel format).

An object found in the displayed cross-reference list can be used either to trigger the "Go to
Place of Use" function or the "Linking" function.
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The data relevant to the "Cross-Reference List" function can be updated either
automatically or manually. Inconsistencies between configuration management and the
displayed cross-reference list are indicated by appropriate status displays or an appropriate
warning during the creation of a cross-reference list.

Note

• Searches for messages are not supported by Cross Reference. This is due to the fact
that messages occur, if at all, in the message window of a picture at runtime or are used
in a function as a parameter of an API call.
Searches in configured messages are supported. Here, an analysis of the tags used in
single messages is performed.

• Tags in functions can only be found and replaced by Cross Reference when the
configuration specifications for tag and picture names (see appendix) is adhered to. This
also applies to the configuration of C actions in pictures.

• For tags that are monitored for limit value violations in Alarm Logging, the
assignment to a message is not acquired in the Cross Reference list. This assignment is
not valid as a so-called place of use. Consequently, a tag that is only monitored for limit
value violations will be listed as "Not Used" in the Cross Reference list..

• The places at which objects are used are handled by Cross Reference exclusively within
the context of WinCC. This means that, for example, no operands are incorporated in
the cross-reference list from Step5 / Step7 which are fundamental to WinCC tags. It is
also not possible to go to places of use in a Step5 / Step7 project.

• Searches for standard and Windows objects in pictures, e.g. lines and circles, are not
supported.
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1.1 Cross Reference in the WinCC Explorer

The editor is visible in the navigation window of the WinCC Explorer and can be started
here via the pop-up menu or via the "Editors" menu.

Used File Names
The following file names and extensions are used in connection with the "Cross-Reference
List" function:

• XFC (XreF-Client file) for the cross-reference list
If the "Cross Reference" entry is selected in the navigation window, all files with the
extension "XFC" stored in the CrossRef folder in the project directory structure are
displayed in the file window to the right.
Each of the displayed files represents a cross-reference list with the filter conditions and
can be opened with a double-click.

• XFS (XreF-Server file) Contains all relevant project data in internal data management.
This "complete cross-reference list" is stored in the project folder and, under normal
circumstances, is not visible to the user.
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Pop-Up Menu for the Editor
If the editor is selected in the navigation window, a pop-up menu is displayed on demand.

Menu Command Function

Open The editor opens.

Display Default Filter The editor opens and a cross-reference list generated
with the default filter criteria is displayed.

New Filter The editor opens and the standard filter dialog for
entering new search criteria is displayed.

Update Data Management This menu item starts (one time) the updating of internal
data management. This manual start is necessary when
automatic actualization is deactivated or has just been
activated.

Automatic Update... When this menu item is selected, a dialog appears in
which you can specify whether internal data
management is to be updated automatically. This
function is deactivated when a new project is created.
This functionality of this pop-up menu item corresponds
to that of the menu item located in the "Tools" menu of
the editor (however, without opening the editor).

Find... Opens the search dialog familiar from WinCC Explorer.

Properties Displays information about the WinCC component
Cross Reference.
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Pop-up menu for the files
If an XFC file is selected in the file window, a pop-up menu is displayed on demand here as
well.

Menu Command Function

Open result file Opens the editor and displays the stored cross-reference
list.

Rename result file The XFC file can be renamed with this command
without starting the editor.

Delete result file The selected XFC file is deleted.

Find... Opens the search dialog familiar from WinCC Explorer.

Properties Displays the XFC file information.



08.99 WinCC "Cross Reference"

WinCC Manual 1-7
C79000-G8276-C160-01

1.2 Structure

1.2.1 Menu Bar

The menu bar of the editor contains all of the available commands. They are divided
logically into groups and assigned to different menus. To execute a command, open the
appropriate menu, click on the command, and, if necessary, set the required parameters in
the dialog box which opens.

Menu Menu Command Shortcut

File New...

Open ...

Close

Save

Save As ...

Save All

Print ...

Print Preview

Page Setup...

Printer Setup...

Export...

Export Options...

File List

Exit

CTRL + N

CTRL + O

CTRL + S

CTRL + P

Edit Copy

Filter...

Find...

Find Next

Go to Place of Use

Linking

CTRL + C

F2

CTRL + F

F3

F9

F10

View Display

Auto Filter...

Hide/Display Columns...

Optimize Column Width

Toolbar

Status Bar

Update

CTRL + W

F5

Tools Update Automatically...

Update Data Management

Update Data Management and View

Settings ...

CTRL + F5

Shift + F5
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Menu Menu Command Shortcut

Window New Window

Cascade

Tile Vertically

Tile Horizontally

Arrange Icons

Close All

Window List

Info Contents and Index

Direct Help

Using Help

About Cross Reference

Shift + F1

1.2.1.1 "File" Menu

New
Starts the creation of a new cross-reference list, the first step of which is the opening of the
filter dialog with the default settings. The user sets the desired filter criteria and starts the
corresponding search. The new cross-reference list is then displayed.

Open
Opens a previously stored cross-reference list via the file browser dialog. The contents of
the displayed cross-reference list are those at the time at which the list was saved, i.e. it is
not necessarily up to date.
The functions in the "Tools" menu and the "View / Update" menu item are available for
updating a possibly "old" cross-reference list.

Print, Print Preview, and Printer Setup
Use the "Print" command to print the current cross-reference list on the set printer.

Use the "Print Preview" command to display a preview of the documentation.

Use the command "Printer Setup" to specify the printer to be used and the page layout.
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Page Setup
Use this menu item to set margins, layout, and the page order for the printout of the current
cross-reference list.

Area Description

Margins The input boxes for the page margins are prefilled with default
values which can be directly overwritten with the required values.

Page order The print order of the table pages is set here.
With the setting "Lines first, then columns", the table contents are
printed from upper left to lower left (all lines), then continues to
the right.
With the setting "Columns first, then lines", the print order is
from upper left to upper right (columns first), and then continues
downward.

Headings and gridlines The check boxes are used to specify layout details.
In this way, titles, borders, and lines can be inserted into the page
layout.

Center on page When printing, the table of the data window is centered on the
page format according to the method selected.
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Export
Saves the current cross-reference list as a file in CSV or Excel format. The data can then be
processed further or analyzed using other Windows programs (e.g. spreadsheets or
databases).

The separator used when exporting to CSV format can be set in the "Tools / Settings... "
menu item.

Further export options can be set in the "File / Export Options..." menu item.

Note

When exporting directly to Excel format or to CSV format with subsequent further data
processing in MS-Excel, note that the maximum number of lines that MS-Excel can process
is 65535.
This limit does not apply to files in CSV format, which are processed using other editors.

Export Options...
Use this menu item to specify whether the displayed cross-reference list is to be exported
with

Á header line,

Á lines set to invisible (MS-Excel only),

Á and type of the contained element (MS-Excel only).

The bottom two options have an effect only when exporting to Excel format.
When exporting to CSV format, all data are exported. Only the export of the header line is
optional.
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1.2.1.2 "Edit" Menu

Filter
Select this menu item to open the filter selection dialog, in which the user can set the filter
criteria for the currently displayed cross-reference list or for a cross-reference list which is
to be created.
An exact description of this dialog can be found in the "Functionality" chapter.

Find
A character string can be entered in a search dialog and a search within the displayed cross-
reference list subsequently performed.

Option Description

"Text" Input Box A character string can be entered here and a search within the
displayed cross-reference list subsequently performed.
The characters "*" and "?" can be used as placeholders.
The previously used character strings are temporarily saved and
can be deleted in the dialog for "Tools / Settings".

Check Boxes These are used to better define the character string being searched
for as described by the adjacent texts.

Option Buttons Below
"Current Column"

These are used to specify that the search range be limited to the
current column or to the entire data window.

"Find" Button As soon as a character string has been entered in the "Text" box,
the button is activated and the search can be started in the
displayed cross-reference list.
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Go to Place of Use
This menu item is used to activate the "Go to Place of Use" function. Depending on the
object selected in the cross-reference list, the appropriate WinCC editor is started. Further
actions are dependent on the given editor, e.g. in Graphics Designer the respective object is
moved to the visible area and displayed.

A more exact description of this function can be found in the "Functionality" chapter.

Linking
With this function, you open a dialog for changing tag names at the places of use in the
project. The area affected by the change can be selected. Inconsistencies in tag designations
can be avoided or corrected using this function.

A more exact description of this function can be found in the "Functionality" chapter.

1.2.1.3 "View" Menu

Display
The subitems of this menu item have a different meaning and refer exclusively to the
currently displayed cross-reference list. When one of these menu items is selected, the
currently displayed cross-reference list is not updated.

Only those options that are valid for the current filter setting can be selected. If, for
example, "Unused, existing" is selected in the filter dialog, "Used objects" and "Open
references" are inactive in this submenu.

All objects:
All elements contained the current cross-reference list are visible.

Used objects:
All objects in the current cross-reference list that exist and are used in another object
(referenced) are displayed.

Unused objects:
All objects that exist and are not referenced in any other object are displayed.

Open references:
All objects that contain a reference to an object that does not exist, i.e. a picture containing
a referenced tag that has been deleted, are displayed.
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User-defined...:
This function can be used to set up a detailed view of the cross-reference list.

Note

The option selected in the submenu is reset when the view is updated or when a new search
is performed using the filter dialog.

With the exception of the "All objects" option, after a subitem is selected, the information is
displayed only in the appropriate column of the table. For the other, unselected options, the
column headings are displayed in grey and the columns themselves remain empty.
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AutoFilter
Use AutoFilter to apply specific criteria to individual columns of the displayed cross-
reference list. This allows you to perform a more specific selection from the displayed data.

Option Description

"Cur." Buttons These buttons apply the contents of the selected cells or lines of
the cross-reference list into the corresponding entry field of the
dialog box.
Multiple selections of individual cells from the table are possible
using the “CTRL” key.
If multiple lines have been selected, in which the top positions
contains empty cells, the cells below (in the same column)
containing data will be applied.

"Column 4..." –
"Column 8..."
Input Boxes

Here, a filter condition can be set for the specified column in the
form of a character string. Single characters can be replaced by
"?" and strings of characters by "*".

"X" Buttons These buttons clear the entry in the corresponding input box to
the left.

"Reset All" Button This button clears the entries in all of the input boxes of the
dialog.

"Apply" Button Use this button to immediately apply the filter criteria to the
current cross-reference list without closing the dialog. The affect
the given filter has on the display can, in this way, be followed
directly.
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If a filtering criterion of this dialog box acts on a column in the cross-reference list, the
respective column heading will be displayed in white and the criterion be included, e.g.
"<nVar1>".

Note

The display in the data window is also affected by the "View / Display" menu item, i.e. the
filter criteria in the "AutoFilter" dialog affect only the currently displayed table.

If an update is performed, the "AutoFilter" filter criteria are not reset and, therefore,
continue to influence the display in the data window.
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Hide/Display Columns...
With this menu item you can:

Á display or hide selected table columns and

Á reset the column widths to the default values or optimize them.

Option Description

Check-boxes in the
“Displayed Columns”
area

These check-boxes select the columns that are to be displayed in
the table or whose widths are to be set.

“Select All” Button All check-boxes in the “Displayed Columns” area will be
selected.

"Deselect All" Button All check-boxes in the “Displayed Columns” area will be
deselected.
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Option Description

Radio buttons in the
"Width of the
Displayed Columns”
area

In here, select how the widths of the displayed columns are to be
set.
The default value “No Change" keeps the current column widths
or sets them to the value before the column was hidden.

"Reset" sets the column widths to their default values. The default
values are defined in the “Options/Settings” dialog box in the
“Default Column Widths” fields.

"Optimize" sets the column widths to their optimum values.

"OK" Button The table columns will be displayed according to the selections
made.

"Close" Button Closes the dialog box without applying the changes.

Note

The "OK" button will remain inactive until at least one column from 4 or higher has been
selected.

Optimize Column Widths
This sets all column widths of the cross-reference list to their optimum values, i.e. all field
contents will be visible.

Update
The selection of this menu item results in an updating of the displayed cross-reference list.
The base filter criteria are again applied to internal data management and the result
displayed. The sequence of events corresponds to that in the "Edit / Filter" menu item,
however, without the preceding filter selection dialog.

Any inconsistencies between internal data management and the displayed cross-reference
list are indicated by "OLD" in the status display.

Note

If "Automatic Update" ("Tools" Menu) is switched off, the current cross-reference list that
is displayed even after this command is used may not necessarily correspond to the current
configuration state. For more information, refer to the description in the "Functionality"
chapter.
Depending on memory capacity and project size, this function may take considerable time
(possibly hours) to complete.
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1.2.1.4 "Tools" Menu

Update Automatically
Select this menu item to toggle the "Update Automatically" property of internal data
management on or off. The current setting is indicated by the marking which precedes the
menu item and by the display "A-UPD" in the status bar.

If automatic updating is deactivated, inconsistencies between the WinCC project and
internal data management may occur. Should an inconsistency occur, an appropriate
warning is displayed during the creation / change of the cross-reference list and "UPD !" is
displayed in the status display.

If automatic updating is activated, all changes in the configuration are also managed by
internal data management starting at this point in time. Nevertheless, inconsistencies may
exist for the period between the reactivation and the last time internal data management was
updated. In addition, the displayed cross-reference list is not automatically updated when an
update is performed.

To display the most current configuration state in both cases, the update must be manually
initiated by using the following menu item "Tools / Update Data Management and View".

Update Data Management
This menu item only triggers the updating of internal data management.
The display of the cross-reference list is not automatically updated by this command.

Note

Depending on memory capacity and project size, this function may take considerable time
(possibly hours) to complete.

Update Data Management and View
This menu item triggers the updating of internal data management and the view of the cross-
reference list.

Note

Depending on memory capacity and project size, this function may take considerable time
(possibly hours) to complete.

If a new picture is copied into the project folder using the Windows Explorer, Cross
Reference does not detect any inconsistency in the cross-reference list. In this case, the user
must manually start the "Update Data Management" function.
Following an update, note that the display may be affected by any set filter criteria via
"AutoFilter".
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Settings
This menu item opens a dialog for

Á activating confirmation dialogs;

Á setting the export separator;

Á entering the column widths in the table;

Á deleting search strings.

Option Description

"Display confirmation
dialog" Area

If these check boxes are activated, a confirmation window
appears, if necessary, each time the given action is performed.

Separator for CSV
files

In this box, the separator for exporting a cross-reference list into a
CSV-format file is set. The default is a semicolon.
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Option Description

"Default column
widths" Input Boxes

The order of the boxes corresponds to the order in the data
window of the editor.
The displayed column width values can be changed manually.
Use the two ".... Reset column widths" buttons of the "View /
Hide/Display Columns..." dialog to activate the values for the
display.

"Use current column
widths" Button

Use this button to take over the values in the "Current column
widths" input boxes into the "Default column widths" boxes.
This button has no effect on the "Current column widths" boxes.

"Current column
widths" Input Boxes

The order of the boxes corresponds to the order in the data
window of the editor.
The displayed column width values can be changed manually.
Use the "Apply" button to use the values in the display
immediately.

"Apply" Button Use this button to use the values in the "Current column width"
input boxes in the data box display immediately.
This button has no effect on the "Standard column widths" boxes.

"Delete search strings
now" Button

If one or more character strings were entered in the "Edit / Find"
menu item, they can be deleted using this button.
The button remains inactive as long as no character string has
been entered in the search dialog.

1.2.2 Toolbar

The toolbar can be used to more quickly execute actions, as the actions must not be selected
from the menu and the desired menu item.

Icon Description

"File" "New"

"File" "Open"

"File" "Save"

"File" "Save All"

"File" "Export"

"Edit" "Copy"

"File" "Print"

"File" "Print Preview"

"Edit" "Find"



08.99 WinCC "Cross Reference"

WinCC Manual 1-21
C79000-G8276-C160-01

Icon Description

"Edit" "Find Next"

"Tools" "Update Data Management"

"Edit" "Filter"

"View" "Update"

"Tools" "Update Data Management and View"

"Edit" "Go to Place of Use"

"Edit" "Linking"

"Help" "Contents and Index"

"Help" "Direct Help"

Double click in an unused area of the toolbar to open a dialog which can be used to modify
the bar to meet your personal needs. In this way, you can add buttons and separators or
change their order in the bar.

1.2.3 Data Window

The result of a filter applied to internal data management is displayed in the editor in table
form.
Displayed in a line of the table are:

Á markings for the reference type (used, unused, non-existing),

Á the object being searched for (e.g. tags, pictures),

Á where it is referenced (type, contained element, object),

Á and which property it influences (properties/action).

The column contents are dependent on the object type being searched for.

The table can be sorted in either ascending or descending order by clicking on the
appropriate column title. The sort order is indicated by either a plus or minus symbol in the
column heading.
If the table display is filtered using the “AutoFilter”, the respective column heading will be
displayed in white and the criterion be included.

The column display can be changed by using the "Hide/Display Columns..." function in the
"View" menu as well as by using the pop-up menu for the column heading.
The column width itself can be changed by selecting and moving the border of the column
heading with the mouse or by using the "Tools / Settings" menu item.
To make all table data visible, the column widths can also be optimized individually or in
groups using the column heading’s pop-up menu.
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The contents of the "Used", "Unused" and "Used, not existing" columns are also determined
by the selection made in the submenu "View / Display": With the exception of the "All
objects" option, when one of these subitems is selected, only the corresponding lines in the
table are displayed. For the other, unselected options, the column headings are displayed in
grey and the columns themselves remain empty.

An example of the table structure during the search for a tag in pictures

1.2.4 Status Bar

In addition to general program information, status displays are displayed in the right-hand
area of Cross Reference.

Box Description

A-UPD "Update Automatically" of internal data management ("Tools" Menu) is
switched on.

UPD ! The data of internal data management may be inconsistent with the
project data.
It may be necessary to execute "Update Data Management and View".

UPD Internal data management is being updated.

OLD The data of the current cross-reference list may be inconsistent with the
data of internal data management.
It may be necessary to execute "Update View".

QUERY The displayed cross-reference list is being updated with the current filter
conditions.
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1.3 Functionality

1.3.1 Creating a Cross-Reference List (Filter Selection Dialog)

The search criteria for a cross-reference list are set in the filter selection dialog.
The dialog appears upon selection of the "File / New" or "Edit / Filter" menu items.

Selection Window
Here, the object types which are to be searched for are selected. You can select from the
following object types: tags, pictures, functions, archives, OLE elements and ActiveX
Controls.

"All" Check Box
If this check box is selected, all objects of the selected type will be searched for. If this is
not desired, a partial selection can be made using the browse button ("..."). In this case, the
check box is displayed in grey.
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"Used, existing" , "Unused, existing" , "Used, not existing" Check Boxes
By activating these check boxes, the search for the selected object type is restricted to the
marked terms.

Term Description

Used, existing All objects in the current cross-reference list that
exist and are used in another object (referenced) are
displayed.

Unused, existing All objects that exist and are not referenced in any
other object are displayed.

Used, not existing All objects that contain a reference to an object that
does not exist, e.g. a picture containing a referenced
tag that has been deleted, are displayed (so-called
open reference).

Check Boxes for the Object Types
A check box is provided here for each object type that supports searches. If a check box is
activated, references are searched for in all or in selected objects of the given type.
If a partial selection is made using the browse dialog, the respective check box is displayed
in grey.

Browse Buttons
With the browse buttons, the user has the option to restrict the search for or in objects as
required.
This restriction is made using an appropriate, object-dependent selection dialog.

Á If "Tag" is selected as the object type being searched for, the tag selection dialog
opens.
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Á When searching in the picture, function, archive, and message object types, the browse
button opens a selection dialog in which, for example, all existing PDL files in the
WinCC project are displayed.

For the OLE element and ActiveX Control types, it is only possible to search for "All"; a
dialog is not opened.

Note

Combinations of useless filter criteria are suppressed in the dialog by means of presettings.
As a result, either the "Start search" button or, for example when searching for pictures, the
check box for "Archives" in the "Search in" area is not available for selection.
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1.3.2 Updating a Cross-Reference List

The cross-reference list displayed in the data window is based on the data in internal data
management and a filter applied to internal data management.
This display does not necessarily correspond to the current WinCC configuration, as
internal data management can be updated either automatically or manually; the displayed
cross-reference list is always updated manually.

FilterE
di

to
r

WinCC Data

The following functions are available for updating:

Function Description

Update Automatically
("Tools" Menu)

Toggles "Update Automatically" for the internal data
management continuously on or off. The current setting is
indicated by the marking which precedes the menu item and by
the display "A-UPD" in the status bar.
All changes in the configuration are recorded starting at the point
of time that the function is switched on.

Update Data
Management
("Tools" Menu)

Triggers only the one-time update of internal data management;
the display of the cross-reference list is not automatically updated
by this function.

Update
("View" Menu)

Triggers a one-time update of the displayed cross-reference list,
i.e. the current filter criteria are again applied to internal data
management and the result displayed.
This corresponds to the "Edit / Filter" menu item, however,
without the preceding filter selection dialog.

Update Data
Management and View
("Tools" Menu)

Triggers the updating of internal data management and the view
of the cross-reference list.

If "Update Automatically" is deactivated, inconsistencies between configuration, internal
data management, and the displayed cross-reference list may occur.
You will be made aware of any inconsistencies in the following ways:

Á Inconsistency between WinCC project and internal data management
is indicated by an appropriate warning during creation / editing of a cross-reference list
and by status display "UPD !"

Á Inconsistency between internal data management and displayed cross-reference list
is indicated by status display "OLD"
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Any of the following items may be executed in order to then obtain a display of the cross-
reference list based on the most recent project status:

Á Switch the "Update Automatically" function (continuous) back on and initiate the
"Update Data Management and View" function.
The manual function is necessary here for two reasons. First, because even though all
changes in the configuration are also managed by internal data management starting at
the time automatic updating is switched back on, inconsistencies may have occurred in
the period between the reactivation and the last time internal data management was
updated. In addition, the cross-reference list is not updated as a result of the activation.

Á Manual, one-time initiation of the "Update Data Management and View" function.

Note

Depending on memory capacity and project size, the "Update Data Management and View"
and "Update Data Management" functions may take considerable time (possibly hours) to
complete.

If a new picture is copied into the project folder using the Windows Explorer, Cross
Reference does not detect any inconsistency in the cross-reference list. In this case, the user
must manually start the "Update Data Management" function.

Following an update, also note that the display may be affected by any set filter criteria via
"AutoFilter".

It may, however, be desirable to switch off automatic updating:

Á In order to "freeze" a specific configuration state in internal data management and
create certain cross-reference lists.

Á In order to reduce system load. When switched off, the "Update Automatically"
function does not constantly require system resources for updating internal data
management.

Data inconsistencies may also occur with a stored cross-reference list. This is because this
stored list is based on the internal data at the time the save was performed and/or internal
data management may not have been current.
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1.3.3 Accessing the Editors ("Go to Place of Use")

When displaying the places of use in a cross-reference list of the editor, it is possible to
spring directly to these points of use in the appropriate WinCC editor.

To do this, you must select the given object in the data window of the editor. The "Go to
Place of Use" function can be trigged via the "Edit / Go to Place of Use" menu item or the
pop-up menu.

The following table illustrates which editor is started when springing to the respective
places of use:

Place of Use Editor Action Triggered on Go to Place of Use

Archive Tag Logging The editor is started, no other action

Message Alarm Logging The editor is started, no other action

Function Global Script The editor is started and the function is displayed

Picture object Graphics Designer The editor is started and the object is given focus

Tag WinCC Explorer Explorer is placed in the foreground, no other action

Example:
Displayed in the editor is a property being made dynamic in a graphic object of a picture.
The dynamics are created via a process tag. Their use is, therefore, correspondingly
displayed in the editor. Upon execution of the "Go to Place of Use" function, the Graphics
Designer is opened from the editor and the affected object moved into the field of view.

1.3.4 Linking a Tag

Another use of cross-reference lists is the "Linking" function. With this function, the name
of a tag can be changed at a place of use in the project without causing inconsistencies in
the names of the tags used throughout the project.

To do this, you must select the given object in the data window of the editor. The Linking
function can be triggered via the "Edit / Linking" menu item or via the pop-up menu.

Note

If the selected tag is not used, the "Linking" item is deactivated. In this case, it is possible to
rename the tag via the WinCC Explorer.
In order for Cross Reference to be able to detect and rename tags that are used in functions,
the configuration specifications included in the appendix must be adhered to. Existing
functions must be changed accordingly.
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Option Description

"Current picture name" Box This box is only a display for the current picture names in
the displayed cross-reference list.

"Link all places of use in all
pictures",
"Link all places of use in the
current screen",
"Link all places of use in the
current object"
Option Buttons

These three items determine where the tags are to be
replaced, i.e. the areas in which renaming is limited.

"Old tag name" and
"New tag name"
Boxes

The previous tag name is displayed in the "Old tag name"
box as well as entered in the input box for the new tag
name.
The new name can be entered directly or selected in the tag
selection dialog, which is opened via the browse button.

Browse Button "..." The browse button, located next to the "New tag name"
box, opens the selection dialog for tags.

"Linking" Button The function is executed via this button.
The button is deactivated as long as the old and new tags
names are the same.
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1.4 Configuration Examples

Prerequisites for the Configuration Examples
In order to obtain the same results in the following examples for the filter dialog and the
"Linking" and "Go to Place of Use" functions, the following prerequisites should be met:

1. Create a new single-user project with any name.

2. In tag management, create two internal tags named "nVar1" and "nVar2" of type
"unsigned 8-bit value".

3 Create a picture in the Graphics Designer named "P10".
Insert an I/O field into the picture, and in the configuration dialog set "nVar1" as the
tag.

4. Duplicate the I/O field, place it next to the first I/O field, and open the configuration
dialog.
Change the "nVar1" entry to "nVar3" directly, i.e. without calling up the tag selection
dialog.

5. Save the picture and close the Graphics Designer.

6. Start Cross Reference and execute the "Update Data Management" function.
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1.4.1 Example of Creating a Cross-Reference List

In order to obtain the same results in this example, the prerequisites described in the
example instructions should be fulfilled. The process can also be used with other projects.
The results will, however, be different.

1. Call up the filter dialog either by activating the button in the toolbar or by selecting the
"Edit / Filter" menu item.

2. In the dialog, set the filter criteria as displayed in the picture.

With the displayed filter criteria, the tags are searched for in all pictures and all
functions independent of whether the tags are "used", "unused", or "not existing, but
used".

3. Starting with the prerequisites described above, the search returns the following result
(sorted using the "Tag" column):
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Meaning of the contents:

- Line 1: The tag "nVar1" is used in picture "P10" as a property of I/O field1,
attribute "Output Value".

- Line 2: The tag "nVar2" is not used.

- Line 3: Displays an open reference. The
tag "nVar3" is used in picture "P10" as a property of I/O field2, attribute "Output
Value", however, it does not exist.

4. Save the cross-reference list via the "Save" icon in the toolbar, and in the "Save As"
dialog enter e.g. "CrossRef2Variables.XFC" as a file name.

This cross-reference list is the starting point for the "Linking" and "Go to Place of Use"
functions, which will also be discussed in examples.
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1.4.2 "Go to Place of Use" Example

This example uses the cross-reference list created in the accompanying example.

1. Select the desired box for the place of use, e.g. "I/O field2" in line 2, "Object" column.

2. The "Place of Use" item in the pop-up menu and the "Edit / Go to Place of Use" menu
item trigger the "Go to Place of Use" function.

3. As the I/O field is an object of a picture, the Graphics Designer is started and I/O
field2 is displayed in the visible area. Because the tag "nVar3" configured in the I/O
field in this example is an open reference, you can now make changes at the tag’s place
of use.

4. Use the configuration dialog to assign a different tag, e.g. "nVar2" or delete the "I/O
field2" place of use.

5. If you have made a change in the picture, save the picture, switch to the CrossRef
editor and execute the "Update Data Management and View" function. Afterwards,
you can see the effects of your change in the cross-reference list: "nVar3" is no longer
displayed as an open reference.
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1.4.3 Example of Linking a Tag

This example uses the cross-reference list created in the accompanying example.

1. Select a tag, e.g. "nVar1" in line 1.

2. Use the "Edit / Linking" menu item or the pop-up menu to open the "Linking" dialog.

3. "nVar1" is displayed as the old tag name and "P10.pdl" is displayed as the current
picture name, as the tag’s place of use is in this picture.
The "Link all places of use in the current screen" option is preset and does not need to
be changed for the example.
Enter "nVar11" as the new tag name; the "Linking" button becomes active.

4. Upon clicking the mouse on this button, the tag will be linked, i.e. renamed, only
within picture "P10.pdl".
The "Link all places of use in all screens" options would not have any effect in this
example, as there is only one place of use.

5. You can check the linking by calling up the properties of I/O field1 in picture "P10"
via the Graphics Designer. Below the "Output/ Input" item, the "Output Value"
attribute of the changed name can be seen.
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1.5 Appendix

Configuration Changes in V5.0 : Tags / Picture Names in Actions
In order to search for and replace the tag or picture names used in C actions (attribute-side
and event-side), the script must be written in the following way:

At the start of the script, all tags and picture names must be declared in two sections.

The sections are structured as follows:

// WINCC:TAGNAME_SECTION_START
// syntax: #define TagNameInAction "DMTagName"
// next TagID : 4 // the next free ID can be entered here
# define TAG_1 "otto" // where "otto" is the actual tag name
# define TAG_2 "hugo"
# define TAG_3 "karl"
// WINCC:TAGNAME_SECTION_END

// WINCC:PICNAME_SECTION_START
// syntax: #define PicNameInAction "PicName"
// next PicID : 4
# define PIC_1 "pict1.pdl"
# define PIC_2 "pict2.pdl"
# define PIC_3 "pict3.pdl"
// WINCC:PICNAME_SECTION_END

The standard functions for reading and writing the tags must then be called via the defined
tags and pictures.

GetTagDWord (TAG_1);
OpenPicture(PIC_1)
SetPictureName( PIC_2, "Picture Window1",PIC_3);

When you create a new C action in the Graphics Designer, the appropriate prefabricated
section is inserted into the script.

In order to use the linking function, an addition must be made to existing scripts as per the
description.
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